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Введение

Инженерная компьютерная графика является одной из наиболее интенсивно 
развивающихся отраслей технических знаний. Современные CAD-подсистемы, 
входящие в состав интегрированных CAD /CAM /CAE-систем (Computer Aided 
Manufactoring/Engineering — поддержанное компьютером конструирование/из­
готовление/инженерная деятельность), и системы твердотельного параметриче­
ского моделирования механических объектов, отражающие последние достижения 
инженерной компьютерной графики, представляют собой наиболее важные раз­
работки в области новых технологий по автоматизации деятельности инженеров, 
конструкторов и технологов [10]. Эта оценка была сделана еще в конце 80-х годов 
прошлого века. К  тому времени в мире было создано 40-50 трехмерных систем 
автоматизированного проектирования (С А П Р) [11].
В последние годы роль САП Р в решении задач интенсификации процесса раз­
работки и выпуска новых изделий еще более возросла, системы продолжали со­
вершенствоваться, становясь при этом все более доступными для широкого круга 
пользователей. Конкуренция на рынке САПР заставила разработчиков продвигать 
в сферу образования некоммерческие учебные версии своих систем, искать другие 
способы внедрения в обучение своего легального прикладного программного обе­
спечения.
Освоение любой САПР, ориентированной на машиностроение и приборостроение, 
начинается со знакомства с CAD-системой.
В данной книге приведены материалы, позволяющие ускорить освоение трех­
мерных редакторов пяти наиболее распространенных в сфере образования CAD- 
систем:
О KOMIIAC-3D. Более 1000 учебных заведений применяют профессиональ­

ное программное обеспечение в обучении студентов и научных исследовани­
ях. В  учебных аудиториях система установлена более чем по 45 000 лицен­
зий. В  2008 году в рамках приоритетного проекта «Образование» все школы



Российской Федерации (Р Ф ) получили систему KOMIIAC-3D LT, при этом 
в 6100 школах, реализующих инновационные программы обучения, была по­
ставлена профессиональная система KOMIIAC-3D.

О  SolidWorks. 145 высших и средних специальных учебных заведений Р Ф  и стран 
ближнего зарубежья являются участниками образовательного проекта.

О  Autodesk Inventor, AutoCAD. Ежегодно более 2 ООО ООО студентов в 50 ООО 
учебных заведений обучаются работе с программными продуктами Autodesk. 
В странах СНГ более 1100 факультетов и сотни вузов выпускают специалистов, 
умеющих использовать технологии Autodesk. Будущие архитекторы, проекти­
ровщики, инженеры и специалисты по компьютерной графике овладевают теми 
же программами, с которыми работают профессионалы. (По данным предста­
вительства Autodesk в России.)

О  T-FLEX. Используется в 116 высших и средних специальных учебных заведе­
ниях Р Ф  и стран ближнего зарубежья.

Данные по внедрению в сферу образования указанных систем взяты с соответ­
ствующих сайтов (см. приложение Б ) в конце 2009 года.
В  книге описаны этапы создания в перечисленных системах трехмерных твердо­
тельных моделей девяти деталей, показанных на следующем рисунке.

Кроме того, в книге вы найдете:
О описание этапов построения чертежей по ЗБ-технологии. Ассоциативные 

чертежи, созданные по ЗБ-технологии, характеризуются тем, что все виды



плоского чертежа связаны так, что изменения в модели приводят к изменению 
изображения в каждом виде;

О описание этапов создания 13 твердотельных моделей в рамках тестирования 
уровня начальных навыков ЗБ-моделирования. Твердотельная модель — это 
трехмерная электронная геометрическая модель, представляющая собой фор­
му изделия как результат композиции заданного множества геометрических 
элементов с применением к этим элементам операций булевой алгебры [4]. 
Геометрическим элементом может быть линия, точка, плоскость, поверхность, 
геометрическая фигура и геометрическое тело [4].

Концептуальные особенности книги
Особенности книги, на которые следует обратить внимание:
О книга знакомит с современным подходом к автоматизированному проекти­

рованию, когда конструкторская документация изделий создается на основе 
трехмерного моделирования этих изделий;

О последовательность представления и содержание учебных заданий обеспечива­
ют постепенность и полноту освоения трехмерных редакторов;

О особенности выполнения заданий раскрываются в рисунках, на которых по­
казаны этапы построения тех или иных изображений или моделей;

О выполнение одинаковых моделей в различных CAD-системах обеспечивает 
эффективный и интуитивно понятный перенос навыков моделирования при 
освоении очередного ЗО-редактора;

О в книге реализован деятельностный подход к инженерному образованию, когда об­
учаемый включается в подлинную или близкую к ней инженерную деятельность; 

О форма представления заданий обеспечивает возможность внедрения дистан­
ционных форм обучения.

Книги, посвященные применению информационных технологий в проектировании, 
можно условно разделить на две группы.
Первую, наиболее многочисленную группу составляют книги, в которых основ­
ное внимание уделяется подробному описанию меню и панелей инструментов, 
описанию их команд. Как отмечается в [5], простейшие примеры, показывающие 
результат выполнения той или иной команды, повышают эффективность обучения, 
но незначительно.
В книгах второй группы описание меню программ и их команд носит лишь ознако­
мительный характер и не изобилует подробностями. Основной упор сделан на вы­
полнение примеров, взятых из «реальной жизни» или максимально приближенных 
к ним [5]. С помощью таких примеров можно наглядно раскрыть основные приемы 
создания моделей, варианты применения различных команд для получения одного 
и того же результата, в том числе в разных CAD-системах.
Вы уже поняли, что книга, которую вы держите в руках, относится ко второй 
группе.



Для кого предназначена книга
Книга в основном предназначена для начинающих пользователей САПР. Она ре­
комендуется студентам, обучающимся по различным техническим направлениям 
подготовки бакалавров и магистров. Книга обеспечивает компьютерную поддержку 
изучения общепрофессиональных и специальных дисциплин и курсов, в рамках 
которых изучаются и применяются различные CAD-системы:
О в вузах и колледжах;
О на курсах повышения квалификации работников промышленности;
О в институтах непрерывного (послевузовского) образования;
О в школах для обучения по программам курса «Черчение», знакомящим с осно­

вами разработки компьютерных чертежей, а также при использовании дистан­
ционных форм изучения материала.

Материалы, размещенные на прилагаемом к книге DVD-диске, могут обеспечить 
эффективное самостоятельное освоение новых (для конкретного пользователя) 
CAD-систем.
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) ГЛАВА
Общие сведения 
о системе КОМ ПАС-3 D LT

Система KOMI1AC-3D LT предназначена для создания трехмерных параметри­
ческих моделей деталей и последующего полуавтоматического выполнения их 
рабочих чертежей, содержащих все необходимые виды, разрезы и сечения.
Система ориентирована на формирование моделей изделий, содержащих как ти­
пичные, так и нестандартные конструктивные элементы.

В терминах KO M IIAC-3D  LT любое изображение, которое можно построить 
средствами системы, принято называть документом. С помощью KOMITAC-3D 
LT можно создавать документы трех типов: трехмерные изображения деталей, 
плоские чертежи и фрагменты. В случаях, когда идет речь о трехмерных изобра­
жениях деталей, употребляется еще один термин — «модель». Построение моделей 
выполняется средствами модуля трехмерного моделирования.
Деталь — модель изделия, изготавливаемого из однородного материала без при­
менения сборочных операций. Детали хранятся в файлах с расширением .m3d.
Чертеж — основной тип графического документа в КОМПАС-ЗБ. Чертеж содер­
жит графическое изображение изделия, основную надпись, рамку, иногда — допол­
нительные объекты оформления (знак неуказанной шероховатости, технические 
требования и т. д.). В чертеж КОМ ПАС-ЗБ всегда входит один лист заданного 
пользователем формата. В файле чертежа КОМ ПАС-ЗБ могут содержаться не 
только чертежи (в понимании ЕСКД ), но и схемы, плакаты и прочие графические 
документы. Чертежи хранятся в файлах с расширением .cdw.
Фрагмент — вспомогательный тип графического документа в КОМ ПАС-ЗЭ. 
Фрагмент отличается от чертежа отсутствием рамки, основной надписи и других 
объектов оформления конструкторского документа. Он используется для хранения

1.1. Основные типы документов



изображений, которые не нужно оформлять как отдельный лист (эскизные про­
рисовки, разработки и т. д.). Кроме того, во фрагментах также хранятся созданные 
типовые решения для последующего использования в других документах. Файл 
фрагмента имеет расширение .frw.

1.2. Основные элементы интерфейса
По сравнению с традиционными Windows-приложениями в КО М ПАС-ЗБ LT 
наложены ограничения на одновременную работу с несколькими документами. 
Таким образом, в главном окне системы может быть открыт только один документ: 
чертеж, фрагмент или деталь.
Команды вызываются из главного меню, контекстного меню или при помощи 
кнопок инструментальных панелей.
При работе с документом любого типа на экране отображаются главное меню и не­
сколько инструментальных панелей: Стандартная, Вид, Текущее состояние, Компактная.
Главное меню системы служит для вызова команд (рис. 1.1). Вызов некоторых из 
них возможен также с помощью кнопок инструментальных панелей. По умолча­
нию главное меню располагается в верхней части окна.

КОМПАС 3D LT V I I

фаійл Вкд Сервис Справка

Рис. 1.1. Главное меню

При выборе пункта меню раскрывается перечень команд этого пункта. Некоторые 
из команд имеют собственные подменю. Для вызова команды (выполнения соот­
ветствующего действия) щелкните мышью на ее названии.
Стандартная панель содержит кнопки вызова команд стандартных операций с фай­
лами и объектами (рис. 1.2).

Рис. 1.2. Стандартная панель

Для вывода ее на экран служит команда Вид ► Панели инструментов ► Стандартная.
Панель Вид содержит кнопки вызова команд настройки вида активного докумен­
та. Набор полей и кнопок панели Вид зависит от того, какой документ активен 
(рис. 1.3).

Рис. 1.3. Панель Вид при работе с деталями



Для вывода ее на экран служит команда Вид ► Панели инструментов ► Вид.
Панель текущего состояния служит для вывода параметров текущего состояния 
активного документа. Набор полей и кнопок панели текущего состояния зависит 
от того, какой документ активен (рис. 1.4).
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Рис. 1.4. Панель текущего состояния при работе с фрагментами

Для вывода ее на экран служит команда Вид ► Панели инструментов ► Текущее со­
стояние.
Компактная панель содержит кнопки переключения между инструментальными 
панелями и кнопки самих этих панелей. Состав компактной инструментальной 
панели зависит от типа активного документа (рис. 1.5).

Панель
переключения

Инструментальная панель 
Редактирование деталей

Редактирование детали

Активизировать инструментальную 
панель

Рис. 1.5. Компактная панель в режиме редактирования детали

Панель свойств служит для управления процессом выполнения команды. На ней 
расположены одна или несколько вкладок и панель специального управления 
(рис. 1.6).

Панель специального управления Панель свойств

: -4-1 ф

\ щ
4¾ , - 1 %  - ' ^ Расстояние 1 30.0 ]у£гон 1 г̂ол 1 0 ■0

JP Параметры ЙТонквя стенка ^Результат операции ^Свойства

юздаите оі ію или отредактируйте параметры

Строка сообщений

Рис. 1.6. Панель свойств

Строка сообщений (если ее показ не отключен при настройке системы) содержит 
подсказки по текущему действию или описание выбранной команды.
Справка по текущему действию или активному элементу интерфейса вызывается 
нажатием клавиши F1, вызов других типов справки — через меню Справка.



1.3. Использование контекстных меню
Команды для выполнения многих часто используемых действий можно вызвать 
из контекстного меню.
Эти меню появляются на экране при щелчке правой кнопкой мыши. Состав меню 
будет разным для различных ситуаций. В нем будут собраны наиболее типичные 
для данного момента работы команды.
Например, во время создания линейного размера при щелчке правой кнопкой 
мыши на экране появится меню, показанное на рис. 1.7.

^  Повторить: Ввод текста
Последние команды ►

Привязка ►
Геометрический калькулятор ►

|~Ў̂~| Автосоздание

Выбор базового объекта

Параллельно объекту 
Горизонтально 

I ^ I Вертикально 
Іекст надписи.,.

Прервать команду 

Рис. 1.7. Контекстное меню при нанесении линейного размера

Таким образом, при выполнении различных действий можно быстро обратиться 
к нужной команде не только через главное меню или инструментальные панели, но 
и через контекстные меню, причем последний способ является наиболее быстрым.

1.4. Управление изображением модели
Для управления масштабом изображения модели предназначены команды Увели­
чить масштаб рамкой, Увеличить масштаб, Уменьшить масштаб, Масштаб по выделенным 
объектам, Приблизить/отдалить, Показать все. Эти команды расположены в меню 
Сервис, а кнопки для их быстрого вызова — на панели управления.
Можно управлять коэффициентом изменения масштаба, использующимся при 
выполнении команд Увеличить масштаб и Уменьшить масштаб.
Чтобы передвинуть изображение модели в окне, щелкните на кнопке Сдвинуть па­
нели Вид или вызовите соответствующую команду из меню Вид.



Для быстрого сдвига изображения (без вызова специальной команды) можно вос­
пользоваться клавиатурными комбинациями Shift+Клавиши со стрелками. Нажатие 
любой из них вызывает перемещение изображения в соответствующую сторону 
Величина перемещения изображения при однократном нажатии управляющей 
клавиатурной комбинации называется шагом перемещения. Величину шага пере­
мещения можно задать.
При создании модели может возникнуть необходимость видеть ее с разных сторон. 
Для этого в KOMI1AC-3D LT предусмотрена возможность вращения модели.
Чтобы повернуть модель, вызывается команда Вид ► Повернуть или нажимается 
кнопка Повернуть панели Вид.
Вы можете вращать модель вокруг центра габаритного параллелограмма, вокруг 
точки (вершины, центра сферы), вокруг оси (вспомогательной оси, прямолиней­
ного ребра, оси операции) или вокруг оси, проходящей через указанную точку пло­
скости (вспомогательной плоскости, плоской грани детали) перпендикулярно ей.
Часто требуется такая ориентация, при которой одна из плоскостей проекций 
располагается параллельно плоскости экрана (в этом случае изображение модели 
соответствует ее изображению на чертеже в стандартной проекции, например, на 
виде сверху или слева). Такую ориентацию трудно получить, поворачивая модель 
мышью. В этом случае для изменения ориентации можно пользоваться предусмо­
тренным системой списком названий ориентаций.
На панели Вид расположена кнопка Ориентация. Щелчок на стрелке рядом с этой 
кнопкой приводит к появлению меню с перечнем стандартных названий ориента­
ций (рис. 1.8): Сверху, Снизу, Слева, Справа, Спереди, Сзади, Изометрия XYZ, Изометрия 
YZX, Изометрия ZXY, Прямоугольная диметрия (каждое из них соответствует направле­
нию взгляда наблюдателя на модель).

Нормально к,..

gp Спереди 
0  - Сзади 
®  Сверху 

®  Снизу
0  Слева 

Справа

Изометрия XYZ 
|^ | Изометрия YZX 

Изометрия ZXY 
^  Диметрия

Рис. 1.8. Меню выбора стандартных ориентаций



В этом меню выбирается команда, соответствующая нужной ориентации. После 
этого изображение перестраивется в соответствии с указанным направлением 
взгляда.
Иногда требуется, чтобы плоскости экрана оказалась параллельна не проекционная 
плоскость, а вспомогательная плоскость или плоская грань детали. Чтобы устано­
вить такую ориентацию, выделите нужный плоский объект и вызовите из меню 
кнопки Ориентация команду Нормально к...
В результате модель поворачивается так, чтобы направление взгляда было перпен­
дикулярно выбранному объекту.
Можно не только использовать стандартные названия ориентаций, но и запоминать 
текущую ориентацию под каким-либо именем, а затем возвращаться к ней в любой 
момент, выбрав это имя в списке. Для этого нажимается кнопка Ориентация — в ре­
зультате на экране появляется диалоговая панель со списком существующих в мо­
дели названий ориентаций. Далее нажимается кнопка Добавить, вводится название 
новой ориентации и нажимается кнопка Выход. Новое название появится в меню 
кнопки Ориентация панели Вид.

1.5. Управление режимом отображения 
детали

При работе в KOMnAC-3D LT доступно несколько вариантов отображения мо­
дели: каркас, представление без невидимых линий или с тонкими невидимыми 
линиями, полутоновое отображение. Чтобы выбрать вариант отображения, вы­
зовите команду Вид ► Отображение и укажите нужный вариант. Можно также вос­
пользоваться кнопками панели Вид.
Каркас представляет собой совокупность всех ребер и линий очерка модели. Чтобы 
отобразить модель в виде каркаса, вызывается команда Вид ► Отображение ► Каркас 
или нажимается кнопка Каркас панели Вид.
При отображении модели с удалением невидимых линий изображение представляет 
собой совокупность видимых (при текущей ориентации модели) ребер, частей 
ребер и линий очерка модели.
Чтобы показать модель без невидимых линий, вызывается команда Вид ► Отобра­
жение ► Без невидимых линий или нажимается кнопка Без невидимых линий панели 
Вид.
Невидимые линии (невидимые ребра и части ребер) можно отобразить отличающим­
ся от видимых линий (более светлым) цветом. Чтобы вывести модель с невиди­
мыми линиями другого цвета, вызывается команда Вид ► Отображение ► Невидимые 
линии тонкие или нажимается кнопка Невидимые линии тонкие панели Вид.
Полутоновое отображение позволяет увидеть поверхность модели и получить 
представление о ее форме. Чтобы получить полутоновое отображение модели, 
вызывается команда Вид Отображение Полутоновое или нажимается кнопка Полуто­



новое панели Вид. При полутоновом отображении модели учитываются оптические 
свойства ее поверхности (цвет, блеск, диффузия и т. д.).
Еще более реалистичное изображение детали в соответствии с особенностями 
зрительного восприятия человека можно получить с помощью перспективы. Точка 
схода перспективы расположена посередине окна детали. Все перечисленные режи­
мы отображения (каркасное, полутоновое, без невидимых линий и с тонкими неви­
димыми линиями) можно сочетать с перспективной проекцией. Для отображения 
модели с учетом перспективы вызывается команда Вид ► Отображение ► Перспектива 
или нажимается кнопка Перспектива панели Вид.
Какой бы тип отображения ни был выбран, он не оказывает влияния на свойства 
модели. Например, при выборе каркасного отображения модель остается сплошной 
и твердотельной (а не превращается в набор «проволочных» ребер), просто ее по­
верхность и материал не показываются на экране.

1.6. Дерево модели
Дерево построения документа — это структурированный список («дерево») объ­
ектов, отражающий последовательность создания документа. Наличие значка + 
рядом с объектом означает, что он имеет подчиненные объекты. Чтобы развернуть 
их список, щелкните мышью на значке. Контекстные меню объектов дерева по­
строения облегчают доступ к командам, которые наиболее часто используются при 
работе с объектами данного типа.
При работе с любой деталью можно вывести на экран окно, содержащее дерево 
модели.
Дерево модели — это графическое представление набора объектов, составляющих 
деталь. Корневой объект дерева — сама деталь. Пиктограммы объектов автомати­
чески возникают в дереве модели сразу после фиксации этих объектов в детали.
В зависимости от выбранного варианта отображения объекты детали могут рас­
полагаться в дереве в порядке их создания или группироваться по типам. Дере­
во модели выводится в отдельном окне, которое всегда находится внутри окна 
документа-детали. В  верхней части окна дерева находится панель управления, 
содержащая четыре кнопки.
В дереве модели имеются: значок начала координат, плоскости, оси, эскизы, значки 
операций и указатель окончания построения модели.
Эскиз, задействованный в любой операции, размещается на «ветви» дерева модели, 
сортветствующей этой операции. Слева от названия операции в дереве отображает­
ся значок +. После щелчка мышью на этом знаке в дереве разворачивается список 
участвующих в операции эскизов. Эскизы, не задействованные в операциях, ото­
бражаются на верхнем уровне дерева модели.
Каждый элемент автоматически возникает в дереве модели сразу после его созда­
ния. Название присваивается элементам также автоматически в зависимости от



способа, которым они получены. Например, «Ось через ребро», «Плоскость через 
три вершины», «Операция вращения», «Фаска» и т. д.
В детали может существовать множество однотипных элементов. Чтобы различать 
их, к названию элемента автоматически прибавляется порядковый номер элемента 
данного типа. Например, «Скругление:1» и «Скругление:2».
Можно переименовать любой элемент в дереве модели. Для этого необходимо 
дважды щелкнуть мышью на его названии — оно откроется для редактирования. 
Введите новое название элемента и щелкните мышью вне списка элементов дерева. 
Новое название элемента будет сохранено в дереве модели.
Слева от названия каждого объекта в дереве отображается пиктограмма, соот­
ветствующая способу, которым этот элемент получен. Пиктограмму, в отличие от 
названия объекта, изменить невозможно. Благодаря этому при любом переимено­
вании элементов в дереве построения остается наглядная информация о способе 
и порядке их создания.
Дерево модели служит не только для фиксации последовательности построения, 
но и для облегчения выбора и указания объектов при выполнении команд.
Обычно пиктограммы отображаются в дереве модели синим цветом. Если объект 
выделен, то его пиктограмма в дереве зеленая. Если объект указан для выполнения 
операции, то его пиктограмма в дереве красная.
Можно отключить показ дерева модели. Для этого в меню Вид выбирается команда 
Дерево построения. Чтобы включить показ дерева, команда вызывается снова. Когда 
режим показа дерева включен, рядом с названием команды в меню присутствует 
«галочка».
Дерево модели выводится в отдельном окне, которое всегда находится внутри окна 
документа-модели. Можно изменять размер окна дерева, перетаскивая мышью его 
углы или границы.



Знакомство
гпдвд с твердотельным 

■ моделированием 
деталей

Трехмерное твердотельное моделирование является единственным средством, 
которое обеспечивает полное и однозначное описание трехмерной геометрической 
формы детали.
Эта глава позволяет получить представление о возможностях твердотельного мо­
делирования деталей в системе КОМПАС-ЗБ LT.

2.1. Формирование основания модели 
детали

В общем случае порядок создания модели включает в себя формирование основа­
ния (рис. 2.1, а), добавление и удаление материала детали (рис. 2.1, б и в), создание 
дополнительных конструктивных элементов (рис. 2.1, г), построение массивов 
элементов и т. д.

а б в г
Рис. 2.1. Этапы создания твердотельной модели детали

Формирование отдельных трехмерных объектов начинается с создания эски­
за — плоской фигуры, на основе которой образуется объемное тело. Эскиз может



располагаться в одной из стандартных плоскостей проекций, на плоской грани 
существующего тела или на вспомогательной плоскости, положение которой за­
дается пользователем. Эскиз создается на плоскости стандартными средствами 
двумерного редактора и состоит из одного или нескольких контуров.
При построении эскиза в системе KOMnAC-3D доступны все команды построения 
и редактирования изображения, а также сервисные возможности. Исключением 
является невозможность ввода некоторых технологических обозначений и объ­
ектов оформления.
По умолчанию в эскизе включен параметрический режим. В этом режиме нано­
сятся параметрические размеры — размеры, управляющие положением выносных 
линий, привязанных к определенным точкам эскиза. С изменением параметриче­
ских размеров изменяется геометрия контуров в эскизе.
В эскиз можно перенести изображение из ранее подготовленного чертежа или 
фрагмента. Это позволяет при создании трехмерной модели опираться на суще­
ствующую чертежно-конструкторскую документацию.
Объемные элементы образуются в результате операций — формообразующих 
перемещений эскизов. В  основе операций лежат показанные на рис. 2.2 способы 
создания трехмерных объектов.

Со?®
Операция выдавливания Кинематическая операция

§т>

Операция вращения Операция по сечениям

Рис. 2.2. Основные формообразующие операции создания трехмерных объектов

Построение трехмерной модели детали начинается с создания основания — ее 
первого формообразующего элемента. Основание есть у любой детали, и оно всегда 
одно. При построении основания можно использовать любую из четырех пред­
ставленных на рис. 2.2 формообразующих операций.



Форма основания детали определяется ее будущей конструкцией. При выборе фор­
мы основания деталь разбивается на составляющие ее формообразующие элементы 
(параллелепипеды, призмы, цилиндры, конусы, торы, кинематические элементы 
и т. д.). При этом мелкие конструктивные элементы (фаски, скругления, проточки 
и т. п.) из рассмотрения исключаются.
Чаще всего в качестве основания используют самый крупный из этих элементов. 
Если в составе детали есть несколько сопоставимых по размерам элементов, то 
в качестве основания можно использовать любой из них.

2.2. Добавление и удаление материала 
детали

Добавление материала детали представляет собой создание в ней новых тел, а так­
же приклеивание к имеющемуся телу (телам) новых элементов. Тело детали — это 
область, ограниченная гранями детали. Считается, что тело детали заполнено одно­
родным материалом детали.
Удаление материала детали подразумевает вырезание формообразующих элемен­
тов из тел.
Как новое тело, так и приклеиваемый или вырезаемый элемент может являться: 
О элементом выдавливания;
О элементом вращения;
О  элементом по сечениям;
О кинематическим элементом.
Построение любого элемента начинается с создания эскиза.
После того как создание эскиза завершено, необходимо указать, каким способом 
требуется перемещать эскиз в пространстве для получения элемента нужного типа, 
то есть необходимо выбрать вид формообразующей операции.
Во время выполнения операции добавления над эскизом можно указать, будет 
ли создаваемый элемент отдельным телом или его необходимо приклеить, то есть 
объединить с другими телами.
Отличие операций удаления материала от операций добавления состоит в том, 
что результатом удаления является не создание нового тела или объединения тел, 
а вычитание или пересечение.
Вычитание формообразующего элемента из тела представляет собой удаление 
материала, находящегося внутри поверхности элемента.
Пересечение формообразующего элемента и тела представляет собой удаление 
материала, находящегося снаружи поверхности элемента.
Чтобы выполнить операцию вырезания из детали формообразующих элементов, 
можно использовать команды подменю Вырезать меню Операции.
Кнопки для вызова этих команд находятся на панели редактирования детали.



2.3. Дополнительные конструктивные 
элементы

К  командам формирования дополнительных конструктивных элементов относятся 
команды создания фасок, скруглений, круглых отверстий, уклонов и ребер жест­
кости. На рис. 2.3, а показан исходный объект, а на рис. 2.3, б и в  — тот же объект 
после создания фаски и скругления.

/О ч

а б в
Рис. 2.3. Результат построения фасок и скруглений на исходном объекте

Команда Фаска позволяет создать фаску на указанных ребрах детали. Команда 
~~ неприменима для ребер, образованных гладко сопряженными гранями.

Команда Скругление позволяет скруглить указанные ребра детали.

Команда Отверстие служит для создания круглого отверстия со сложным про­
филем. Перед вызовом этой команды требуется выделить плоскую грань, на 
которой должно располагаться отверстие. Фантом отверстия с заданными 
параметрами отображается в окне детали. Точка привязки отверстия (она 
помечена на эскизе красным цветом) по умолчанию располагается в начале 
локальной системы координат грани, на которой создается отверстие.

Чтобы разместить отверстие в нужном месте грани, раскройте поле р в строке пара­
метров объектов и укажите положение отверстия мышью или введите координаты 
центра отверстия в поле р.
На рис. 2.4 показано несколько из предлагаемых 14 вариантов форм круглых отвер­
стий, создаваемых с помощью команды Отверстие. Буквами обозначены параметры, 
которым присваиваются необходимые численные значения.
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Рис. 2.4. Примеры круглых отверстий, которые строятся с помощью команды Отверстие



Команда Уклон позволяет придать уклон плоским граням, перпендикулярным 
основанию, или цилиндрическим граням, образующие которых перпенди­
кулярны основанию. То есть команда Уклон дает возможность наклонить 
отдельные грани (рис. 2.5).

Команда Ребро жесткости позволяет создавать ребра жесткости детали 
(рис. 2.6).

Рис. 2.6. Результат выполнения команды Ребро жесткости

2.4. Отсечение, зеркальное копирование 
и построение массивов элементов

Команда Сечение поверхностью позволяет удалить часть детали, находящуюся по 
одну сторону пересекающей эту деталь поверхности.
Если перед вызовом команды была выделена поверхность, пересекающая деталь, 
название этой поверхности появится в поле Поверхность сечения на панели свойств. 
Если поверхность сечения не была выделена перед вызовом команды, то укажите ее.
Команда Сечение по эскизу позволяет удалить часть детали, находящуюся по одну 
сторону пересекающей эту деталь поверхности, образованной перемещением ука­
занного эскиза в направлении, перпендикулярном его плоскости. Перед вызовом 
команды выделяется эскиз, в котором изображен профиль секущей поверхности. 
Команда Зеркальный массив позволяет получить копию выбранных элементов, сим­
метричную им относительно указанной плоскости или плоской грани.
Команда Зеркально отразить тело позволяет создать зеркальную копию тела. Ре­
зультатом выполнения команды может быть либо тело, обладающее плоскостью 
симметрии, либо новое тело, зеркально симметричное имеющемуся. После указа­
ния тела и плоскости симметрии на экране появляется фантом зеркальной копии



детали. Если фантом сформирован верно, то подтверждение создания копии обе­
спечивается щелчком на кнопке Создать объект.
Команда Массив по сетке позволяет создать массив элементов, расположив их 
в узлах параллелограммной сетки.
Команда Массив по концентрической сетке позволяет создать массив элементов, рас­
положив их в узлах концентрической сетки.
Команда Массив вдоль кривой позволяет создать массив элементов, расположив их 
вдоль указанной кривой.
Перед вызовом команд требуется выделить исходные элементы для создания мас­
сива. Это можно сделать, выбрав соответствующие пиктограммы в дереве модели 
или грани элементов в окне детали. После вызова команд на экране появляется 
панель диалога ввода параметров сетки.

2.5. Построение вспомогательных 
элементов

Если существующих в модели граней, ребер и плоскостей проекций недостаточно 
для построений, то можно создать вспомогательные плоскости и оси.
Команды построения вспомогательных осей расположены в меню Операции, а кноп­
ки для их вызова находятся в одной группе на панели Вспомогательная геометрия.
Отрезок, изображающий ось, немного выступает за пределы объектов, на которых 
базировалось построение этой оси. Иногда для понимания расположения оси тре­
буется, чтобы символизирующий ее отрезок был больше (меньше) или распола­
гался в другом месте оси (прямой линии). Можно изменять размер и положение 
этого отрезка, перемещая мышью его характерные точки (они появляются, когда 
ось выделена).
Команда Ось через две вершины позволяет создать одну или несколько конструктив­
ных осей, каждая из которых проходит через указанные опорные точки. Опорными 
точками могут служить вершины, характерные точки графических объектов в эски­
зах (например, конец отрезка, центр окружности и т. п.) или начала координат.
Если перед вызовом команды были выделены какие-либо точки, то они восприни­
маются как опорные для построения оси.
Команда Ось на пересечении плоскостей позволяет создать одну или несколько 
конструктивных осей, каждая из которых является линией пересечения двух кон­
структивных плоскостей и (или) плоских граней (и их продолжений).
Команда Ось через ребро позволяет создать одну или несколько конструктивных 
осей, каждая из которых проходит через указанное прямолинейное ребро модели.
Команда Ось конической грани позволяет создать одну или несколько конструк­
тивных осей, каждая из которых является осью конической (а в частном случае — 
цилиндрической) грани.



Команды построения вспомогательных плоскостей расположены в меню Операции, 
а кнопки для их вызова находятся в одной группе на панели Вспомогательная гео­
метрия.
Прямоугольник, изображающий плоскость, немного выступает за пределы объек­
тов, на которых базировалось построение этой плоскости. Иногда для понимания 
расположения плоскости требуется, чтобы символизирующий ее прямоугольник 
был больше (меньше) или располагался в другом месте плоскости. Можно изме­
нять размер и положение этого прямоугольника, перетаскивая мышью его харак­
терные точки (эти точки появляются, когда плоскость выделена).
Команда Смещенная плоскость позволяет создать одну или несколько вспомогатель­
ных плоскостей, расположенных на заданном расстоянии от указанной плоскости 
или плоской грани детали.
Если перед вызовом команды была выделена плоскость или грань, то она воспри­
нимается в качестве опорного объекта для новой плоскости.
Команда Плоскость через три вершины позволяет создать одну или несколько вспомо­
гательных плоскостей, каждая из которых проходит через три указанные опорные 
точки. Опорными точками могут служить вершины, характерные точки графиче­
ских объектов в эскизах (например, конец отрезка, центр окружности и т. п.) или 
точки начала координат.
Команда Плоскость под углом к другой плоскости позволяет создать одну или не­
сколько вспомогательных плоскостей, проходящих через прямолинейный объект 
под заданным углом к существующему плоскому объекту.
Опорным прямолинейным объектом для построения плоскости может служить 
ребро, отрезок в эскизе или вспомогательная ось. Опорным плоским объектом 
может служить вспомогательная плоскость или плоская грань.
Команда Плоскость через ребро и вершину позволяет создать одну или несколько 
вспомогательных плоскостей, каждая из которых проходит через прямолинейный 
объект и точку.
Команда Плоскость через вершину параллельно другой плоскости позволяет создать 
одну или несколько вспомогательных плоскостей, проходящих через указанные 
точки параллельно указанным конструктивным плоскостям или плоским граням.
Команда Плоскость через вершину перпендикулярно ребру позволяет создать одну 
или несколько вспомогательных плоскостей, проходящих через указанные точки 
перпендикулярно указанным прямолинейным объектам.
Команда Нормальная плоскость позволяет создать одну или несколько вспомога­
тельных плоскостей, нормальных к цилиндрической или конической грани модели.
Так как к любой цилиндрической или конической поверхности можно провести 
множество нормальных плоскостей (все они будут проходить через ось цилиндра 
или конуса), для определения одной из них требуется задать дополнительное 
условие. Для этого укажите плоскость или плоскую грань, параллельно которой 
должна пройти новая плоскость.



Команда Касательная плоскость позволяет создать одну или несколько вспомога­
тельных плоскостей, касательных к цилиндрической или конической грани модели.
Чтобы построить плоскость, касающуюся грани в определенном месте, требуется 
задать линию касания. Линия касания определяется пересечением грани и нор­
мальной к ней плоскости. Поэтому перед вызовом команды Касательная плоскость 
в модели должна быть построена нормальная плоскость, пересекающая нужную 
коническую поверхность в месте касания; в качестве такой плоскости может вы­
ступать и плоская грань, нормальная к поверхности.
Команда Плоскость через ребро параллельно/перпендикулярно другому ребру позво­
ляет создать одну или несколько вспомогательных плоскостей, проходящих через 
указанные прямолинейные объекты параллельно или перпендикулярно другим 
прямолинейным объектам.
Опорными прямолинейными объектами для построения плоскости могут служить 
ребра, вспомогательные оси или отрезки в эскизах.
Команда Плоскость через ребро параллельно/перпендикулярно грани позволяет создать 
одну или несколько вспомогательных плоскостей, проходящих через указанные 
прямолинейные объекты параллельно или перпендикулярно плоским объектам.
Опорными прямолинейными объектами для построения плоскости могут служить 
ребра, вспомогательные оси или отрезки в эскизах. Опорными плоскими объектами 
могут служить вспомогательные плоскости или плоские грани модели.

2.6. Система координат и плоскости 
проекций

В каждом файле детали существует система координат и проекционные плоскости, 
определяемые этой системой. Название этих объектов появляется в окне дерева 
модели после создания нового файла детали. Изображение системы координат 
возникает посередине окна построения модели; чтобы увидеть изображение про­
екционных плоскостей, их нужно выделить в дереве модели.
Плоскости выводятся на экран в виде прямоугольников, лежащих в этих плоско­
стях; такое представление позволяет увидеть расположение плоскости в простран­
стве. Плоскости проекций и систему координат невозможно удалить из файла 
модели. Их можно переименовать, а также отключить их вывод в окне модели.
В системе КОМПАС-ЗБ при ориентации Изометрия XYZ координатные оси и пло­
скости проекций расположены так, как показано на рис. 2.7, а. Эта ориентация не 
совпадает с требованиями ГОСТ 2.319-69 (рис. 2.7, б).
При выполнении чертежа детали необходимо правильно выбрать главное изобра­
жение. Согласно ГОСТ 2.305-68, в качестве главного принимается изображение на 
фронтальной плоскости проекций. Предмет располагают относительно фронталь­
ной плоскости проекций так, чтобы изображение на ней давало наиболее полное 
представление о форме, размерах и функциональном назначении предмета.
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Рис. 2.7. Ориентация координатных осей и плоскостей проекций: 
а — в системе КОМПАС-ЗО; 6 — согласно ГОСТ 2.317-69

При создании трехмерной модели от выбора главного вида зависит форма осно­
вания моделируемой детали и эскиза этого основания. Рисунок 2.8 иллюстрирует 
приемлемую для решения задач создания моделей и чертежей связь между аксоно­
метрическим изображением, расположением эскиза и стандартными видами (при 
различных ориентациях главного вида).
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Рис. 2.8. Связь между аксонометрическим изображением, 
расположением эскиза и стандартными видами



На основе анализа изображений на рис. 2.8 можно дать следующие рекомендации 
относительно выбора начальной ориентации плоскостей проекций при создании 
моделей:
О в общем случае целесообразен выбор ориентации Изометрия XYZ, при этом изо­

бражение в эскизе плоскости YZ должно быть перевернуто;
О выбор ориентации Изометрия YZX оправдан при необходимости получения аксо­

нометрии в прямоугольной диметрической проекции.
Необходимо отметить, что многообразие выбора ориентаций может быть полезно 
при импорте в KOM IIAC-3D моделей из различных систем в разных форматах 
в тех случаях, когда импортируемая модель должна занять адекватное положение.

2.7. Настройка параметров 
и расчет характеристик моделей

Задание свойств детали. Щелкните правой кнопкой мыши в любом пустом месте 
окна модели и в контекстном меню выберите команду Свойства (рис. 2.9).

I ** [ Дерево модели

Отношения в дополнительном окне

Измерить

Нормально к...

Рис. 2.9. Контекстное меню с командой Свойства

Введите обозначение (например, ПМ И Г.ХХХХ10) и наименование детали (Опо­
ра), определите или задайте ее цвет (рис. 2.10), после чего щелкните на кнопке 
Создать объект.

1

А .

Обозначение ПМИГ.ХкХКЮ Наименование Опора

□ □ □ □ □ П И П
Другие цвета... Щ

Цвет { ■  1 ▼ У Оттеские^юйст

Рис. 2.10. Ввод обозначения и наименования детали, задание ее цвета

Управление свойствами поверхности модели. Очень часто параллельные грани 
детали на полутоновом изображении сливаются. Восприятие такого изображения



можно улучшить, если свойства параллельных граней сделать разными. Чтобы за­
дать свойства поверхности (степень блеска, прозрачность т. д.), необходимо вызвать 
панель настройки оптических свойств (рис. 2.11).

Цвет

1 Общий цвет -Л---- 50¾ |і
1 Диффузия ---Л — 60*)?
1 Зеркальность л 80* ;
1 Блеск Л “ 4
П̂розрачность 0¾ 1
1 Излучение 50¾}
Оптические свойства «

Рис. 2.11. Панель настройки оптических свойств

Настроив свойства поверхности, необходимо подтвердить сделанные изменения. 
Выбор материала. При работе с деталью можно выбрать материал, из которого 
она должна изготавливаться. Соответствующая панель Материал (рис. 2.12) вызы­
вается через ту же панель, которая появляется после выбора в контекстном меню 
команды Свойства.

IВыбрать из списка материалов!

Сталь 15Л ГОСТ 977-.

Дптические свойства »  [ Материал <<1| Плотность, г/смЗ|7.820

Рис. 2.12. Панель Материал

На этой панели кнопка Выбрать из списка материалов позволяет выбрать материал 
в справочном файле значений плотности. В окне Плотность материалов можно рас­
крыть нужный раздел и указать марку материала (рис. 2.13).



Плотность материалов хі
Магериал-

Й- Стали 
Й- Чугуны
В- Алюминиевые сплавы 

АДО ГОСТ 4784-97 
АД1 ГОСТ 4784-97 
Д1 ГОСТ 4784-97 
Д16 ГОСТ 4784-97 
АК6 ГОСТ 4784-97

Сплав АЛ8 ГОСТ 1583-93 
АМг2 ГОСТ 4784-97 
АМгб ГОСТ 4784-97 
В95оч ГОСТ 4784-97

HI.. CnnUOLI

Плотность |2.65 г/смЗ
z i

ОК 1 Отмена | Справка |

Рис. 2.13. Окно Плотность материалов

Расположенная на панели Материал кнопка Выбрать из справочника материалов по­
зволяет обратиться к справочнику материалов и сортаментов.
Расчет массо-центровочных характеристик модели. Поддерживаются расчеты 
массы, площади поверхности, объема, координат центра масс, плоскостных, осевых 
и центробежных моментов инерции. Для осуществления расчета на инструменталь­
ной панели Измерения необходимо щелкнуть на соответствующей кнопке.

2.8. Создание ассоциативных видов
Многие трехмерные модели деталей создаются с целью получения конструктор­
ской документации, в том числе чертежей деталей.
В системе КОМПАС-ЗО имеется возможность создания ассоциативных чертежей 
трехмерных деталей. В таких чертежах все виды связаны с моделью так, что из­
менения в модели приводят к изменению изображения в каждом ассоциативном 
представлении.
Ассоциативное изображение формируется в обычном чертеже. В нем создаются 
выбранные пользователем ассоциативные виды и разрезы (сечения) трехмерной 
детали. Виды автоматически располагаются в проекционной связи. При необходи­
мости связь можно отключить — это дает возможность произвольного размещения 
видов в чертеже.
Стандартные виды. Для создания в текущем чертеже стандартных видов детали 
вызовите команду Вставка ► Вид с модели ► Стандартные или щелкните на кнопке 
Стандартные виды панели Ассоциативные виды (рис. 2.14).
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Вставка Инструменты Сервис Окно Справка
ЕЗ Вид

Вид е додели ► Стандартные...
I СЗі I (S .I 0.6996 Ыа-»

□ и Разрез/Сечение

Рис. 2.14. Вызов стандартных видов

После вызова команды на экране появится стандартный диалог выбора файла для 
открытия. Выберите деталь для создания видов и откройте файл. В окне чертежа 
появится фантом изображения в виде габаритных прямоугольников видов.
Для задания параметров создаваемых видов служат элементы управления панели 
свойств (рис. 2.15). В окне Ориентация главного вида с помощью раскрывающегося 
списка можно выбрать требуемую ориентацию главного вида.

После щелчка на кнопке Схема на экране появится диалоговое окно (рис. 2.16), 
в котором можно установить необходимый набор стандартных видов.

Рис. 2.15. Элементы управления параметрами задаваемых видов

Отмена |

Справка

Зазор по горизонтали, мм
Зазор по вертикали, мм 115.00

Рис. 2.16. Диалоговое окно выбора схемы видов

В полях Зазор по горизонтали и Зазор по вертикали можно задать необходимые рас­
стояния между главным видом и остальными видами.



На вкладке Параметры можно также назначить цвет для активных видов чертежа 
и установить изображения, а на вкладке Линии изменить стиль линий видимого 
контура, включить или отключить отображение линий невидимого контура, уста­
новить прорисовку линий переходов.
После выбора нужных стандартных видов и настройки их параметров укажите по­
ложение точки привязки изображения — начало координат главного вида. В чертеж 
будут вставлены выбранные виды детали, в основную надпись чертежа передадутся 
следующие сведения из документа-детали:
О обозначение;
О масса;
О материал.
В результате в дереве построения чертежа появятся пиктограммы созданных видов 
и их названия (рис. 2.17).

Дерево построения 9 X
Q БЕЗ ИМЕНИ
I...Системный вид (1:1)

Й - Щ  (т) Спереди 1 (1:1)
Ф ' В В  Проекционный вид 2(1:1)
ЕЬ1 Й  Проекционный вид 3(1:1)

Рис. 2.17. Пиктограммы созданных видов

Чертеж модели, полученный с помощью команды Стандартные виды, нуждается 
в некоторой доработке, например, добавлении осевых линий, обозначений центров 
и т. п. Кроме того, он не содержит объектов оформления: размеров, технических 
требований и др.
Разрез/сечение. Для создания в текущем чертеже вида, содержащего изображение 
разреза или сечения модели, вызовите команду Вставка ► Вид с модели ► Разрез/ 
сечение или щелкните на кнопке Разрез/сечение панели Ассоциативные виды и ука­
жите в окне чертежа обозначение секущей плоскости. На экране появится фантом 
изображения в виде габаритного прямоугольника.
На панели свойств появятся элементы управления, которые позволят задать 
параметры создаваемых объектов. После настройки всех параметров укажите по­
ложение точки привязки изображения.
В результате в чертеж будет вставлен новый разрез или сечение, в дереве построе­
ния чертежа появится пиктограмма созданного вида и его название.



_____ Создание моделей 
) ГЛАВА и ассоциативных 

чертежей деталей

В  этой главе описаны этапы создания ЗБ-моделей для девяти деталей, упомянутых 
во введении к этой книге, и ассоциативных чертежей по двум моделям.

3.1. Изолятор
В этом разделе мы создадим трехмерную модель изолятора, показанную на рис. 3.1.

Рис. 3.1. Модель изолятора

1. Для создания модели новой детали выпол­
ните команду Файл ► Создать или щелкните 
на кнопке Создать на стандартной панели 
и в открывшемся окне в качестве типа но­
вого документа выберите вариант Деталь.
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2. На панели Вид раскройте список Ориентация 
и укажите вариант Изометрия XYZ.
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3. В дереве модели выберите вариант Пло­
скость ZX.
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В J-  Начало коордшат 

Плоскость XY

j— ф  Плоскость ZY
‘  ̂Ось х

, ОСЬ Y
>. Ось Z

4. На панели Текущее состояние щелкните на 
кнопке Эскиз. В результате плоскость ZX ста­
нет параллельной экрану

ы - г^ і и м и  s[

І
Ь  Эскиз

ВклочитьуЬыклочить режим 
редактцэова-мя эскиза

5. В появившейся компактной панели щел­
кните на кнопке Геометрия для вызова со­
ответствующей инструментальной панели.

ѣ
ш

£
Л

Дерево пс 

Дета

Ѣ  
Ѣ  
*

Геометрия^

6. На панели Глобальные привязки установите 
флажок По сетке, включив соответствую­
щую привязку, а также включите режим 
Изображение сетки на экране.

I Ф ЧШ  -Г(§|г о.о
У( ынопксі гл о б а л ь н ы х  п р и вя зок

3 Ближайшая точка

□  середжа

3 Пересечение

□  касание

□  нормаль

□  Выравнквание 
3 Угловая привязка

□  центр

3 Точка на кривой 

р* Все привязки 
Г7 Ді*имичесхи

ГЗаг*



7. На инструментальной панели в режиме Гео­
метрия выберите команду Окружность 0  |,
с помощью которой по сетке нарисуйте 
эскиз основания детали, содержащий три 
окружности: одну с диаметром 60 и две — 
10 мм. При рисовании каждой окружно­
сти в рабочей области отметьте курсором 
первую и вторую точки: центр и точку на 
окружности требуемого радиуса. Заканчи­
вается эскиз повторным щелчком на кнопке 
Эскиз.

На панели редактирования детали Щ 
щелкните на кнопке Операция выдавлива­
ния •I . Внизу экрана появится панель
свойств, на которой задайте параметры вы­
давливания: Прямое направление; Расстоя­
ние 1 — 20,0. Ввод параметров заканчива­
ется щелчком на кнопке Создать объект в

ф  Средняя плоскость

Ц»рамвн»|Д h'lЙоаХГііѢТ^ 1 |ЯЯР«сто»*«1|2а0~Ш
Рпф иетрц  { Ч т е н и я  станса | ^ Р е зу/ьтатоперации |*ЙСвойства |

9. После выбора на панели Вид команды По­
лутоновое мы получим нужное изображение 
основания втулки. I

Полутоновое
Полутоновое і

Ю.Для удаления материала из основания 
в дереве модели укажите вариант Плоскость 
ZY и щелкните на кнопке Эскиз. Плоскость 
Z Y  станет параллельной экрану. Затем в по­
явившейся компактной панели щелкните 
на кнопке Геометрия для вызова соответ­
ствующей инструментальной панели.

11. Используя команду Непрерывный ввод объ­
ектов, нарисуйте на сетке прямоугольники, 
как показано на рисунке. Заканчивается 
эскиз повторным щелчком на кнопке Эскиз.

Y i



Чтобы завершить создание модели, на инструментальной панели щелкните на
кнопке Вырезать выдавливанием О  и на панели свойств задайте параметры Два
направления и Через все. Получив требуемое изображение, сохраните файл под 
именем Изолятор.

3.2. Вкладыш
В этом разделе мы создадим модель детали вкладыша, показанную на рис. 3.2.

Рис. 3.2. Модель вкладыша

1. Для создания модели новой детали выпол­
ните команду Файл ► Создать или на стан­
дартной панели щелкните на кнопке Соз­
дать и в открывшемся окне в качестве типа 
нового документа выберите вариант Деталь.

I Іоі II.I.-' докуг-ич

ЁГІ

Чертеж
а

Фрагмент

2. На панели Вид раскройте список Ориентация 
и укажите вариант Изометрия XYZ. Нормально к...

0) Спереди 
&\ Сзади 
iff) Сверху 
iff] Снизу 
0 !  Слева 
# !  Справа

ш ш т___
Иэометрия YZX 

ф  Иэометрия ZXY 
іі Деметрия

3. В дереве модели выберите вариант Пло­
скость ZX.

В  деталь (Тел-0)
Начало координат

-Щ Плоскость XY

—Щ Плоскость ZY
- \  ОСЬ X
- \  Ось Y
—\  Ось Z



4. Щелкните на кнопке Эскиз на панели Теку­
щее состояние. Плоскость ZX станет парал­
лельной экрану.

ГЫ SMUI-Tgill Yt[
ВТ ’ 1  ̂ ----------

gj ІЬ  Эскиз
В ВКЛОЧ4ТЬ/ВЫКЛЮЧИТЬ режим 
■  редактирования эскиза

5. В появившейся компактной панели щел­
кните на кнопке Геометрия для вызова со­
ответствующей инструментальной панели.

Дерево пс 

©  Дета

ѣ 
ѣ
А

Г еометрия:

6. На панели Глобальные привязки установите 
флажок, включив соответствующую при­
вязку.

Д ^ іа м ы  xggr 0.0

13 Бгмжайиая точка

□  середина 

0  Пересечение

□  касание

□  норма/ъ

□вьрас 

ЕІ Угловая привязка

□  центр

В точка  на іфквой

j^ -'йаггуммм f эапр
F  onrcneojdeerib

7. На инструментальной панели в режиме Гео­
метрия выберите команду Окружность j;Q
с помощью которой по сетке нарисуйте две 
окружности с диаметрами 80 и 20 мм. Для 
рисования каждой окружности в рабочей 
области отметьте курсором первую и вто­
рую точки: центр и точку на окружности 
требуемого радиуса. При вводе параметров 
можно воспользоваться кнопками панели 
специального управления, которая входит 
в состав панели свойств. Заканчивается 
эскиз повторным щелчком на кнопке Эскиз.



8. На панели редактирования детали Щ  

щелкните на кнопке Операция выдавлива- 
ния Я>|. Внизу экрана появляется панель
свойств, на которой задайте параметры 
выдавливания: Прямое направление; Рас­
стояние 1 — 10,0. Ввод параметров закан­
чивается щелчком на кнопке Создать объ-ект Н

І4̂  Приоеналравлмв
^ Обратное направлете 

p S S S S S S s  Два направлен 
' Средняя плоскость

ЦдомвмІА h 'l Способ I l 5 _ t l i ' 

ІЛерсипры І̂ Томшяспіт [фРевуя
<піИІИМРассп)я>в1|20.0 ^ 
«татолерацт |,2Эсмйства |

9. После выбора на панели Вид команды По­
лутоновое изображение мы получим нуж­
ное изображение основания детали. О

10. Выделите курсором верхнюю грань осно­
вания (грань станет зеленой) и щелкните 
на кнопке Эскиз, затем на инструменталь­
ной панели в режиме Геометрия выберите
команду Прямоугольник ||р|, с помощью
которой по сетке нарисуйте два квадрата. 
Закройте эскиз повторным щелчком на 
кнопке Эскиз.

if®
11. Для создания двух углублений в основа­

нии модели на инструментальной панели 
щелкните на кнопке Вырезать выдавлива­
нием Щ \  и на панели свойств укажите
следующие параметры: Прямое направле­
ние; Расстояние — 5,0. Ввод параметров 
заканчивается щелчком на кнопке Создать
объект

•
12. Для формирования выступов выберите 

вариант Плоскость ZX и щелкните на кноп­
ке Эскиз. Открыв эскиз, выполните коман­
ду Операции ► Спроецировать объект и спро­
ецируйте в эскиз окружность диаметром 
80 мм. В появившейся компактной панели 
щелкните на кнопке Геометрия и выберите
команду Окружность 0  , с помощью ко­
торой нарисуйте по сетке три окружности: 
одну с диаметром 60 и две — 20 мм.

(йя)



13. В режиме редактирования на инструмен­
тальной панели выберите команду Усечь
прямую \? /'\, с помощью которой удалите
четыре дуги. Завершите эскиз щелчком на 
кнопке Эскиз.

14. На панели редактирования детали
щелкните на кнопке Операция выдавлива­
ния g>|. Внизу экрана появится панель
свойств, на которой задайте параметры 
выдавливания: Прямое направление; Рас­
стояние 1 — 30,0. Ввод параметров закан­
чивается щелчком на кнопке Создать объ-

ѳ-ект

15. Для формирования паза выберите вариант 
Плоскость ZY и щелкните на кнопке Эскиз. 
В появившейся компактной панели щел­
кните на кнопке Геометрия для вызова со­
ответствующей инструментальной панели 
и нарисуйте прямоугольник. Завершите 
эскиз щелчком на кнопке Эскиз.

16. Чтобы завершить создание модели, на 
инструментальной панели щелкните на
кнопке Вырезать выдавливанием і і ]  и на
панели свойств задайте параметры Два 
направления и Через все. Ввод параметров 
заканчивается щелчком на кнопке Создать 
объект.

17. Чтобы завершить формирование паза, вы­
берите вариант Плоскость ZX и в созданном 
эскизе нарисуйте два отрезка. Закрыв эс­
киз, в меню Операции выберите команду 
Сечение по эскизу. После щелчка на кнопке
Создать объект | -*-11 мы получим требуемое
изображение.



3.3. Радиатор игольчатый
В этом разделе мы создадим трехмерную модель игольчатого радиатора, показан­
ную на рис. 3.3.

Рис. 3.3. Модель радиатора

1. Для создания модели новой детали выпол­
ните команду Файл ► Создать или на стан­
дартной панели щелкните на кнопке Соз­
дать и в открывшемся окне в качестве типа 
нового документа выберите вариант Деталь.

\ ІОІ II.\s докумп
Новые дш^мвніъі )ш а б ло т |

и  щ | в і |

 ̂ и ѳ т
Чертеж Фрагмент я—

2. На панели Вид раскройте список Ориентация 
и укажите вариант Изометрия XYZ. Нормально к...

Спереди 
9 ' Сзади 

Сверху

S Ci-изу 
Слева 

£7] Сграѳа

ф ] Иэометрия YZX 
¢1  Иэометрия ZXY 

і! Диметрия

3. В дереве модели выберите вариант Пло­
скость ZX. А Л г іВ А

f t  Деталь СГел-0)
Начало коордшат

—Щ Плоскость XY

—Ф  Плоскость ZY
- \  Ось X
- \  Ось Y
- Ч  Ось Z

4. Щелкните на кнопке Эскиз на панели Теку­
щее состояние. Плоскость ZX  станет парал­
лельной экрану.

1 U—л.—л . I Си. I к П  ід ---------------- .
Ь  Эскиз

Вклочлъ/Ььклоч/пъ режим 
редактирования эскиза



5. В появившейся компактной панели щел­
кните на кнопке Геометрия для вызова со­
ответствующей инструментальной панели. 
На инструментальной панели щелкните 
на кнопке Непрерывный ввод объекта и на­
рисуйте прямоугольник со сторонами 
25x50 мм. Щелкните на кнопке Скругление, 
установите значение радиуса 3 мм и скру­
глите углы прямоугольника. Создайте вер­
тикальную ось симметрии и на ней — две 
окружности диаметром 2,7 мм с межцен- 
тровым расстоянием 40 мм. В завершение 
щелкните на кнопке Эскиз.

t ------ і------>
-  А .  .

т

о
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6. На панели редактирования детали 
щелкните на кнопке Операция выдавлива­
ния Д>|. Внизу экрана появится панель
свойств, на которой задайте параметры вы­
давливания: Прямое направление; Расстоя­
ние 1 — 3,0. Ввод параметров заканчивается
щелчком на кнопке Создать объект В-

7. На верхней грани создайте новый эскиз, на 
котором изобразите окружность диаметром 
3 мм на расстоянии 2,5 мм по оси X  и 10 мм 
по оси Y  от нижнего левого угла основа­
ния. Закройте эскиз повторным щелчком 
на кнопке Эскиз.

8. На панели редактирования детали [щ\ 
щелкните на кнопке Операция выдавлива­
ния . Внизу экрана появится панель
свойств, на которой задайте параметры 
выдавливания: Прямое направление; Рас­
стояние 1 — 15,0. Укажите в качестве укло­
на вариант Внутрь, а в качестве параметра 
Угол — значение 1,0. Ввод параметров закан­
чивается щелчком на кнопке Создать объект.



9. Щелкните на кнопке Массив по сетке |
и укажите в дереве модели исходный
объект. Установите для первой оси шаг 5, 
количество 5; для второй оси (угол 90°) — 
шаг 5, количество 7. В завершение щел­
кните на кнопке Создать объект.

10. Удалите пять иголок в центре радиатора, 
как это показано на рисунке.

#
11. В плоскости ZX создайте новый эскиз, 

в котором изобразите центральное от­
верстие диаметром 4,5 мм. Используя ко­
манду Вырезать выдавливанием, создайте 
отверстие. Отметьте все ребра отверстий
(их 6) и щелкните на кнопке Фаска .
Установите параметры фаски 0,5x45° и
щелкните на кнопке Создать объект \+ - *\ .

3.4. Уголок
В  этом разделе мы создадим трехмерную модель уголка, показанную на рис. 3.4.

Рис. 3.4. Модель уголка



1. Для создания модели новой детали выпол­
ните команду Файл ► Создать или на стан­
дартной панели щелкните на кнопке Соз­
дать и в открывшемся окне в качестве типа 
нового документа выберите вариант Деталь.

I ІОІ tl.l̂  ДОІ<уМ<*н
Новьв документы |шаблсэны|

Б )  о )  m l

3 1 ѳ ш
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2. На панели Вид раскройте список Ориентация 
и укажите вариант Изометрия XYZ.

T̂ i*iapifrQ)j
0*. нормально к...

0  Спереди 

&  Сзади 
®  Сверху 
& Омзу 
© Слева 
0  Справа

іійометрияхге
¢) Изометрия Y2X 
0  Изометрия ZXY 
% Диметрия

3. В дереве модели выберите вариант Пло­
скость ZY.

иштж
» fe-l в I
&  Детагь (Тел-0)
Q J-  Начало координат 

Плоскость XY

Щ Плоскость ZY 
Ось X 

- \  OCbY 
- Ч  Ось Z________

4. Щелкните на кнопке Эскиз на панели Теку­
щее состояние. Плоскость ZY станет парал­
лельной экрану.

Ы З . ^ 1  S M U I  j g g l  ѵ* [
U __л.___^  I е. „ I >■ ег . ___________________

Ь  Эскиз

Вклоч'пъ/вьклоч'пъ режим 
редактирования эскизаі

5. В появившейся компактной панели щел­
кните на кнопке Геометрия для вызова со­
ответствующей инструментальной панели. 
На инструментальной панели выберите ко­
манду Непрерывный ввод объектов ЭД |, а за­
тем — команду Скругление и с их помо­
щью изобразите профиль стенки уголка по 
указанным размерам. В завершение щел­
кните на кнопке Эскиз.



6. На панели редактирования детали 
щелкните на кнопке Операция выдавливание 

. Внизу экрана появится Панель свойств,
на которой задайте параметры выдавлива­
ния: Два направления; Расстояние 1 — 15,0, 
Расстояние 2 — 15,0. После ввода параме­
тров щелкните на кнопке Создать объект

в-
7. Установите вид справа, отметьте курсором 

боковую грань уголка и создайте новый 
эскиз. Нарисуйте ломаную линию с исполь­
зованием текущей привязки Точка на кри­
вой, нанесите показанные параметрические 
размеры и закройте эскиз.

8. На инструментальной панели щелкните на 
кнопке Ребро жесткости ' JgjЛ Внизу появит­
ся панель свойств, на которой установите 
следующие параметры: Положение — В пло­
скости эскиза; Обратное направление; Толщина 
стенки — 2,0. После ввода параметров щел­
кните на кнопке Создать объект В-

9. Установите вид слева, отметьте курсором 
боковую грань уголка и создайте новый 
эскиз. Открыв эскиз, выполните команду 
Операции ► Спроецировать объект и спрое­
цируйте в эскиз построенную ранее лома­
ную линию. На инструментальной панели
щелкните на кнопке Ребро жесткости !^pj.
Внизу появится панель свойств, на которой 
установите следующие параметры: Положе­
ние — В плоскости эскиза; Прямое направле­
ние; Толщина стенки — 2,0. После ввода пара­
метров щелкните на кнопке Создать объект.



10. Выделите все горизонтальные ребра жест­
кости, два вертикальных ребра нижней 
стенки и два горизонтальных ребра вер­
тикальной стенки уголка, щелкните на
кнопке Скругление и в качестве радиу­
са скругления укажите значение 3 мм. Для 
завершения ввода параметров щелкните на 
кнопке Создать объект.

*
11. Выделите курсором верхнюю грань основа­

ния уголка и создайте отверстие, щелкнув
на кнопке Отверстие В | . В появившемся
окне Библиотека отверстий выберите вари­
ант Отверстие 03 и задайте следующие па­
раметры: D (диаметр зенковки) — 5,50, d 
(диаметр отверстия) — 4,5, Н (глубина от­
верстия) — 5. Укажите координаты точки 
привязки (0, -15) и щелкните на кнопке 
Создать объект.

*
3.5. Втулка
В этом разделе мы создадим трехмерную модель втулки, показанную на рис. 3.5.

Рис. 3.5. Модель втулки

1. Для создания модели новой детали выпол­
ните команду Файл ► Создать или на стан­
дартной панели щелкните на кнопке Соз­
дать и в открывшемся окне в качестве типа 
нового документа выберите вариант Деталь. 
Затем на панели Вид раскройте список Ори­
ентация и укажите вариант Изометрия XYZ.
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ф  иэометрия ZXY 
ф ; Дкметрия



2. В дереве модели выберите вариант Пло­
скость ZY и откройте эскиз, щелкнув на 
кнопке Эскиз.

> ІЕ-ІВВ
&  Детагъ (Тел-0)
В-*І— Начало координат

Ш  Плоскость XY

Ц| Плоскость ZY
—\  Ось х
- \  Ось Y

- \ . .Q 9 b . L

3. В рабочей области отметьте мышью пер­
вую точку в начале координат и начертите 
эскиз по приведенному рисунку Наличие 
осевой линии обязательно. Для нанесения 
размеров используйте пункты Линейный

20

размер о  и Угловой размер в списке Раз­

меры г Завершите эскиз, повторно щел­
кнув на кнопке Эскиз.

На панели построения детали выберите 
в раскрывающемся меню Операции вариант 
Операция вращения.

т т я
Операция вращения

5. На панели свойств выберите объект Сфе­
роид, задайте прямое направление, угол, 
равный 360°, а в параметрах тонкой стенки 
укажите вариант Нет. В завершение щел­
кните на кнопке Создать объект. После вы­
бора вида Изометрия XYZ и щелчка на кнопке 
Полутоновое модель должна выглядеть так, 
как показано на рисунке.

6. В дереве модели выберите вариант Пло­
скость XY и создайте эскиз, на котором 
изобразите одно углубление прямого 
рифления, как показано на рисунке. Да­
лее выберите в меню Редактор команду Ко­
пия ► По окружности и укажите центр окруж­
ности.

1 Коша ►e g  Я со ѵ м и

Деформация ► Подовой

ээЗРУйиТэ |@ | ГЪдоужности



7. В параметрах копирования в качестве ко­
личества копий в кольцевом направлении 
выберите значение 120, а в качестве шага 
в кольцевом направлении — значение 360°. 
Значение в 120 копий выбрано потому, что, 
согласно ГОСТу, для данного диаметра не­
обходимо создать рифление с шагом 0,8. 
Завершив ввод, щелкните на кнопке Создать 
объект. Внимание, не допускайте пересече­
ния контуров, иначе выполнение операции 
будет невозможно. Завершите эскиз, по­
вторно щелкнув на кнопке Эскиз.

8. В дереве модели выберите вариант Пло­
скость ZX и создайте эскиз, на котором изо­
бразите окружность, щелкнув на кнопке
Окружность j 0  I. После закрытия эскиза
щелкните на кнопке Вырезать выдавлива­
нием и в качестве параметров выберите ва­
рианты Обратное направление и Через все. 
В завершение щелкните на кнопке Создать 
объект. Требуемая модель втулки с вырезом 
одной четверти показана на рисунке.

3.6. Кронштейн
В этом разделе мы создадим трехмерную модель кронштейна, показанную на 
рис. 3.6.

Рис. 3.6. Модель кронштейна



1. Для создания модели новой детали выпол­
ните команду Файл ► Создать или на стан­
дартной панели щелкните на кнопке Соз­
дать и в открывшемся окне в качестве типа 
нового документа выберите вариант Деталь. 
На панели Вид раскройте список Ориентация 
и укажите вариант Изометрия XYZ. В дереве 
модели выберите вариант Плоскость XY.

1
№ ЕгЧѲЮ
f t  Кронилге№ (Гел-О)

В ^ ц д д д д д
Плоскость 2Х 
Плоскость 2Y

1

2. Щелкните на кнопке Геометрия для вызова 
соответствующей инструментальной па­
нели и в рабочей области создайте пока­
занный на рисунке эскиз. Заканчивается 
создание эскиза повторным щелчком на 
кнопке Эскиз.

1

3. На панели редактирования детали Щ 
щелкните на кнопке Операция выдавлива­
ния Д>| ,  а на панели свойств задайте па­
раметры Обратное направление и Расстоя­
ние — 25,0. Ввод параметров заканчивается 
щелчком на кнопке Создать объект. После 
щелчка на кнопке Полутоновое изображение 
на панели управления должно получиться 
показанное на рисунке изображение.

1

4. Для формирования выступов в дереве мо­
дели выберите вариант Плоскость XY, щел­
кните на кнопке Эскиз и нарисуйте четыре 
замкнутые дуги, как показано на рисунке. 
Завершается рисование повторным щелч­
ком на кнопке Эскиз.

1



5. На панели редактирования детали % 
щелкните на кнопке Операция выдавливания 
Ш1, а на панели свойств задайте параме­

тры Прямое направление и Расстояние — 3,0. 
Завершите ввод параметров щелчком на 
кнопке Создать объект.

1

6. В дереве модели выберите вариант Пло­
скость ZY и выполните эскиз прямоуголь­
ника.

Z

7. Выполните команду Вырезать выдавливани­
ем 0 1 и на панели свойств задайте пара­
метр Через все.

х

8. Для создания отверстия выделите курсо­
ром верхнюю грань основания (грань ста­
нет зеленой) и щелкните на кнопке Отвер­
стие В|. В появившемся окне Библиотека
отверстий выберите вариант Отверстие 03 
и задайте следующие параметры: D (диа­
метр зенковки) —10,4, d (диаметр отвер­
стия) — 5 и Н (глубина отверстия) — 5. 
Укажите координаты точки привязки для 
центра отверстия, например, (27,5; 7,5) 
и щелкните на кнопке Создать объект.

ѣ '



9. Для создания скруглений выделите соот­
ветствующие элементы, щелкните на кноп­
ке Скругление •I , в качестве параметров 
установите значения радиусов скругления 
и щелкните на кнопке Создать объект. Для 
формирования фасок в двух верхних от­
верстиях щелкните на кнопке Фаска |^|
и в качестве параметров установите сле­
дующие значения: Длина — 1,0; Угол — 45,0. 
Выделите соответствующие ребра. В завер­
шение щелкните на кнопке Создать объект.

10. Чтобы завершить создание модели, дваж­
ды воспользуйтесь командой Зеркально 
отразить тело, которая позволяет к детали 
приклеить зеркальную (относительно вы­
бранной грани) копию. Результат первого 
применения команды показан на рисунке, 
результат второго — в начале этого раздела 
(см. рис. 3.6).

3.7. Корпус
На практике встречаются задачи, в которых по плоскому чертежу требуется соз­
дать трехмерную модель детали. Рисунок 3.7 иллюстрирует последовательность
создания двух проекций корпуса.
Дадим краткий комментарий этих семи этапов построения двух проекций корпуса:
1. Линиями соответствующих стилей при включенной привязке По сетке изобра­

жаются отрезки и окружности.
2. Элемент крепления на виде сверху изображается с использованием команд 

Окружность, Отрезок, Дуга, Выровнять по границе, Скругление.
3. Используется команда Копия по окружности.
4. С помощью вспомогательных прямых осуществляется прорисовка элементов 

вида сверху.
5. На виде спереди делаются необходимые скругления и изображается элемент 

крепления.
6. На виде спереди изображается еще один элемент крепления.
7. На виде спереди изображается проекция бокового прямоугольного отверстия.



Рис. 3.7. Этапы создания двух видов корпуса

Упражнение данного раздела состоит из двух частей. Сначала, используя приведен­
ную информацию, мы построим две проекции корпуса, а затем по двум видам с по­
мощью приведенной далее инструкции мы создадим трехмерную модель корпуса.

1. Откройте файл, содержащий чертеж де­ Реджтор 1 Вил Вздемть Вставка 1*
тали, выделите главный вид и выберите Отмежть Ctrl+Z

в главном меню команду Редактор ► Копи­ Псзтсэктэ Sh;t+Alt+3cCi>pcI6

ровать. В качестве точки привязки при вы­ ,¾ Вьремть Ctrl+X

полнении копирования укажите точку пе­ 1¾ Копировать СЫ+Insert 1
ресечения осевой линии с нижней линией
основания детали.



2. На стандартной панели щелкните на кноп­
ке Создать, в открывшемся окне выберите 
вариант Деталь в качестве типа нового до­
кумента и щелкните на кнопке ОК. В де­
реве модели выберите вариант Плоскость 
XY и щелкните на кнопке Эскиз на панели 
текущего состояния. Включите режим По 
сетке и установите шаг сетки равным 2,5.

1
В

| Л  8 M U I  і Щ і ѵ* 10.0

0  Ближайшая точка 

О Середина 

В  Пересечение

□  касание

□  нормагь

□  выравнивание 
В  Углевая привязка 

□ ц ен тр
И Точка на кривой

[* Все прквяэо* Г" Запр 
F" Дшамически отслеживать

3. В главном меню выберите команду Редак­
тор ► Вставить и расположите вставленный 
фрагмент так, чтобы точка привязки со­
впала с началом координат. Отредактируй­
те эскиз, оставив на нем только контуры 
половины детали и удалив изображение 
боковых креплений. Через начало коор­
динат проведите линию, выбрав для стиля 
отрезка вариант Осевая. Завершите эскиз, 
повторно щелкнув на кнопке Эскиз.

1

4. На инструментальной панели Редактиро­
вание детали выберите в раскрывающемся 
меню Операции тип выполняемого действия 
Операция вращения. На панели свойств за­
дайте прямое направление и угол 360°. 
Щелкните на кнопке Создать объект. В ре­
зультате выполнения данной операции 
будет получена цилиндрическая часть 
создаваемой детали с необходимыми цен­
тральными отверстиями.

ШшШа :
1 Операция вращения

5. После выбора ориентации Изометрия XYZ 
и щелчка на кнопке Полутоновое, изобра­
жение модели должно выглядеть так, как 
показано на рисунке.

в



6. Сохранив, созданную модель, снова от­
кройте исходный чертеж. Выделите на виде 
сверху контуры одного из боковых крепле­
ний с отверстием и скопируйте фрагмент 
чертежа в буфер обмена так же, как было 
описано ранее (для удобства при копиро­
вании точку привязки расположите так, 
чтобы она совпала с центром окружности 
в основании цилиндрической части дета­
ли). Затем перейдите к файлу с сохранен­
ной деталью. Создав новый эскиз, вставьте 
скопированный фрагмент и отредактируйте 
его.

О
7. Закончив редактирование, примените 

к эскизу команду Операция выдавливания
Щ1 и на панели свойств в нижней части

экрана установите параметры Прямое на­
правление и Расстояние 10. После этого на­
жмите кнопку Создать объект. Далее, выбрав 
вид Изометрия XYZ и выделив верхнюю грань 
крепления, примените команду Скругление

к одному из ребер этой грани.

•
8. В файле чертежа, используя команду Редак­

тор ► Скопировать, скопируйте окружность 
цилиндрического углубления, имеющего­
ся в креплении. Перейдя к файлу модели, 
создайте эскиз на верхней грани крепле­
ния. Вставьте из буфера обмена окружность 
цилиндрического углубления. Используя
команду Вырезать выдавливанием ІЭ  |, соз­
дайте углубление.

а
9. Для создания копии крепления под углом 

120° к исходному образцу на расширенной 
панели команд построения конструктив­
ных осей панели Вспомогательная геометрия 
щелкните на кнопке Ось конической поверх­
ности. После этого необходимо щелкнуть на 
внутренней цилиндрической поверхности 
детали. Когда система построит ось, щел­
кните на кнопке Прервать команду.

«а
ІЖ
Ф_

■““ І Ось конической поверхности |



10. На расширенной панели команд создания 
массивов панели Редактирование детали 
щелкните на кнопке Массив по концентриче­
ской сетке. Далее в дереве модели укажите 
все элементы, относящиеся к построению 
крепления, и созданную ось конической по­
верхности. После этого на панели свойств 
задайте число копий равным 3 в кольцевом 
направлении, шаг в кольцевом направле­
нии выберите равным 360° (копии распо­
лагаются под углом, равным частному от 
деления 360° на количество копий). В ради­
альном направлении число копий должно 
быть равно 1, так как все копируемые объ­
екты располагаются на одной окружности. 
Завершив ввод, щелкните на кнопке Создать 
объект.

Ч — ---------“ —

т  
Щ
ш к

—Н  Массив по конц ентрической сетке |

11. Перейдите к файлу с чертежом детали. 
Скопируйте в буфер обмена окружность 
сквозного отверстия в цилиндрической ча­
сти детали. В файле детали, выбрав вари­
ант Плоскость XY в дереве модели, создайте 
новый эскиз, на который поместите скопи­
рованную окружность так, чтобы она рас­
полагалась на 25 мм выше горизонтальной 
плоскости проекций. К созданному эскизу 
примените команду Вырезать выдавливанием 
с параметром Два направления, указав для 
каждого направления параметр Через все.

12. На плоскости ZY создайте эскиз прямоу­
гольного отверстия в стенке цилиндри­
ческой части детали. Нижняя сторона 
прямоугольника должна располагаться 
на расстоянии 17 мм от горизонтальной 
плоскости проекций, высота равняться 
15 мм, ширина — 20 мм. Снова примените 
к завершенному эскизу команду Вырезать 
выдавливанием, указав параметры Обратное 
направление и Через все.

В результате мы получим требуемую модель корпуса, которая с вырезом одной 
четверти показана на рис. 3.8.



Рис. 3.8. Готовая модель корпуса с вырезом одной четверти

3.8. Пружина
В этом разделе мы создадим трехмерную модель пружины по размерам, указанным 
на чертеже (рис. 3.9).
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Рис. 3.9. Чертеж пружины

1. На стандартной панели щелкните на кноп­
ке Создать и в открывшемся окне в качестве 
типа нового документа выберите вариант 
Деталь. На панели Вид раскройте список 
Ориентация и укажите вариант Изометрия 
XYZ. В дереве модели выберите вариант Пло­
скость XY.

1
& §£лІ Н ® .

\

f t  Деталь (Гел-О)
ЕЭ-̂ Ц Начало координат 

j-% Плоскость XY

ЬШ Плоскость ZY 
і - \  ОСЬ X 
| - \  Ось Y 
!- Ч  Ось Z

2. Из меню Операции вызовите панель Про­
странственные кривые, щелкните на кнопке 
Спираль цилиндрическая и на вкладке По­
строение задайте параметры спирали: Число 
витков — 10,0, Шаг — 4,0.

©1 n,t ЧИСЛ98ИГМ»|100 :!ш«-|4.0 t В
¢) J - ' Jj |3 Постройте 0Диаиетр ^Свойства |



3. Перейдите на вкладку Диаметр и в поле Диа­
метр задайте диаметр спирали равным 25,0.

|3 Построение 0  Диаметр Свойства

4. Щелкните на кнопке Создать объект или 
нажмите клавиши Ctrl+Enter. В результате 
должно получиться показанное на рисунке 
изображение.

5. В дереве модели выберите вариант Пло­
скость ZX, после чего, открыв эскиз, вы­
полните команду Операции ► Спроецировать 
объект и спроецируйте в эскиз простран­
ственную кривую. Измените стиль линии 
проекции, выбрав вариант Утолщенная. Изо­
бразите окружность радиуса 1 мм.

6. В меню Операции выберите команду Опера­
ция ► Кинематическая.

7. В качестве траектории в дереве модели вы­
берите вариант Спираль цилиндрическая 1 
и щелкните на кнопке Создать объект, что­
бы получить изображение, показанное на 
рисунке. В результате в поле Траектория 
появится запись Ребра 1.

В дереве модели выберите вариант Пло­
скость ZY, откройте эскиз и для моделиро­
вания подрезания изобразите два прямоу­
гольника, отстоящие друг от друга на 35 мм 
(длина пружины), после чего закройте 
эскиз.
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9. Чтобы завершить создание модели, на ин­
струментальной панели щелкните на кноп­
ке Вырезать выдавливанием Е і| и на панели
свойств укажите параметры Два направ­
ления и Через все. В результате мы получим 
показанное на рисунке изображение.

3.9. Опора
3.9.1. Использование в модели переменных 

из эскизов
Нанесение в эскизах операций параметрических размеров, которым сопоставлены 
переменные, позволяет изменять размеры модели, не прибегая к прямому редак­
тированию отдельных элементов.
В этом разделе мы создадим трехмерную модель опоры, у которой сделаны сквоз­
ные вырезы по нанесенной разметке (рис. 3.10).

2 выреза выполнить

1. На стандартной панели щелкните на кноп­
ке Создать и в открывшемся окне в качестве 
типа нового документа выберите вариант 
Деталь. На панели Вид раскройте список 
Ориентация и укажите вариант Изометрия 
XYZ. В дереве модели выберите вариант Пло­
скость ZY.

fr ЕвЧ ВЮ
f t  детагь (Тел-0)
B - J -  Начало координат

—Щ  Плоскость XY

- Щ  Плоскость ZY
\  ОСЬ X

- \  OCbY
~ Ч  Ось 2



2. Щелкните на кнопке Эскиз на панели Теку­
щее состояние и выполните установку гло­
бальных привязок, таких как Ближайшая 
точка, Пересечение, Выравнивание, Угловая 
привязка. Используя команду Непрерывный 
ввод объектов, приближенно нарисуйте кон­
тур. Нанесите четыре размера, указав в со­
ответствующих полях окна Установить значе­
ние размера требуемые значения, присвоив 
переменным имена L, LI, Н, Н1 и сделав ком­
ментарии, например Габарит по длине, и т. д.
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3. На стандартной панели щелкните на кноп­
ке Переменные.

GCf»c &

4. На экране появится окно Переменные, пред­
назначенное для работы с переменными 
и выражениями. Щелкните на символе+сле­
ва от названия модели Деталь. Ниже откро­
ется список всех объектов, составляющих 
модель. Щелкните на символе + слева от на­
звания эскиза Эскиз:1. Ниже откроется спи­
сок всех переменных, созданных в эскизе.

5. Щелчком мыши сделайте текущей ячейку 
Выражение для переменной L1 и введите 
выражения L/4. Для переменной Н1 введите 
выражения Н/3.

6. Закройте эскиз и примените к нему опера­
цию Выдавливание ► Два направления, указав 
одинаковые расстояния для обоих направ­
лений, например 24 мм. *

7. В дереве модели выберите вариант Пло­
скость XY. Открыв эскиз, выполните ко­
манду Операции ► Спроецировать объект 
и спроецируйте в эскиз показанное ребро. 
Измените стиль линии проекции, выбрав 
вариант Утолщенная. Постройте вертикаль­
ный отрезок со стилем линии Осевая. По­
стройте прямоугольник с двумя скруглен­
ными углами.



8. Нанесите два горизонтальных размера 
и один вертикальный, присвоив им име­
на Н2 и В1, В2, задайте также радиаль­
ный размер. На панели Параметризация 
щелкните на кнопке Совпадение радиусов, 
укажите две дуги и щелкните на кнопке 
Запомнить состояние. Затем на стандартной 
панели щелкните на кнопке Переменные, 
чтобы открыть окно, предназначенное для 
работы с переменными и выражениями. 
Аналогично изложенному введите для 
переменной Н2 выражения Н/3, а для пере­
менной В1 — выражение В2*2.
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9. Закройте эскиз, щелкните на кнопке Выре­
зать выдавливанием и на вкладке Параметры 
в качестве параметров выберите варианты 
Обратное направление и Через все. *

10. В дереве модели выберите вариант Пло­
скость ZX. Открыв эскиз, выполните ко­
манду Операции ► Спроецировать объект 
и спроецируйте в эскиз показанное ребро. 
Измените стиль линии проекции, выбрав 
вариант Утолщенная. Включите привязки 
Выравнивание и Точка на кривой. Постройте 
вертикальный отрезок со стилем линии 
Осевая. Постройте окружность и проставь­
те диаметральный размер. Щелкните на 
кнопке Точка на прямой на панели Параме­
тризация. Укажите осевой отрезок и центр 
окружности. Постройте треугольник. 
Проставьте один горизонтальный размер 
и два вертикальных, присвоив одному из 
них имя L2. Для переменной L2 введите 
выражения 0.625*L.

11. Закройте эскиз, щелкните на кнопке Вы­
резать выдавливанием Ш \  и на вкладке
Параметры в качестве параметров выберите 
варианты Обратное направление и Через все.
Установите уклон 10°.



12. Войдите в режим редактирования эскиза 
детали Опора_1 (Эскиз: 1). Для этого вы­
делите в дереве модели соответствующую 
строку. После этого на стандартной панели 
щелкните на кнопке Переменные и в таблице 
установите новые значения для перемен­
ных Н (30,0) и L (80,0). Обратите внимание 
на то, что в параметрах Эскиз: 2 и Эскиз: 3 
произошли изменения.

13. Закройте эскиз и щелкните на кнопке Пе­
рестроить на панели Вид. В окне документа 
модель будет изменена в соответствии с но­
выми значениями переменных. Сохраните 
файл под именем Опора J2.
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3.9.2. Создание в модели переменных, 
соответствующих параметрам элементов

Делать переменными можно не только ассоциативные размеры в эскизах, но и па­
раметры элементов в дереве модели.

1. Войдите в режим редактирования эскиза 
детали Опора_1 (Эскиз: 1). Для этого вы­
делите в дереве модели соответствующую 
строку. Затем на стандартной панели щел­
кните на кнопке Переменные и в окне Пере­
менные откройте следующие уровни эле­
ментов:

Операция выдавливания: 1;
Вырезать элемент выдавливания: 1;

■ Вырезать элемент выдавливания: 2.
После этого установите в таблице новые 
значения для переменных V30 (40,0), ѴЗЗ 
(40,0), Ѵ55 (12,0), Ѵ94 (0,0) и введите текст 
в поле Комментарий.

и f  с
В4м«%(ГеМф
К (т)И*ют стрижа; 
DE Эгоа;]
Е Сферам»

4Z7

Y3Z
ѵО] :Y<J5 !

DC 2соо;2
Е Вьсеээть ме*<кг быымввжяіі

ѵэа
\<Я 

К  ЭоооіЗ
Вьоовть x»e*<tfT m u M iM tt t i2



2. Закройте эскиз и щелкните на кнопке Пере­
строить на панели Вид. В окне документа 
модель будет изменена в соответствии с но­
выми значениями переменных. Сохраните 
файл под именем Опора З .

3.9.3. Добавление отверстий с резьбой
Важным этапом создания моделей деталей, соединяемых стандартными крепеж­
ными изделиями, является выбор параметров отверстий для этих изделий.
На рис. 3.11 упрощенно изображены отверстие (слева) для установки шпильки 
и сама шпилька (справа), ввернутая в деталь из стали, а также приведены соот­
ношения для задания параметров отверстия.
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Рис. 3.11. Параметры отверстия для установки шпильки

Верхнее соотношение основано на положении ГОСТ 2.311-68: сплошную тонкую 
линию при изображении резьбы, как это показано на шпильке, наносят на рас­
стоянии не менее 0,8 мм от основной линии и не более величины шага резьбы. На 
рисунке тонкие линии при изображении резьбового отверстия не показаны, но надо 
понимать, что они располагались бы на расстоянии Х/2 с двух сторон от осевой 
линии. Реализация остальных соотношений требует обращения к ГОСТ 10549- 
80, в котором указаны размеры а  — для недорезов и z — для фасок внутренней 
метрической резьбы.
Мы завершим построение ЗБ-модели опоры, добавив в модель два отверстия для 
вворачивания в них шпилек (винтов) Мб с крупным шагом. Материал опоры — 
сталь. При таком выборе d = 4,4 мм, Н = 12 мм, z = 1 мм.

1. Откройте файл Опора_1 и укажите верх­
нюю грань опоры (грань станет зеленой).



2. На панели редактирования детали щелкни­
те на кнопке Отверстие и в окне библиотеки 
отверстий укажите вариант Отверстие 04. 
Далее в таблице параметров задайте глуби­
ну отверстия Н (12 мм), диаметр отверстия 
d (4,4 мм), диаметр зенковки D (6,4 мм).
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3. Задайте координаты центра отверстия. ‘ ®  [ХІт 1-18.0 j -8.0

4. Щелкните на кнопке Создать объект. В про­
фессиональной версии KOMI1AC-3D мож­
но создать условное изображение резьбы на 
цилиндрической или конической поверхно­
сти детали для правильного ее отображения 
на чертеже.

5. На панели редактирования детали щелкни­
те на кнопке Зеркальный массив и в дереве 
модели укажите варианты Плоскость ZY и От­
верстие: 1, после чего щелкните на кнопке 
Создать объект. Сохраните файл под именем 
Опора.

3.10. Построение ассоциативного 
чертежа уголка

В этом разделе мы построим чертеж созданной ранее (см. раздел 3.4) трехмерной 
модели уголка.

1. Для создания чертежа выполните команду 
Файл ► Создать ► Чертеж и сохраните чертеж 
на диске под именем Уголок в той же папке, 
что и файл трехмерной модели.

2. Для создания стандартных видов выпол 
ните команду Вставка ► Вид ► Вид с мо 
дели ► Стандартные.
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3. Откройте документ Уголок.

4. На вкладке Параметры панели свойств в 
списке Ориентация главного вида выберите 
вариант Справа и установите флажок Линии 
переходов.
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5. Щелкните на кнопке Схема видов. В поля За­
зор по горизонтали и Зазор по вертикали вве­
дите расстояние между видами в горизон­
тальном (40 мм) и вертикальном (50 мм) 
направлениях, затем укажите курсором на 
пунктирную габаритную рамку главного 
вида и щелкните на кнопке ОК. Располо­
жите фантом стандартных видов в поле 
чертежа. На чертеже останутся два вида: 
сверху и слева.
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6. Сделайте текущим проекционный вид 2 
и включите привязки Выравнивание и Точ­
ка на прямой. На панели Обозначения щел­
кните на кнопке Линия разреза. Укажите 
на горизонтали, проходящей через центр 
отверстия, две точки, через которые должна 
пройти линия разреза. Для правильного за­
дания направления взгляда курсором ука­
жите расположение стрелок.

аГ І И І Т а

7. Щелкните на кнопке Разрез/сечение на 
странице Ассоциативные виды и укажите 
курсором на любом элементе линии разре­
за. После этого на экране появится фантом 
изображения разреза в виде габаритного 
прямоугольника. Щелкните на кнопке По­
казать все. При необходимости измените 
положение видов.



8. Для включения в чертеж аксонометри­
ческой проекции выполните команду 
Вставка ► Вид с модели ► Стандартные. От­
кройте документ Уголок и на вкладке Па­
раметры панели свойств в поле Ориентация 
главного вида выберите вариант Изометрия 
XYZ, после чего щелкните на кнопке Схема 
видов. Укажите курсором на пунктирные га­
баритные рамки двух видов, оставив глав­
ный, и щелкните на кнопке ОК. Расположи­
те фантом изометрии в поле чертежа.

А:А

Л
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9. Сделайте текущим вид под номером 4 — 
сечение А-А, щелкните на кнопке Выносной 
элемент на инструментальной панели Обо­
значения и постройте обозначение выносно­
го элемента. Для этого укажите централь­
ную точку контура выносного элемента, 
затем — точку на контуре и точку начала 
полки. аГ

Создаваемый ассоциативный чертеж в системе KOMIIAC-3D имеет определенные 
отступления от требований ЕСКД, устранить которые в получаемых изображениях 
невозможно, так как изображения недоступны для редактирования. Для рассматри­
ваемого примера отметим, что недостатком построенного системой фронтального 
разреза А-А является невозможность удаления линии разреза и обозначений этой 
линии и разреза. Согласно ГОСТ 2.305-68, положение секущей плоскости не от­
мечают и разрез надписью не сопровождают в случаях, когда секущая плоскость 
совпадает с плоскостью симметрии предмета и разрезы расположены в непосред­
ственной проекционной связи.
Чтобы создаваемый чертеж полностью соответствовал требованиям ЕСКД, необ­
ходимо разрушить ассоциативные связи в двух видах и выполнить необходимое 
редактирование. После этого редактирования, нанесения осевых линий и размеров 
изображение в поле чертежа должно выглядеть так, как показано на рис. 3.12.
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Рис. 3.12. Фрагмент чертежа уголка

3.11. Построение ассоциативного 
чертежа опоры

При создании ассоциативного чертежа между чертежом и моделью формируется 
ассоциативная связь, благодаря которой любое изменение модели автоматически 
отражается на чертеже в форме изменения значений и положения размеров и тех­
нологических обозначений. Это достигается за счет формирования в режиме пара­
метризации ассоциативных связей между геометрическими элементами, размерами 
и обозначениями в чертеже. В системе KOMnAC-3D LT режим параметризации 
недоступен, поэтому мы рассмотрим этапы создания ассоциативного чертежа 
в полной версии KOMIIAC-3D.
В этом разделе мы создадим чертеж выполненной ранее (см. раздел 3.9) трехмерной 
модели опоры.

1. Для создания чертежа выполните команду 
Файл ► Создать ► Чертеж и сохраните чертеж 
на диске под именем Опора в той же папке, 
что и файл трехмерной модели.
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2. Вызовите команду Сервис ► Параметры, 
открыв диалоговое окно Параметры, и на 
вкладке Текущий чертеж в левой части окна, 
сделайте текущей ветвь Параметризация, 
расположенную в нижней части дерева па­
раметров. Далее в правой части окна уста­
новите два флажка Все в группах Ассоциати- 
ровать при вводе и Параметризировать, после 
чего щелкните на кнопке ОК.

3. Повторите шаги 2-7 из пошаговой проце­
дуры раздела 3.10. Вставку видов произ­
ведите в масштабе 1:2. В результате в поле 
чертежа должны появиться показанные на 
рисунке изображения.

А-А
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4. Сделайте текущим проекционный вид 2. 
Проведите к ребру углового среза перпен­
дикулярную прямую. На панели Обозна­
чения щелкните на кнопке Линия разреза и 
укажите на перпендикулярной прямой две 
точки, через которые должна пройти ли­
ния разреза. Для правильного задания на­
правления взгляда курсором расположите 
стрелки. Щелкните на кнопке Разрез/сече­
ние на панели Ассоциативные виды и укажите 
курсором на любой элемент линии разреза. 
После этого на экране появится фантом 
изображения разреза в виде габаритного 
прямоугольника. Выделите вид Разрез Б-Б 
щелчком на его габаритной рамке.

Б-Б

5. Сделайте текущим проекционный вид 3 
и постройте в нем замкнутый контур, огра­
ничивающий местный разрез. Щелкните 
на кнопке Местный разрез на панели Ассо­
циативные виды и укажите курсором постро­
енный замкнутый контур (он высветится 
красным цветом). Не переключая текущий 
вид, на разрезе А-А покажите положение се­
кущей плоскости местного разреза. На виде 
слева система постгюит местный ъазъез.



6. Сделайте текущим проекционный вид 3. 
Щелкните на кнопке Выносной элемент на 
панели Обозначения и постройте обозначе­
ние выносного элемента. Для этого укажите 
центральную точку контура выносного эле­
мента, затем — точку на контуре и точку на­
чала полки. После этого система перейдет 
в режим автоматического построения вы­
носного элемента.

7. На панели свойств раскройте список Мас­
штаб и укажите масштаб 2:1. V

ВьноснаЯэІЦоетДД-Ц Масштаб

8. Перейдите на вкладку Обозначение вида 
и установите флажок Масштаб для автома­
тического формирования текстовой ссылки 
на масштаб вида в его заголовке.
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9. Укажите положение выносного элемента в 
поле чертежа.

Как уже отмечалось, создаваемый ассоциативный чертеж в системе КОМПАС- 
3D имеет определенные отступления от требований ЕСКД, устранить которые 
в получаемых изображениях невозможно, так как изображения недоступны для 
редактирования. Следует отметить следующие нарушения стандартов:
□ В построенном местном разрезе Б-Б и выносном элементе А линия, ограни­

чивающая местный разрез и выносной элемент, должна быть сплошной вол­
нистой.

□ На выносном элементе и на виде сверху условное изображение резьбы, полу­
ченное из трехмерной модели, не соответствует требованиям ГОСТ 2.311-68.

Чтобы создаваемый чертеж полностью соответствовал требованиям ЕСКД, не­
обходимо разрушить ассоциативные связи в соответствующих видах и выполнить 
необходимое редактирование. После этого редактирования, нанесения осевых ли­
ний и размеров изображение в поле чертежа должно выглядеть так, как показано 
на рис. 3.13.



Рис. 3.13. Чертеж опоры

3.12. Учебное пособие «Азбука КОМПАС»
В заключительном разделе главы, посвященной ЗБ-технологии создания твердо­
тельных моделей деталей и чертежей по этим моделям, следует упомянуть о встро­
енном электронном учебном пособии «Азбука КОМПАС».
«Азбука КОМПАС» — это интерактивное учебное пособие, реализованное в виде 
отдельного файла. В пособии, входящим в поставку КОМПАС-ЗБ, представлено 
13 уроков по освоению ЗБ-технологии (рис. 3.14).
В пособии, входящем в комплект поставки KOMnAC-3D LT, представлено 6 уро­
ков. Это уроки 1, 2, 10, 11, 12, обозначенные на рис. 3.14. Урок 11 для пособия 
«Азбука КОМПАС-ЗБ LT» разбит на два.
В поставку КОМПАС-ЗБ V II включена «Азбука КОМПAC-График» (рис. 3.15).
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Рис 3.14. Первая страница «Азбуки КОМПАС-ЗЭ»

Рис 3.15. Первая страница «Азбуки КОМПАС-График»



Освоение интерактивных учебных пособий «Азбука КОМПАС» будет способ­
ствовать ускоренному изучению 2D- и ЗБ-технологий создания конструкторской 
документации и твердотельных моделей изделий.
Для углубленного изучения системы KOMnAC-3D VII можно порекомендовать 
книгу [8].
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г. . „ .  Общие сведения 
о системе SolidWorks

Система SolidWorks предназначена для создания твердотельных параметрических 
моделей деталей и последующего полуавтоматического выполнения их рабочих 
чертежей, содержащих все необходимые типы изображений.
SolidWorks также поддерживает поверхностное моделирование, проектирование 
деталей, изготовленных литьем, проектирование деталей, изготовленных из ли­
стового материала.
Для SolidWorks разработан ряд приложений: CosmosWorks обеспечивает прочност­
ной расчет деталей методом конечных точек; CosmosMotion — расчет кинематики 
и динамики механизма и др.
При разработке функций и интерфейса SolidWorks учитывались приемы рабо­
ты, свойственные машиностроительному проектированию. Система специально 
ориентирована на операционную среду MS Windows и в полной мере использует 
все ее возможности для предоставления пользователю максимального комфорта 
и удобства в работе.

4.1. Основные типы документов
В терминах SolidWorks любое изображение, которое можно построить средствами 
системы, принято называть документом. С помощью SolidWorks можно создавать 
документы трех типов: деталь, сборка, чертеж. В случаях, когда идет речь о трех­
мерных изображениях деталей, употребляется еще один термин — «модель».
Деталь — это модель изделия, изготавливаемого из однородного материала без 
применения сборочных операций. Детали хранятся в файлах с расширением .sldprt.
Сборка — это модель изделия, состоящего из нескольких деталей с заданным вза­
имным положением. Сборки хранятся в файлах с расширением .sldasm.



Чертеж — это основной тип графического документа в SolidWorks. Чертеж со­
держит графическое изображение изделия, основную надпись, рамку, иногда — 
дополнительные объекты оформления (технические требования и т. д.). Чертеж 
SolidWorks может содержать несколько листов заданного пользователем формата. 
Чертежи хранятся в файлах с расширением .slddrw.

4.2. Основные элементы интерфейса
Команды вызываются с помощью систем выпадающих и контекстных меню, а так­
же кнопок инструментальных панелей.
При работе с документом любого типа на экране отображаются строка меню и не­
сколько инструментальных панелей: Стандартная, Вид, Диспетчер команд.
Система меню обеспечивает вызов команд. Некоторые из них вызываются также 
с помощью кнопок инструментальных панелей. По умолчанию строка меню рас­
полагается в верхней части окна (рис. 4.1).

^  Файл Правка Вид Вставка Инструменты Utilities Окно ?

Рис. 4.1. Строка меню

При выборе пункта меню он раскрывается, предоставляя доступ к командам этого 
пункта. Доступ к некоторым из команд возможен только через подменю. Для вы­
зова команды (выполнения соответствующего действия) щелкните мышью на ее 
названии.
Стандартная панель содержит кнопки вызова команд стандартных операций для 
работы с файлами и объектами (рис. 4.2).

D 0 H Р ®  Ъ  1 Ч 8 і И Ь - Я і в - И - В Ф

Рис. 4.2. Стандартная инструментальная панель

Для вывода ее на экран служит команда Вид ► Панели инструментов ► Стандартная.
Панель Вид содержит кнопки вызова команд настройки вида активного документа. 
Набор элементов управления панели Вид зависит от того, какой документ активен 
(рис. 4.3)

Рис. 4.3. Панель Вид при работе с деталями

Для вывода ее на экран служит команда Вид ► Панели инструментов ► Вид.
Диспетчер команд содержит кнопки переключения между режимами работы Эле­
менты и Эскиз (две первые кнопки слева). Состав остальных элементов управления



инструментальной панели диспетчера команд зависит от выбранного режима 
работы (рис. 4.4 и 4.5).

Рис. 4.4. Диспетчер команд в режиме Элементы
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Рис. 4.5. Диспетчер команд в режиме Эскиз

Для вывода этой инструментальной панели на экран служит команда Вид ► Панели 
инструментов ► Диспетчер команд.
Пользователь может изменять состав меню и инструментальных панелей, а также 
создавать собственные панели. Для вызова диалогового окна, позволяющего про­
извести эту настройку, служит команда Инструменты ► Настройка.
Панель свойств служит для изменения параметров и свойств объектов при их соз­
дании и редактировании (рис. 4.6).
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Рис. 4.6. Панель свойств отрезка прямой

4.3. Использование контекстных меню
Команды для выполнения многих часто используемых действий можно вызвать из 
контекстного меню. Это меню появляется на экране при щелчке правой кнопкой



мыши. Состав меню разный для различных ситуаций. В нем собраны наиболее 
типичные для текущего момента работы команды.
Например, в режиме редактирования эскиза при щелчке правой кнопкой мыши на 
экране появится меню, показанное на рис. 4.7.

' Выбрать

|| ̂  j Автоматическое указание размеров 
I Дополнительные размеры ►
j \  Линия
I О  Прямоугольник 
! 0  Окружность

Дуга с указанием центра 
"+) Касательная дуга 
Л  Дуга через три точки 
] Осевая линия 

Отсечь объекты

Перерисовать
j Уда/мть выбранные элементы
і--------;---------------------j Настройка меню

Рис. 4.7. Контекстное меню в режиме редактирования эскиза

Таким образом, при выполнении различных действий можно быстро обратиться 
к нужной команде не только через строку меню или инструментальные панели, но 
и через контекстные меню.

4.4. Изменение масштаба, сдвиг 
изображения и поворот модели

Для изменения масштаба изображения модели предназначены команды Изменить 
в размер экрана, Увеличить элемент вида, Увеличить/Уменьшить вид, Увеличить выбранный 
элемент, Вращать вид, Переместить.
Эти команды расположены в подменю Изменить меню Вид, а кнопки для их быстрого 
вызова — на панели Вид.
Для настройки углового шага поворота модели с помощью клавиш со стрелка­
ми, скорости мыши и анимации служит диалоговое окно, вызываемое командой 
Инструменты ► Параметры (рис. 4.8).
Для изменения масштаба отображения объекта удобно вращать колесико мыши. 
Чтобы передвинуть изображение модели в окне, щелкните на кнопке Переместить 
на панели Вид или вызовите соответствующую команду из меню Вид.

ПРИМЕЧАНИЕ Для изменения размера объекта по размеру экрана нажмите клавишу F.

Для быстрого сдвига изображения (без вызова специальной команды) 
можно воспользоваться клавиатурными комбинациями СМ+<стрелки> или 
Ctrl-кнажатое колесико мыши>.



Настройки пользователя | Свойства документа [

Общие 
Чертежи

Тип отображения пс 
1 Штриховка/Заполни 

Цвета 
Эскиз

Взаимосвязи/привяз 
Отображение/выбор кр 
Качество изображения 
Сборки
Внешние ссылки 
Шаблоны по умолчанигс 
Месторасположение фа 
FeatureManager 
Инкременты счетчика 
Вращение вида/Увелич»

Стрелочные клавиши : | 15-ООгра. [ Ц  

Медленно

Скорость мыши : <--------------------------------

Выключить Быстро 

Скорость анимации: <------^ -----------------------

0  Изменении масштаба с помощью колеса мыши

Быстро

-О

Рис. 4.8. Настройки пользователя, касающиеся вращения вида и увеличения

При создании модели может потребоваться увидеть ее с разных сторон. Для этого 
в SolidWorks предусмотрена возможность вращения модели.
Чтобы повернуть модель, вызовите команду Вид ► Изменить/Вращать, щелкните на 
кнопке Вращать вид Q  на панели Вид или переместите мышь при нажатом коле­
сике мыши.
Также можно воспользоваться клавишами со стрелками.

4.5. Управление ориентацией детали
Для изменения ориентации модели в SolidWorks можно воспользоваться командой 
Вид ► Изменить ► Ориентация вида.
Часто требуется ориентация, при которой одна из плоскостей проекций парал­
лельна плоскости экрана (в этом случае изображение модели соответствует ее 
изображению на чертеже в стандартной проекции, например, на виде сверху или 
слева). Такую ориентацию трудно получить, поворачивая модель мышью. В этом 
случае для изменения ориентации можно пользоваться предусмотренным системой 
списком готовых вариантов ориентации.
На панели Вид расположена кнопка Стандартные виды (¾ При щелчке на стрелке
рядом с этой кнопкой раскрывается меню с перечнем стандартных вариантов ори­
ентации, каждый из которых соответствует направлению взгляда наблюдателя на 
модель (рис. 4.9).
Иногда требуется, чтобы параллельной плоскости экрана оказалась не проекци­
онная плоскость, а вспомогательная плоскость или плоская грань модели. Чтобы 
установить такую ориентацию, выделите нужный плоский объект и вызовите из 
меню кнопки Ориентация команду Перпендикулярно. Модель повернется так, чтобы 
направление взгляда было перпендикулярно выбранному объекту.



^  Перпендикулярно

Спереди 
( Э  Сзади 

Слева 
Справа 

т  Сверху

(Э СнизУ
Ф  Изометрия 
(3  Триметрия 
9  Диметрия

^  Ориентация

Рис. 4.9. Список стандартных вариантов ориентации

ПРИМЕЧАНИЕ Удобно пользоваться клавиатурными комбинациями, например, для установки 
изометрического изображения —  комбинацией клавиш Ctrl+7, для установки 
режима перпендикулярно —  комбинацией клавиш Ctrl+8.

Можно не только использовать стандартные варианты ориентации, но и запоми­
нать текущую ориентацию под каким-либо именем, а затем возвращаться к ней 
в любой момент, выбрав это имя в списке. Для этого щелкните на кнопке Ориента­
ция. На экране появится диалоговая панель со списком существующих в модели 
вариантов ориентации. Щелкните на кнопке Новый вид и введите название нового 
варианта ориентации. Затем щелкните на кнопке О К, и новое название появится 
в меню кнопки Ориентация на панели Вид.
Впоследствии, когда ориентация модели изменится, можно выбрать в меню кноп­
ки Ориентация созданный вариант ориентации, и модель повернется так, чтобы ее 
ориентация ему соответствовала.

4.6. Управление режимом отображения 
детали

При работе в SolidWorks доступно несколько вариантов отображения модели: кар­
касное представление, представление с выводом и без вывода невидимых линий, 
полутоновое представление, закрашенное представление и перспектива.
Чтобы выбрать вариант отображения, раскройте подменю Вид ► Отобразить и вы­
зовите нужную команду. Можно также воспользоваться кнопками панели Вид.
О Каркасное представление — отображаются все кромки модели.

Чтобы отобразить модель в виде каркаса, вызывается команда Вид ► Отобра­
зить ► Каркасное представление или нажимается кнопка Каркасное представление
(g j на панели Вид.



О Представление с отображением невидимых линий (невидимые ребра и части ре­
бер) — все кромки модели, которые невозможно увидеть под выбранным углом, 
отображаются серым цветом и штриховыми линиями.
Чтобы отобразить модель с невидимыми линиями другого цвета, вызовите 
команду Вид ► Отобразить ► Невидимые линии отображаются или щелкните на
кнопке Невидимые линии отображаются Q J  на панели Вид.

О Представление без невидимых линий — все кромки модели, которые невозможно 
увидеть под выбранным углом, не отображаются.
Чтобы отобразить модель без невидимых линий, вызовите команду Вид ► 
Отобразить ► Скрыть невидимые линии или щелкните на кнопке Скрыть невидимые
линии на панели Вид.

О Полутоновое представление — отображение закрашенного вида модели с види­
мыми кромками.
Чтобы получить полутоновое представление модели, вызовите команду 
Вид ► Отобразить ► Закрасить с кромками или щелкните на кнопке Закрасить
с кромками на панели Вид. В полутоновом представлении модели учи­
тываются оптические свойства ее поверхности (цвет, блеск, диффузия и т. д.). 

О Закрашенное представление — вывод закрашенного изображения модели. 
Чтобы получить закрашенное изображение модели, вызовите команду 
Вид ► Отобразить ► Закрасить или щелкните на кнопке Закрасить на панели 
Вид.

О Перспектива — в этом режиме можно получить еще более реалистичное изо­
бражение детали в соответствии с особенностями зрительного восприятия 
человека. Точка схода перспективы расположена посередине окна детали. Все 
перечисленные режимы отображения (каркасное, полутоновое, без невидимых 
линий и с тонкими невидимыми линиями) можно сочетать с перспективной 
проекцией.
Для получения вида модели с учетом перспективы вызовите команду Вид ► 
Отобразить ► Перспектива или щелкните на кнопке Перспектива на панели 
Вид.

Какой бы тип отображения ни был выбран, он не оказывает влияния на свойства 
модели. Например, при выборе каркасного отображения модели она остается 
сплошной и твердотельной (а не превращается в набор «проволочных» ребер), 
просто ее поверхность и материал не воспроизводятся на экране.



4.7. Дерево конструирования модели
При работе с любой деталью в SolidWorks на экране кроме окна, в котором отобра­
жается модель, выводится окно, содержащее дерево конструирования.
Дерево конструирования — это окно, в котором в виде структурированного списка 
(«дерева») отражается последовательность построения трехмерной модели с пере­
числением объектов, составляющих деталь. Они отображаются в дереве в порядке 
создания.
В дереве конструирования детали отображаются: символ начала координат, пло­
скости, оси, эскизы, операции и указатель окончания построения модели.
Эскиз, задействованный в любой операции, размещается на ветви дерева конструи­
рования, соответствующей этой операции. Слева от названия операции в дереве 
выводится значок +. После щелчка мышью на этом значке в дереве разворачивается 
список участвующих в операции эскизов. Эскизы, не задействованные в операциях, 
отображаются на верхнем уровне дерева конструирования.
Каждый элемент автоматически включается в дерево конструирования сразу после 
его создания. Название присваивается элементам также автоматически в зависи­
мости от способа создания. Например, «Вытянуть», «Вырез-Вытянуть», «Вырез- 
Повернуть», «Скругление» и т. д.
В детали может существовать множество однотипных элементов. Чтобы различать 
их, к названию элемента автоматически прибавляется порядковый номер элемента 
данного типа. Например, «Скругление 1» и «Скругление2».
Любой элемент в дереве конструирования можно переименовать. Для этого необ­
ходимо дважды (с паузой) щелкнуть мышью на его названии или выбрать в кон­
текстном меню, появляющемся при щелчке правой кнопкой мыши на названии 
элемента, команду Свойства. Новое название элемента будет сохранено в дереве 
конструирования.
Слева от названия каждого объекта в дереве отображается пиктограмма, соот­
ветствующая способу, которым этот элемент получен. Пиктограмму, в отличие от 
названия объекта, изменить невозможно. Благодаря этому при любом переиме­
новании элементов в дереве конструирования остается наглядная информация 
о способе и порядке их создания.
Дерево конструирования и графическая область динамически связаны. Благодаря 
этому, щелкая на названиях в дереве, можно выбирать элементы, эскизы, чертежные 
виды и вспомогательную геометрию в любой из областей окна.
Обычно пиктограммы отображаются в дереве конструирования каждая своим 
цветом. Если объект выделен, то по умолчанию его пиктограмма в дереве синяя.
Дерево конструирования можно скрыть. Для этого в меню Вид сбросьте флажок 
у команды Область дерева или нажмите клавишу F9. Чтобы опять вывести дерево 
на экран, снова установите флажок или нажмите клавишу F9.



Дерево конструирования отображается в отдельном окне, которое всегда находит­
ся внутри окна редактируемого документа. Можно изменять размер окна дерева, 
перетаскивая мышью его границы.

Кроме дерева конструирования ISl , на других вкладках этого окна располагаются 
менеджер свойств Ц|Р и менеджер конфигураций Ж ]  (рис. 4.10).

^твж
Деталь 1 

ffl-ttl Примечания 
© ф  Связь проектов 
.... Материал <не указан >

® Й  Источники света и камеры 
© (Й  Твердые тела(1)

...<$> Спереди 

. Сверху 

...<$> Сбоку

....£* Начало координат 
д..|Щ Вытянуть 1

(-) Эскиз 1 
I Вырез-Вытянутьі

Рис. 4.10. Окно дерева конструирования

В окне менеджера свойств выводятся свойства объекта или элемента, а менеджер 
конфигураций служит для создания, выбора и просмотра многочисленных конфи­
гураций деталей и сборок.
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Современные ЗБ-системы проектирования позволяют создавать трехмерные моде­
ли самых сложных деталей и сборок. Используя наглядные методы формирования 
объемных элементов, конструктор оперирует простыми и естественными понятия­
ми: основание, отверстие, фаска, оболочка и т. д. При этом процесс конструирова­
ния может воспроизводить технологический процесс изготовления детали. После 
создания трехмерной модели изделия конструктор может получить его чертеж без 
рутинного создания видов средствами плоского черчения.

5.1. Общие принципы твердотельного 
моделирования деталей

В общем случае порядок создания модели корпусной детали включает в себя фор­
мирование основания, приклеивание и вырезание дополнительных элементов, по­
строение массивов элементов, зеркальное копирование, создание дополнительных 
конструктивных элементов (рис. 5.1).
Формирование отдельных трехмерных объектов начинается с создания эски­
за — плоской фигуры, на основе которой образуется объемное тело. Эскиз может 
располагаться в одной из плоскостей координат, на плоской грани существую­
щего тела или на вспомогательной плоскости, положение которой задано поль­
зователем. Эскиз строится на плоскости стандартными средствами двухмерного 
редактора.
При построении эскиза в системе SolidWorks доступны все команды создания и ре­
дактирования изображения, а также сервисные возможности. В эскиз можно пере­
нести изображение из ранее подготовленного чертежа. Это позволяет при создании 
трехмерной модели опираться на существующую чертежно-конструкторскую 
документацию.
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Рис. 5.1. Этапы создания твердотельной модели детали: а —  формирование основания; 
б —  приклеивание дополнительного элемента; в — построение массива элементов; 

г —  создание дополнительных конструктивных элементов

5.2. Основные операции 
3 D-моделирован ия

В системе SolidWorks определены базовые операции создания твердых тел, для 
выполнения которых используются следующие команды:

Вытянутая бобышка/основание — вытяжка эскиза в одном или двух направле­
ниях для создания твердотельного элемента;

Повернутая бобышка/основание — вращение эскиза в одном или двух направ­
лениях для создания твердотельного элемента;

По траектории — вытяжка замкнутого эскиза по траектории для создания 
твердотельного элемента;
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По сечениям — создание элемента путем построения переходов между про­
филями;

Вытянутый вырез — вырезание путем вытягивания эскиза в одном или двух 
направлениях;

Отверстие под крепеж — вставка отверстия определенного пользователем по­
перечного сечения;

Повернутый вырез — вырезание путем вращения эскиза в одном или двух на­
правлениях;



Вырез по траектории — вырезание путем вытягивания замкнутого эскиза по 
траектории;

Вырез по сечениям — вырезание путем удаления материала между профилями.

Объемные элементы образуются в результате операций — формообразующих пере­
мещений эскизов. Основные способы создания трехмерных объектов иллюстрирует 
рис. 5.2.

Рис. 5.2. Основные формообразующие операции создания трехмерных объектов: 
о —  выдавливание; б — вращение; в — кинематическая операция; г —  операция по сечениям

Построение трехмерной модели детали начинается с анализа ее конструкции. 
Необходимо внимательно осмотреть деталь, уяснить ее назначение и технологию 
изготовления, определить название.
При изучении конструкции тщательно анализируется форма детали путем мыс­
ленного расчленения ее на простейшие геометрические тела (параллелепипеды, 
призмы, цилиндры, конусы, торы, кинематические элементы и т. д.) или их части, 
отдельно представляются наружные и внутренние поверхности. Следует иметь 
в виду, что любая деталь представляет собой различные сочетания простейших 
геометрических форм. При этом мелкие конструктивные элементы (фаски, скру- 
гления, проточки и т. п.) из рассмотрения на первом этапе исключаются.
После этого приступают к созданию модели основного формообразующего эле­
мента детали. При построении можно использовать любую из перечисленных 
формообразующих операций.



5.3. Система координат и плоскости 
проекций

В каждом файле детали существуют система координат и проекционные плоскости, 
определяемые этой системой. Название этих объектов появляется в окне дерева 
конструирования после создания нового файла детали. Окно дерева конструиро­
вания является графическим интерфейсом, служащим для управления процессом 
создания и редактирования модели изделия. Изображение системы координат 
появляется посередине окна построения модели; чтобы увидеть изображение про­
екционных плоскостей, их нужно выделить в дереве конструирования.
Плоскости представляются на экране в виде прямоугольников, лежащих в этих 
плоскостях; такое представление позволяет увидеть расположение плоскости 
в пространстве. Иногда для понимания расположения плоскости требуется, 
чтобы символизирующий ее прямоугольник был больше (меньше), или рас­
полагался в другом месте. Размер и положение этого прямоугольника можно 
регулировать мышью. Плоскости проекций и систему координат невозможно 
удалить из файла модели. Их можно переименовать, а также запретить их показ 
в окне модели.
В системе SolidWorks при выборе в качестве ориентации вариант Изометрия коор­
динатные оси и плоскости проекций располагаются так, как показано на рис. 5.3, а. 
Эта ориентация не совпадает с требованиями ГОСТ 2.319-69 (рис. 5.3, б).

а б

Рис. 5.3. Ориентация координатных осей и плоскостей проекций в системе SolidWorks
и согласно ГОСТ 2.317-69

Положение модели в системе SolidWorks иллюстрирует рис. 5.4.



Рис. 5.4. Ориентация ассоциативных видов в системе SolidWorks

5.4. Особенности трехмерного 
моделирования деталей

При построении эскизов для создания ЗБ-моделей деталей целесообразно про­
ставлять параметрические размеры, с помощью которых легко изменять геометрию 
контуров и редактировать твердотельные модели. На рис 5.5 представлен параме­
тризованный эскиз контура для создания модели изолятора.

Редактировать эскизы можно с помощью типового набора команд редактирования: 
Переместить объекты, Повернуть объекты, Копировать объекты, Зеркально отразить объ­
екты и Масштабировать объекты, кроме того, можно использовать маркеры манипули­
рования объектом. Маркеры появляются в начальной и конечной точках объекта, 
например, отрезка, при его выделении (рис. 5.6). При наведении курсора на маркер 
и нажатии левой кнопки мыши можно изменить длину, угол, иными словами, пере­
местить граничную точку отрезка.

і

Рис. 5.5. Параметризованный эскиз контура для создания модели изолятора

Рис. 5.6. Маркеры манипулирования объектом



Важным этапом создания моделей деталей, соединяемых стандартными крепеж­
ными изделиями, является выбор параметров отверстий для этих изделий. Для 
создания круглого отверстия со сложным профилем необходимо использовать
команду Отверстие под крепеж |j^  Перед вызовом этой команды требуется вы­
делить плоскую грань, от которой начинается отверстие. Далее необходимо на 
панели свойств (Спецификация отверстий) выбрать профиль отверстия и задать 
необходимые параметры (рис. 5.7).

с: Спецификация отверстий

[ 3  Тип *3* Расположения

ill :Ж и

1 Й*
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|гост 14
Тип:

1С потайной гол.кл.т.А и В ГОСт| v  J
Размер:

1 Мб ГІ
Рис. 5.7. Панель свойств отверстия

Положение отверстия задается на вкладке Расположения панели свойств простав­
лением координатных размеров.

5.5. Выбор ориентации модели детали
При выполнении чертежа детали необходимо правильно выбрать главное изобра­
жение. Согласно ГОСТ 2.305-68, в качестве главного принимается изображение на 
фронтальной плоскости проекций. Предмет располагают относительно фронталь­
ной плоскости проекций так, чтобы изображение на ней давало наиболее полное 
представление о форме, размерах и функциональном назначении предмета.
При создании трехмерной модели необходимо осознанно выбирать плоскость по­
строения эскиза. Для создания вида спереди нужно выбирать плоскость построения 
эскиза, заданную осями ОХ и OY.
Если в дальнейшем потребуется создать чертеж по модели, полезно уже при по­
строении основы детали просмотреть изображение модели, выбрав вид спереди, 
и оценить, насколько он соответствует главному изображению детали.



5.6. Создание ассоциативных видов
Трехмерные модели деталей создаются не столько для наглядной визуализации, 
сколько с целью получения конструкторской документации, в том числе чертежей 
деталей.
В системе SolidWorks имеется возможность создания ассоциативных чертежей 
трехмерных деталей. В таких чертежах все виды связаны с моделью так, что из­
менения в модели приводят к изменению изображения в каждом ассоциативном 
виде и наоборот.
Ассоциативное изображение формируется в обычном чертеже. В нем создаются 
выбранные пользователем ассоциативные виды и разрезы (сечения) трехмерной 
детали. Виды автоматически располагаются в проекционной связи. При необходи­
мости связь можно отключить — это дает возможность произвольного размещения 
видов в чертеже.
В системе SolidWorks определены базовые операции создания ассоциативных изо­
бражений, выполняемые с помощью следующих команд:
□а Три стандартных вида — создаются три связанных стандартных вида детали 
ЕЙ или сборки, которые отображаются одновременно;

пхч Вид модели — появляется окно менеджера свойств, позволяющее добавить 
один или несколько (определенных пользователем) ортогональных видов 
детали или сборки;

сп Проекционный вид — позволяет создать один или несколько проекционных 
СЗ видов относительно вида, определенного пользователем;

Вспомогательный вид — получение проекций модели на вспомогательные пло- 
скости (не параллельные координатным плоскостям);

+ш Разрез — построение простого или ступенчатого разреза;

Выровненный разрез — построение ломаного разреза;

Местный вид — представление части вида обычно в увеличенном масштабе; 

Вырыв детали — построение местного разреза;

Линия обрыва — вставка в чертеж линии обрыва, при этом участок изображе­
ния между двумя линиями удаляется, а крайние части изображения сближа­
ются до расстояния, указанного в менеджере свойств;

Обрезанный вид — обрезание существующего вида для отображения только 
его части.
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В этой главе описаны этапы создания в системе SolidWorks ЗЭ-моделей восьми 
деталей, упомянутых во введении к этой книге, и ассоциативных чертежей для 
двух моделей.

6.1. Изолятор
Создайте трехмерную модель изолятора, показанную на рис. 6.1.

Рис. 6.1. Модель изолятора

1. Создайте новый документ, выбрав в каче­
стве типа документа вариант Деталь.



2. В дереве конструирования выберите пло­
скость Сверху и в появившейся панели вы­
берите команду Эскиз либо щелкните на 
одноименной кнопке на ленте, перейдя на 
вкладку Эскиз.

1¾  Деталь2 

а О П  Принеча м я

1.4.
,

| Справа 1 

1 Исходная точка

Е! О
Эскиз Автоматическое 

^  нанесете ра...

Эскиз [ j

3. Создайте эскиз согласно рисунку. По­
стройте осевые линии, проходящие через 
начало координат. Затем выберите команду
Окружность Ѳ и постройте окружности
произвольного радиуса, расположенные 
на вертикальной осевой линии. Нанесите 
размеры, используя команду Автоматическое
нанесение размеров ^  Вторую окруж­
ность диаметром 20 мм постройте как зер­
кальную копию первой относительно гори­
зонтали, щелкнув на кнопке .

4. Выйдите из режима построения эскиза, 
щелкнув на кнопке Выход из эскиза. X

5. Для создания модели на основе построен­
ного эскиза на вкладке Элементы выберите 
команду Вытянутая бобышка/основание. I Элем виты j Эею

6. На панели свойств команды задайте вели­
чину выдавливания 30 мм. Результат пред­
ставлен на рисунке.

I Плоскость для эскиза v j

^  j На эадажюс расстоян-

I 30.00»«



В дереве конструирования выберите пло­
скость Справа. Установите вид справа с по­
мощью команды Стандартные виды ► Вид
справа и перейдите на вкладку Эскиз,
чтобы вернуться к построению эскиза.

£права

8. Создайте эскиз согласно приведенному 
рисунку, используя команду Угловой прямо­
угольник Q  . Проставьте размеры и выйди­
те из режима создания эскиза.

40
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1 т-------
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9. Выберите команду Вытянутый вырез (fa)
и с помощью панели свойств установите па­
раметры согласно приведенному рисунку.

х

I Плоскость А

г
- 1  Переставить сторону 
-^длявьреэв

©С

В итоге мы должны получить требуемую модель (см. рис. 6.1).

6.2. Вкладыш
В этом разделе мы создадим трехмерную модель вкладыша, показанную на рис. 6.2.

Рис. 6.2. Модель вкладыша



1. Создайте новый документ, выбрав в каче­
стве типа документа вариант Деталь. В де­
реве конструирования выберите плоскость 
Сверху для построения эскиза и щелкните
на кнопке Эскиз 0 ^  в появившейся пане­
ли. Установите вид сверху, выбрав команду: 
Стандартные виды ► Сверху или щелкнув на
кнопке Сверху а  в пиктографическом 
меню кнопки Ориентация видов.

т я т а о
g}, Деталь 1 

$  СЙ Прии*

§5 Материал <не указан» 

<$> Спереди

<$* Справа 

£> Исходная точка

2. Постройте две окружности с координатами 
положения центра 0, 0 и произвольными 
радиусами, щелкнув на кнопке Окружность
Ѳ Проставьте размеры, щелкнув на 

кнопке Автоматическое нанесение размеров
ф  Для этого задайте местоположения

размерной линии и надписи, после чего 
в появившемся диалоговом окне укажите 
нужную величину диаметра первой (80 мм) 
и второй (30 мм) окружностей. Затем вый­
дите из режима создания эскиза, повторно 
щелкнув на кнопке Эскиз.

3. Выделите в дереве конструирования по­
строенный эскиз, перейдите на кладку Эле­
менты и выберите команду Вытянутая бо­
бышка/основание (Щ  На панели свойств 
задайте величину выдавливания 10 мм.

©

4. Выберите плоскость верхнего основания 
в качестве плоскости построения следую­
щего эскиза и щелкните на кнопке Эскиз.

5. Установите вид сверху, выбрав команду 
Стандартные виды ► Сверху или щелкнув на
кнопке Сверху в пиктографическом
меню кнопки Ориентация видов. Создайте 
изображение квадрата с размерами соглас­
но рисунку.



6. Второй квадрат постройте, используя ко­
манду Зеркально отразить объекты . Для
этого укажите объекты (четыре отрезка — 
стороны квадрата) и вертикальную ось, от­
носительно которой должно происходить 
отражение (на рисунке — Линия 5). Выйди­
те из режима построения эскиза.

Зеркальное смрнж..

К -tt

Выберите объекты для 
зеркального отражения; линию 
эскиза или кройку львиной 
модели относительно которых 
необходюю выполнить 
зеркальное отражение

Объекты для зеркального 
отображежя:

& /Ѵінияі
Ли**ія2
ЛинияЗ
Линия4

0  Копировать 

Зеркально относительно:

7. Выполните для этого эскиза операцию Вы­
тянутый вырез, выдавите его на 5 мм.

Выберите плоскость верхнего основания 
в качестве плоскости построения следую­
щего эскиза и щелкните на кнопке Эскиз. 
Постройте три окружности согласно рисун­
ку. Выберите команду Преобразование объ­
ектов в и спроецируйте большую окруж­
ность основания детали в текущий эскиз, 
щелкнув на ней левой кнопкой мыши.

9. Выберите команду Отсечь и в окне
свойств выберите вариант Отсечь до бли­
жайшего. Результат должен соответствовать 
рисунку.

Выберите объект для 
отсечения до ближайшего 
объекта пересечения или для 
перетаскивания в объект

f f i ]  Автообрезка 

(нг) Угол

] Отсечь внутри 

I & ]  Отсечь снаружи

1 0тсечь до J ближайшего



10. Выполните для этого эскиза операцию вы­
давливания на 20 мм.

11. В дереве конструирования выберите пло­
скость для построения эскиза, щелкнув 
на пункте Справа. Установите вид справа, 
выбрав команду Стандартные виды ► Справа. 
Выберите команду построения эскиза и по­
стройте прямоугольник с размерами, ука­
занными на рисунке.

зо

г-П1

♦
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12. Вырежьте прямоугольник в оба направ­
ления насквозь, щелкнув на кнопке Вытя­
нутый вырез (j|j| Результат представлен
на рисунке. В итоге мы должны получить 
требуемую модель (см. рис. 6.2).

I Плоскость для эскиза ѵ |

г -1 Переставить сторону 
•'-'для вьфеза

©

13. Для выреза четверти на виде сверху создай­
те эскиз в форме двух отрезков, располо­
женных под прямым углом.

14. Выполните команду Вытянутый вырез. Вы­
берите направление выреза: одна стрелка 
указывает на направление выреза (вниз от 
плоскости эскиза), вторая — на удаляемую 
часть.



В результате мы должны получить требуемое изображение с вырезом одной чет­
верти, как показано на рис. 6.3.

Рис. 6.3. Модель детали с вырезом одной четверти

6.3. Радиатор игольчатый
В этом разделе мы создадим трехмерную модель игольчатого радиатора, показан­
ную на рис. 6.4.

Рис. 6.4. Модель радиатора

1. Создайте новый документ, выбрав в каче­
стве типа документа вариант Деталь. В де­
реве конструирования выберите плоскость 
Сверху для построения эскиза и щелкните
на кнопке Эскиз Е! в появившейся пане­
ли. Установите вид сверху, выбрав команду 
Стандартные виды ► Сверху или щелкнув на
кнопке Сверху в пиктографическом
меню кнопки Ориентация видов. Постройте 
эскиз согласно рисунку. Строить прямоу­
гольник удобнее с помощью команды Пря­
моугольник из центра ЕЗ Для построения 

скруглений используйте команду Скругление 
• Проставьте размеры, щелкнув на кноп­

ке Автоматическое нанесение размеров О  
В завершение выйдите из режима созда­
ния эскиза, снова щелкнув на кнопке Эскиз.

25



2. Выделите в дереве конструирования по­
строенный эскиз, выберите команду Вытя­
нутая бобышка/основание и на панели
свойств задайте величину выдавливания 
3 мм.

3. Выберите верхнюю плоскость основания 
радиатора для создания эскиза, представ­
ленного на рисунке.

2,50

4. Выделите в дереве конструирования по­
строенный эскиз, выберите команду Вы­
тянутая бобышка и на панели свойств уста­
новите расстояние 15 мм и угол наклона 
1°. В результате мы получим иглу в виде
усеченного конуса.

^  к &Ў

Плоскость для эскиза ѵ і

Л Т5.ЮІГ

0  Результат с т я м я  

; 1.«Градусов 

□У клон наружу

5. Размножьте иглы, построив прямоуголь­
ный массив с помощью команды Линейный
массив §§§ . Задайте параметры построения
массива согласно рисунку. Здесь Направле­
ние 1 — это длинное ребро основания, а На­
правление 2 — короткое.
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6. Удалите пять иголок в центре радиатора 
с координатами (4, 3); (5, 3); (4, 2); (4, 4); 
(3, 3), щелкнув в разделе Пропустить экзем­
пляры панели свойств и указав данные эк­
земпляры иголок на модели.

(4 .3 )
(5 .3 )  
(4 ,2 )  
(4. 4) 0

7. Вызовите команду Фаска (Q  , отметьте
все шесть ребер отверстий (с двух сторон 
основания детали) и установите параметры 
катета (0,5 мм) и угол наклона (45°).

ж

а> Кроиса<1>
ШШ

Кроны <2> : s |
КромсвО> 1
Кроюа<4> >1

© У гол

Op*Вйяікна 
О  Переставить сторону

45 .ООгрлдусов ■

В итоге мы получили требуемую модель (см. рис. 6.4).

6.4. Уголок
В этом разделе мы создадим трехмерную модель уголка, показанную на рис. 6.5.

Рис. 6.5. Модель уголка



1. Создайте новый документ, выбрав в каче­
стве типа документа вариант Деталь. Выбе­
рите в дереве конструирования плоскость 
для построения эскиза, щелкнув на пун­
кте Справа, и в появившейся панели щел­
кните на кнопке Эскиз 0 ^  Установите
вид справа, выбрав команду Стандартные 
виды ► Справа или щелкнув на кнопке Спра­
ва в пиктографическом меню кнопки
Ориентация видов. Постройте эскиз согласно 
рисунку Проставьте размеры, щелкнув на 
кнопке Автоматическое нанесение размеров
ф  В завершение выйдите из режима

создания эскиза, снова щелкнув на кнопке 
Эскиз.

И*
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2 . Выделите в дереве конструирования по­
строенный эскиз и выберите команду Вы­
тянутая бобышка/основание (ТЦ . С помощью
панели свойств выполните выдавливание 
в обе стороны от плоскости эскиза, для 
дальнейшего удобства, задав величину вы­
давливания по 15 мм в каждую сторону.

Плоскость для эскиза ѵ ]

( ¾ ]  [Назаданноер асстоя^ѵ

' Ш  =

;На зад е т о е  peccros** v  j

^  I 15.00т

3. Для моделирования ребра жесткости вы­
берите боковую торцевую плоскость в ка­
честве плоскости построения эскиза и по­
стройте эскиз согласно рисунку.



4. Для построения ребра жесткости щелкните 
на кнопке Ребро , после чего задайте на­
правление и толщину ребра в 2 мм.

'А Г2”»"

0  Переставить сторону»

(ЁГ|:1

ЭсюсРКааурб»

5. Для зеркального отражения ребра выбери­
те команду Зеркальное отражение в  , на
панели свойств в качестве плоскости отра­
жения укажите вариант Справа и выделите 
ребро в дереве конструирования.

к

6. Для построения скруглений выберите
команду Скругление , выделите ребра
с 1-го по 6-е и задайте величину радиуса
в 3 мм. Скруглите. По завершении выдели­
те ребра с 7-го по 10-е и также скруглите.



7. В целях ознакомления, смоделируем от­
верстие в основании. Для этого вызови­
те команду Отверстие под крепеж ^  ,  на
появившейся панели свойств выберите от­
верстие с фаской и задайте параметры, как 
показано на рисунке.

g^jgBgL- __ _______ :  тмтттптті'
* Ы  L e -сгитѵ

:І£ —
; @ ® і!  I ; j
' С т и д е :
 ̂ Ami (тегр**сгле) v  

! с плоской головкой-Af61Blv

8. Перейдите на вкладку Расположения, чтобы 
задать местоположение отверстия.

\ (71 Т п і- . y j f  Расположения

9. На вкладке Расположения укажите размеры 
в соответствии с рисунком.

Результат моделирования был представлен в начале этого раздела (см. рис. 6.5).

6.5. Втулка
В этом разделе мы создадим трехмерную модель втулки, показанную на рис. 6.6.

Рис. б.б. Модель втулки

1. Создайте новый документ, выбрав в каче­
стве типа документа вариант Деталь. Выбе­
рите в дереве конструирования плоскость 
для построения эскиза, щелкнув на пун­
кте Справа, и в появившейся панели щел­
кните на кнопке Эскиз Установите
вид справа, выбрав команду Стандартные 
виды ► Справа или щелкнув на кнопке Спра-
ва Ш  в пиктографическом меню кнопки
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Ориентация видов. Постройтеэскизсогласно 
рисунку. Проставьте размеры, щелкнув на 
кнопке Автоматическое нанесение размеров
ф  В завершение выйдите из режима

создания эскиза, снова щелкнув на кнопке 
Эскиз.

2. Выделите в дереве конструирования по­
строенный эскиз, выберите команду Повер­
нутая бобышка 6¾ и установите параметры
вращения, как показано на рисунке. В каче­
стве осевой линии выберите горизонталь­
ный отрезок, от которого измеряются все 
радиусы.

и ш в г о я и и н
х

3. Создайте две фаски на большем цилиндре 
с размерами 1x45°, используя команду Фа-
ска

Выберите торцевую плоскость большего 
цилиндра в качестве плоскости построения 
эскиза и создайте эскиз согласно рисунку. 
Постройте вертикальную ось. Выберите
команду Многоугольник ®  и постройте
многоугольник с количеством вершин 3 
и диаметром вписанной окружности 0,95. 
Выделите большую окружность модели, 
выберите команду Преобразовать объект
в  , задайте тип линии, выбрав вариант 
Вспомогательная геометрия, и создайте при­
митив Точка & на пересечении построен­
ной окружности и вертикальной оси. Про­
ставьте вертикальный размер и выйдите из 
режима создания эскиза, повторно щелкнув 
на кнопке Эскиз.



5. Выполните вырезание выдавливанием, ис­
пользуя команду Вытянутый вырез (fi|)

6. В разделе Справочная геометрия выберите 
команду Ось \  и постройте ось, указав 
цилиндрическую поверхность.

$
\

Плоскость
Ось

|Гра«»<1> ~і

I I одна линия/кромка/ось

\Ф\ Две плоскости 

|’\ J  Две точки/вершины

Цилждрическая/кожческ<

7. Постройте круговой массив. Для этого вы­

берите команду Круговой массив , в раз­
деле Настройка укажите построенную ось, а 
в разделе Копировать элементы — вырезанное 
углубление.

[ О ]  (Ось!

В  ЗбО.ООградусое

Ф  %
0 Р ав № * і шаг

- ¾  05 - вту/ка 
^Й А ) Принечатя

Материал <не указан> 
Спереди 
Сверху 
Справа 

f~ Исходная точка 
Повернутьі

I- Ф̂аскаІК, \(О сь1
Вытянуть 1

Результат моделирования был представлен в начале этого раздела (см. рис. 6.6).

6.6. Кронштейн
В этом разделе мы создадим трехмерную модель кронштейна, показанную на 
рис. 6.7.



Рис. 6.7. Модель кронштейна

1. Создайте новый документ, выбрав в ка­
честве типа документа вариант Деталь. 
Выберите в дереве конструирования пло­
скость для построения эскиза, щелкнув на 
пункте Спереди, и в появившейся панели
щелкните на кнопке Эскиз Установи­
те вид спереди, выбрав команду Стандарт­
ные виды ► Спереди или щелкнув на кнопке
Спереди а  в пиктографическом меню 
кнопки Ориентация видов. Постройте эскиз 
согласно рисунку. Проставьте размеры, 
щелкнув на кнопке Автоматическое нанесе­
ние размеров ф  В завершение выйдите
из режима создания эскиза, снова щелкнув 
на кнопке Эскиз.

2. Выделите в дереве конструирования по 
строенный эскиз, выберите команду Вытя
нутая бобышка (Щ и выполните выдавли
вание на величину 50 мм.

3. Укажите плоскость модели, как показано на 
рисунке, и выберите команду построения 
эскиза.



4. Создайте эскиз в виде двух равных по диа­
метру окружностей.

5. Выделите обе окружности и командой До­
бавить взаимосвязь назначьте им вза­
имосвязи в соответствии с параметрами, 
представленными на рисунке.

ra g  вы я

"I Im I

L !Касате/ьностъ17 
J  Paetferi радиус/д»*«а18

О  Определен

1 Даб—
\0\Корадиашмі 
|< |̂касате/ъныи 

I @  I Комцентри>**>*5

I = I Равенство 

Іёі*

6. Выделите вертикальные грани и малые 
дуги модели и вызовите команду Инстру­
менты ► Инструменты эскиза ► Преобразование 
объектов для проецирования данных объ­
ектов в текущий эскиз. Командой Отсечь

обрежьте ненужные фрагменты при­
митивов, как показано на рисунке.

7. Выделите две большие дуги и с помощью 
маркеров, появившихся на концах дуг 
(предварительно удалив взаимосвязи Со­
впадение и Проецирование), переместите 
конечную точку дуги большей окружности 
вправо, как показано на рисунке. Тем са­
мым исключается возможность самопере­
сечения контура.



8. Выберите команду Вытянутая бобышка [ Щ

и выполните выдавливание построенного 
эскиза на 8  мм. і

9. Установите вид справа и постройте прямо­
угольник с размерами 1 1 0 x 2 0 . ью

10. Вырежьте построенный эскиз из модели 
детали, используя команду Вытянутый вы-
р е з  Q D 1

11. В качестве плоскости построения эскиза 
выберите верхнюю плоскость основания и 
вызовите команду Вставка ► Элементы ► От­
верстие ► Под крепеж или щелкните на
кнопке Отверстие под крепеж (j^ 1

12. Выберите отверстие с зенковкой и уста­
новите параметры отверстия М8 согласно 
рисунку.

Размер:
|мв ѵ) 
Разместить:
(Нормальная ѵ|

Отобразить ‘-‘настраіеаежііе размеры
^  [Ѵ.ОООниГ

^  І 17.300« — 
^  j 90градусов



13. На вкладке Расположение задайте положе­
ние центра отверстия, указав размеры в со­
ответствии с рисунком.

15

14. Чтобы создать скругления, щелкните на 
кнопке Скругление 0 и, выделив указан­
ные на рисунке элементы, задайте радиус 
Змм.

15. Для зеркального отражения щелкните на 
кнопке Зеркально отразить объекты Щ  и 
выделите все элементы.

ж

ВытжутъЭ
Вьшиутъ2
ВЪГГЖѴТЬІ

16. В качестве плоскости отражения укажите 
грань модели.

17. Еще раз зеркально отразите модель в со­
ответствии с параметрами, указанными на 
рисунке.

ж

Результат моделирования был представлен в начале этого раздела (см. рис. 6.7).



6.7. Корпус
В этом разделе мы создадим трехмерную модель корпуса, показанную на рис. 6.8.

Рис. 6.8. Модель корпуса

1. Создайте новый документ, выбрав в ка­
честве типа документа вариант Деталь. 
Выберите в дереве конструирования пло­
скость для построения эскиза, щелкнув на 
пункте Спереди, и в появившейся панели
щелкните на кнопке Эскиз Установи­
те вид спереди, выбрав команду Стандарт­
ные виды ► Спереди или щелкнув на кнопке
Спереди в пиктографическом меню
кнопки Ориентация видов. Постройте эскиз 
согласно рисунку. Проставьте размеры, 
щелкнув на кнопке Автоматическое нанесе­
ние размеров ф  В завершение выйдите
из режима создания эскиза, снова щелкнув 
на кнопке Эскиз.

2. Выделите в дереве конструирования по 
строенный эскиз, выберите команду По
вернутая бобышка 6ft и создайте тело вра 
щения.



3. Укажите нижнюю плоскость модели и вы­
берите команду построения эскиза. Устано­
вите вид сверху и создайте эскиз согласно 
рисунку. Спроецируйте большую окруж­
ность в текущий эскиз с помощью команды
Преобразование объектов в  . Скругления у
основания лапки строятся с использовани­
ем связи Касание. После чего удалить дугу 
большей окружности. Выйдите из режима 
создания эскиза.

4. Выберите команду Вытянутая бобышка/осно­
вание (Щ  и выполните выдавливание на 
величину 10 мм.

5. На верхней плоскости лапки, созданной на 
предыдущем шаге, постройте эскиз окруж­
ности диаметром 11 мм.

6. Сделайте вырез на величину 1 мм, исполь­
зовав команду Вытянутый вырез

7. Постройте круговой массив. Для этого
выберите команду Круговой массив ,
выделите в дереве конструирования две 
последние операции (построения лапки 
с отверстием) и на панели свойств задайте 
параметры согласно рисунку.

ш
I ЗбО.ООградусов

Ф ! з
0  Равный шаг

|j^ Вытянуть 1 
Вытянуть2



8. Установите вид спереди, в дереве констру­
ирования в качестве плоскости построе­
ния эскиза выберите плоскость Спереди, 
войдите в режим построения эскиза и соз­
дайте окружность с размерами, указанны­
ми на рисунке.

9. Использовав команду Вытянутый вырез 
(Л ||, сделайте вырез в модели детали в 
двух направлениях насквозь.

10. Установите вид слева, в дереве конструи­
рования в качестве плоскости построения 
эскиза выберите вариант Слева, войдите 
в режим построения эскиза и создайте 
прямоугольник с размерами, указанными 
на рисунке. По завершении выйдите из 
режима создания эскиза и, использовав
команду Вытянутый вырез (|g j, сделайте 
вырез в модели детали в одном направле­
нии насквозь. В результате получим пря­
моугольное отверстие в половине модели 
корпуса.

В результате должна получиться модель корпуса, показанная в начале этого раз­
дела (см. рис. 6.8).

6.8. Пружина
В этом разделе мы создадим трехмерную модель пружины по указанным на чертеже 
размерам (рис. 6.9).

Рис. 6.9. Чертеж пружины



1. Создайте новый документ, выбрав в каче­
стве типа документа вариант Деталь. Выбе­
рите в дереве конструирования плоскость 
для построения эскиза, щелкнув на пун­
кте Справа, и в появившейся панели щел­
кните на кнопке Эскиз Установите
вид справа, выбрав команду Стандартные 
виды ► Справа или щелкнув на кнопке Спра-
ва (3¾ в пиктографическом меню кнопки
Ориентация видов. Постройте эскиз согласно 
рисунку. Проставьте размер, щелкнув на 
кнопке Автоматическое нанесение размеров
ф  В завершение выйдите из режима

создания эскиза, снова щелкнув на кнопке 
Эскиз.

2. Для построения спирали выберите команду 
Геликоид и спираль ^  , укажите построен­
ную окружность и на панели свойств за­
дайте параметры спирали согласно рисунку.

I Шаг и вращение

©Постоянный шаг
О  Переменный шаг

□  Реверс направления 

Повороты:

По Р
Начальный угол:

I О.ООградусов

0  По часовой стрелке

3. Постройте объект, показанный на рисунке.

4. Установите вид сверху, щелкнув на кнопке
Сверху , и создайте эскиз окружности
диаметром 2 мм с привязкой к началу спи­
рали.



5. Выберите команду Вытянутая бобышка/осно-
вание (§ »  после чего в качестве профиля
выберите окружность, а в качестве направ­
ления — спираль.

Е Н Я Ш Ш В Я В В
•s х

*£ 1130002

Ориент./тип скручивания: 
По направлению

6. Установите вид спереди, щелкнув на кноп­
ке Спереди S  , и постройте два прямоу­
гольника, на расстоянии 35 мм друг от 
друга. Правая сторона одного из прямоу­
гольников должна проходить через начало 
координат.

7. Используя команду Вытянутый вырез цд|
сделайте вырез в модели детали в двух на­
правлениях насквозь.

6.9. Построение ассоциативного чертежа 
корпуса

В этом разделе мы построим чертеж созданной ранее (см. раздел 6.7) трехмерной 
модели корпуса.

1. Выберите команду Инструменты ► Параметры, в открывшемся окне перейдите 
на вкладку Настройки пользователя, выделите пункт Чертежи и сбросьте флажок 
Отметить все размеры детали/сборки для импорта в чертеж по умолчанию.

Настрой» по/ъзователя | Свойства документа j

Общие □  Авто-разиеще»#іе вставленных размеров с модели
Чертежи

ТѴг отображения пс
□  Удалить повторив размеры при вставке

Штриховка/Запол»- □  Отметить все размеры деташ/сборки для импорта в чертеж по умолчанию



2. В том же окне перейдите на вкладку Свой­
ства документа, выделите пункт Оформление 
и в группе Авто вставить при создании вида 
расставьте флажки так, как показано на 
рисунке.

 ̂Авто вставить при создании вида - - 
И  Указатели центра-отверстия

□  Указатели центрачхруглетя 

(7]Осееыѳ n — t
□  Ѳыноооі

3. На вкладке Расположение вида выберите 
команду Вид модели Щ Ц  .

4. Выберите файл модели (если он еще не от­
крыт), щелкните на кнопке Далее, устано­
вите переключатель Один вид и выберите 
вид слева.

0ОДИНВИД

О Несколько видов

Стандартные виды:

0 ___
© © в ]©
@ 0
Допо/нггелыые виды:

(А) Вид пржечания 1 
*Дк«етрия
*Тринетрия________

0Предв. просмотр

5. Укажите мышью положение вида на листе.

Ш il l . Ш

6. На месте главного изображения построй­
те фронтальный разрез. Для этого на ин­
струментальной панели Чертежи выберите
команду Разрез , задайте положение
секущей плоскости, построив разомкнутую 
линию, и разместите изображение разреза 
на листе (при необходимости измените на­
правление взгляда).

И



7. Снова вызвав команду Разрез J j  , по­
стройте на месте ввда сверху горизонталь­
ный разрез плоскостью, проходящей через 
ось отверстия и прямоугольный вырез.

8. Постройте аксонометрическое изображе­
ние модели, вызвав команду Проекционный
вид щ Укажите главное изображение —
разрез, расположите аксонометрию на 
свободном месте листа.
Для данной детали достаточно главного 
изображения (разрез) и вида сверху, 
поэтому вид слева скройте, выделив его 
и выбрав в контекстном меню команду 
Скрыть.

9. Окончательно расположите изображения 
на листе и нанесите необходимые разме­
ры, щелкнув на кнопке Автоматическое на­
несение размеров ^

ГЗначение ] 1 Вьмоски

Р З ]  Автоматическое 
f e i l  н а н е с е т е  размера

^ ■ Г Т І Ж М У І І Г  Г ,г “ ч - а » |— ►  ѵ |

© Ѳ ( @ ) Ѳ

<M00-blAM><DM>

H f f i l

®ѲШ)ѲѲ
f 1—11 Т  |д о п о л ... |

10. Для создания осевых линий используй
те команды Указатель центра <♦> и Осевая
линия . Для создания круговой осевой
линии на виде сверху достаточно указать 
на три окружности (отверстия в лапках).

Щ  U±\ I
0  Круговые ЛПП1 

□ Р а д и а іы « е  л*#* 

0 У казате іъ  центра

Готовый чертеж корпуса показан на рис. 6.10.
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6.10. Построение ассоциативного 
чертежа опоры

В этом разделе мы построим чертеж опоры, показанной на рис. 6.11.

Рис. 6.11. Модель опоры

1. На вкладке Расположение вида щелкните
на кнопке Вид модели , выберите файл
модели (если он еще не открыт), щелкните
на кнопке Далее, установите переключатель 
Один вид и выберите вид слева, после чего
укажите мышью положение вида на листе.

Г^Н  

Z I

2. На месте главного изображения постройте 
фронтальный разрез. Для этого на инстру­
ментальной панели Чертежи выберите ко­
манду Разрез J] , задайте положение се­
кущей плоскости, построив вертикальную 
линию, и разместите изображение разреза 
на листе (при необходимости измените на­
правление взгляда).

А-А К5

1й \
и
А

3. Вызовите команду Проекционный вид щ
и постройте вид сверху, как показано на ри­
сунке. Создайте также аксонометрическое 
изображение модели.

14
Ш

ф

ф

Для возможности нанесения размеров 
и угла наклона среза основания создайте 
частичный разрез, для чего нарисуйте ли­
нию, перпендикулярную линии среза, и вы­
делите эту линию.



5. После вызова команды Разрез секущая
плоскость разместится вдоль созданной 
линии. Задайте местоположение разреза. 
Замените отрезок, скрыв его, сплайном 
(линия обрыва), после чего измените на 
панели свойств принадлежность слою (для 
изменения типа линии на тонкую), выбрав 
вариант Thin line.

6-6

6. Для создания местного разреза на виде сле­
ва по оси отверстий в вертикальной стойке
выберите команду Вырыв детали , об­
ведите место разреза сплайном и задайте 
глубину выреза в 56 мм.

М

В таком масштабе проставлять размеры от­
верстия неудобно, поэтому нам потребуется 
выносной элемент. Выберите команду Мест­
ный вид , обведите построенный мест­
ный разрез окружностью, задайте на панели 
свойств нужный масштаб и разместите изо­
бражение на свободном месте листа.

В  (11)

8. Окончательно расположите изображения 
на листе. Для создания осевых линий ис­
пользуйте команды Указатель центра (+) 
и Осевая линия А з  . Нанесите необходимые 
размеры, щелкнув на кнопке Автоматическое 
нанесение размеров ф

Ш @ і
0  Круговые /м**і 

□Радиал*ь«
0  У камтв/ь центра

Готовый чертеж опоры показан на рис. 6.12.
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Моделирование
часть в системе

Autodesk Inventor

О Глава 7. Общие сведения о системе Autodesk Inventor 

О Глава 8. Знакомство с созданием моделей деталей 

О Глава 9. Создание моделей и ассоциативных чертежей деталей





_____ Общие сведения
1 ) глава о системе

Autodesk Inventor

Система Autodesk Inventor предназначена для создания твердотельных параме­
трических моделей деталей, сборок и последующего полуавтоматического вы­
полнения их рабочих и сборочных чертежей, содержащих все необходимые типы 
изображений.

7.1. Основные типы документов
С помощью Autodesk Inventor можно создавать документы шести типов, включая 
деталь, сборку, чертеж, презентацию, деталь из тонкостенного материала и сварную 
деталь.
Деталь — модель изделия, изготавливаемого из однородного материала без при­
менения сборочных операций. Детали хранятся в файлах с расширением .ipt.
Сборка — модель изделия, состоящего из нескольких деталей с заданным взаимным 
положением. Сборки хранятся в файлах с расширением .іат.
Чертеж — графический документ, содержащий графическое изображение из­
делия, основную надпись, рамку, иногда дополнительные объекты оформления 
(технические требования и т. д.). Чертеж Autodesk Inventor может содержать не­
сколько листов заданного пользователем формата. Чертежи хранятся в файлах 
с расширением .idw, .dwg.
Схема — специальный вид сборки. Основным типом схем являются схемы сборки- 
разборки. Они иллюстрируют процесс соединения компонентов в сборке. На 
основе схем можно создавать презентационные ролики, призванные показать 
последовательность сборки сложного изделия. Схемы хранятся в файлах с рас­
ширением .ірп.



Деталь из листового материала в отличие от модели обычной детали содержит 
специализированные команды моделирования. Сохраняется в том же формате, что 
и обычная модель изделия (в файлах с расширением .ipt).
Сварная деталь содержит команды моделирования сварных швов. Хранится в фор­
мате модели сборки (в файлах с расширением .іат).

7.2. Основные элементы интерфейса
Главная особенность нового интерфейса Autodesk Inventor заключается в том, что 
команды, ранее располагавшиеся на панелях управления и панелях инструментов, 
теперь размещаются на вкладках, которые, в свою очередь, расположены на ленте. 
Команды создания и модификации эскизов и моделей вызываются при помощи 
кнопок, расположенных на соответствующих вкладках ленты.
При работе с документом любого типа на экране отображаются панель быстрого 
доступа, лента и браузер.
Панель быстрого доступа содержит команды Стандартной панели -  создания, от­
крытия, сохранения файлов, отмены или повторения изменений в файле (рис. 7.1). 
На панель быстрого доступа можно добавить любые инструменты.

Рис. 7.1. Панель быстрого доступа

Лента состоит из наборов панелей, размещенных на вкладках, которые имеют 
названия, соответствующие задачам. Состав вкладок и инструментов зависит от 
создаваемого типа документа (рис. 7.2, 7.3, 7.4, 7.5).
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Рис. 7.2. Состав вкладок и команд ленты в режиме создания/редактирования эскиза
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Рис. 7.3. Состав вкладок и команд ленты в режиме создания/редактирования модели
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Рис. 7.4. Состав вкладок и команд ленты в режиме создания чертежа
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Рис. 7.5. Состав вкладок и команд ленты в режиме оформления чертежа 

Браузер описывается в разделе 7.5.

7.3. Использование контекстных меню
Команды для выполнения многих часто используемых действий можно вызывать 
из контекстных меню. Эти меню появляются на экране при щелчке правой кноп­
кой мыши. Состав меню разный в различных ситуациях. В нем собраны наиболее 
типичные для текущего момента работы команды.
Например, в режиме редактирования эскиза при щелчке правой кнопкой мыши на 
экране появится меню, показанное на рис. 7.6.
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Рис. 7.6. Контекстное меню в режиме редактирования эскиза

Таким образом, при выполнении различных действий можно быстро обратиться 
к нужной команде не только через инструментальные панели, но и через контекст­
ные меню.
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7.4. Управление отображением модели
Для управления масштабом отображения модели предназначены инструмен­
ты Панели навигации: Видовой куб, Штурвалы, Панорамирование, Инструменты 
Зуммирования,Инструменты орбиты, Вид грани (рис. 7.7).

Рис. 7.7. Панель навигации

Инструмент навигации Видовой куб (рис. 7.8) предоставляет возможность визуаль­
ного управления текущей ориентацией модели. Видовой куб позволяет настроить 
положение камеры для просмотра модели.
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Рис. 7.8. Видовой куб

Для изменения ориентации модели в Autodesk Inventor, кроме Видового куба, 
предусмотрена возможность вращения модели с помощью инструмента Орбита.
Чтобы повернуть модель, зайдите на вкладку Вид ► Навигация или на Панели нави­
гации щелкните на кнопке Орбита . В результате появится кольцо орбиты. При
наведении курсора мыши внутрь кольца и нажатии левой кнопки мыши можно 
выполнять свободное вращение модели. При наведении курсора на горизонтальную 
или вертикальную ось вращение модели будет осуществляться вокруг вертикаль­
ной или горизонтальной оси соответственно.
Иногда требуется, чтобы плоскости экрана оказалась параллельна вспомогатель­
ная плоскость или плоская грань модели. Чтобы установить такую ориентацию,
вызовите команду Вид грани [|§] и укажите нужный плоский объект. Модель
повернется так, чтобы направление взгляда было перпендикулярно выбранной 
грани/плоскости.

СОВЕТ Для изменения масштаба отображения объекта удобно вращать колесико 
мыши, а для его изменения в соответствии с размером экрана достаточно 
нажать клавишу Ноте.

Чтобы передвинуть изображение модели в окне, перемещайте мышь при 
нажатом колесике мыши.

Для вызова команды Орбита удерживайте нажатой клавишу F4.

Для включения режима Вид грани используйте клавишу Page Up.



При работе в Autodesk Inventor доступно несколько режимов отображения модели, 
для доступа к которым используются команды вкладки Вид ► Вид (рис. 7.9):
О режимы ортогональной и перспективной проекций;
О каркасный режим, режим с невидимыми линиями и тонированный режим;
О режимы без тени, тень на земле и тень от просвечивания;
О переопределение цвета.

Вид

Рис. 7.9. Панель Вид вкладки Вид

В режиме ортогональной проекции деталь представляется таким образом, что все 
ее точки проецируются на экран вдоль параллельных линий Q )

Посредством режима перспективной проекции можно получить еще более реали­
стичное изображение детали в соответствии с особенностями зрительного восприя­
тия человека. Точка схода перспективы располагается посередине окна детали. Все 
существующие режимы отображения (каркасный, полутоновый, с невидимыми
линиями) можно сочетать с перспективной проекцией 

В каркасном режиме отображаются все кромки модели [Q]

В режиме с невидимыми линиями (невидимые ребра и части ребер) все кромки 
модели, которые невозможно увидеть под выбранным углом, отображаются серым
цветом, модель становится полупрозрачной (Q

В тонированном режиме выводится закрашенное изображение модели Q I .

Какой бы вариант отображения ни был выбран, он не оказывает влияния на свой­
ства модели. Например, при выборе каркасного отображения модель остается 
сплошной и твердотельной (а не превращается в набор «проволочных ребер»), 
просто ее поверхность и материал не видны на экране.

7.5. Браузер
При работе с любым документом в Autodesk Inventor на экране кроме рабочей об­
ласти выводится окно браузера (рис. 7.10).
В окне браузера отображается иерархическая структура деталей, узлов и чертежей 
активного файла. В браузере детали имеются обозначения, соответствующие на­
чалу координат, плоскостям, осям, эскизам, операциям и окончанию построения 
модели.
Эскиз, задействованный в любой операции, размещается в «ветви» браузера, соот­
ветствующей этой операции. Слева от названия операции в браузере отображается



знак +. После щелчка мышью на этом знаке разворачивается список участвующих 
в операции эскизов. Эскизы, не задействованные в операциях, располагаются на 
верхнем уровне браузера.
Каждый элемент автоматически возникает в браузере сразу после создания. На­
звания присваиваются элементам также автоматически в зависимости от способа, 
которым они получены, например: Выдавливание, Вращение, Сопряжение и т. д.
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Рис. 7.10. Окно браузера

В детали может существовать множество однотипных элементов. Чтобы различать 
их, к названию элемента автоматически прибавляется его порядковый номер, на­
пример: Выдавливание 1, Выдавливание 2.
Можно переименовать любой элемент в браузере. Для этого необходимо дважды 
(с паузой) щелкнуть мышью на его названии или выбрать в контекстном меню 
команду Свойства (после щелчка правой кнопкой мыши на названии элемента). 
Новое название элемента будет сохранено в браузере.
Слева от названия каждого объекта в браузере выводится пиктограмма, соот­
ветствующая способу, которым этот элемент получен. Пиктограмму, в отличие от 
названия объекта, изменить невозможно. Благодаря этому при любом переимено­
вании элементов в браузере остается наглядная информация о способе и очеред­
ности их создания.
Браузер и графическая область динамически связаны. Можно выбирать элементы, 
эскизы, чертежные виды и вспомогательную геометрию в любой из областей окна.
Можно отключить режим показа браузера. Для этого на вкладке Вид ► Окна ► 
Пользовательский интерфейс достаточно сбросить галочку у пункта Браузер.



Знакомство с созданием 
моделей деталей

Программа Autodesk Inventor предназначена для создания трехмерных твердо­
тельных параметрических моделей деталей и сборок с последующей возможностью 
создания чертежей.

8.1. Общие принципы твердотельного 
моделирования деталей

В общем случае порядок создания модели корпусной детали ничем не отличается 
от рассмотренных ранее в главах 2 и 5 и может включать в себя формирование 
основания, приклеивание и вырезание дополнительных элементов, зеркальное 
копирование, создание дополнительных конструктивных элементов (рис. 8.1).
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Рис. 8.1. Этапы создания твердотельной модели детали: а —  формирование основания; 6 —  при­
клеивание дополнительного элемента; в — вырезание дополнительного элемента; г — создание 

дополнительных конструктивных элементов
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Формирование отдельных трехмерных объектов начинается с создания эскиза — 
плоской фигуры, на основе которой образуется объемное тело. Эскиз может рас­
полагаться на одной из плоскостей координат, на плоской грани существующего 
тела или на вспомогательной плоскости, положение которой задано пользователем. 
Эскиз изображается на плоскости стандартными средствами двухмерного редак­
тора. После создания эскиза на него накладываются ограничения и проставляются 
параметрические размеры.
При построении эскиза в системе Autodesk Inventor доступны все команды по­
строения и редактирования изображений, а также сервисные возможности. В эскиз 
можно перенести изображение из ранее подготовленного чертежа или фрагмента. 
Это позволяет при создании трехмерной модели опираться на существующую 
чертежно-конструкторскую документацию.

8.2. Основные операции 
3D-моделирования

В системе Autodesk Inventor определены следующие базовые операции создания 
твердых тел:

gjjj Выдавливание — построение конструктивного элемента с приданием объема 
— -  замкнутому или разомкнутому контуру или области;

Вращение — построение конструктивного элемента путем поворота одного 
или нескольких эскизных контуров вокруг оси;

Отверстие — построение отверстия определенного пользователем профиля;

Оболочка — построение полой тонкостенной оболочки путем удаления вну­
тренней части имеющейся детали;

Ребро жесткости — построение ребер жесткости;
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Д  По сечениям — построение элемента с поверхностью, переходной между не- 
сколькими контурами, расположенными на разных рабочих плоскостях или 
плоских гранях;

Сдвиг — построение конструктивного элемента путем перемещения замкну­
того эскиза вдоль плоской траектории;

Пружина — создание винтовых конструктивных элементов.

Объемные элементы образуются в результате операций — формообразующих 
перемещений эскизов. В основе операций лежат основные способы создания трех­
мерных объектов (рис. 8.2).



Рис. 8.2. Основные формообразующие операции создания трехмерных объектов: 
о — выдавливание; б  — вращение; в  —  кинематическая операция; г  —  операция по сечениям

Построение трехмерной модели детали начинается с анализа ее конструкции. 
Необходимо внимательно осмотреть деталь, уяснить ее назначение и технологию 
изготовления, определить название.
При изучении конструкции тщательно анализируется форма детали путем мыс­
ленного расчленения ее на простейшие геометрические тела (параллелепипеды, 
призмы, цилиндры, конусы, торы, кинематические элементы и т. д.) или их части, 
отдельно наружные поверхности и внутренние. Следует иметь в виду, что любая 
деталь представляет собой различные сочетания простейших геометрических форм. 
При этом мелкие конструктивные элементы (фаски, скругления, проточки и т. п.) 
из рассмотрения на первом этапе исключаются.
После этого приступают к созданию модели основного формообразующего элемен­
та детали. При построении можно использовать любую из четырех перечисленных 
формообразующих операций.



8.3. Система координат и плоскости 
проекций

В каждом файле детали существует система координат и проекционные плоскости, 
определяемые этой системой. Название этих объектов появляется в окне браузера 
после создания нового файла детали. Окно браузера предоставляет графический 
интерфейс для управления процессом создания и редактирования модели изде­
лия. Изображение системы координат появляется посередине окна построения 
модели; чтобы увидеть изображение проекционных плоскостей, нужно выделить 
их в браузере.
Плоскости на экране выглядят прямоугольными; такое представление позволяет 
увидеть положение плоскости в пространстве. Иногда, чтобы уяснить положение 
плоскости, требуется, чтобы символизирующий ее прямоугольник был больше 
(меньше) или располагался в другом месте плоскости. Поэтому размер и положение 
прямоугольника можно изменить. Плоскости проекций и систему координат уда­
лить из файла модели невозможно. Их можно переименовать, а также отключить 
их вывод в окне модели.
В системе Autodesk Inventor при выборе ориентации Изометрия координатные оси 
и плоскости проекций располагаются так, как показано на рис. 8.3, а. Эта ориента­
ция не совпадает с требованиями ГОСТ 2.319-69 (рис. 8.3, б).

Положение модели в системе координат таково, что при создании ассоциативного 
чертежа виды спереди, сверху и слева соответствуют рис. 8.4.
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Рис. 8.3. Ориентация координатных осей и плоскостей проекций: 
а — в системе Autodesk Inventor; б — по ГОСТ 2.317-69

Рис. 8.4. Ориентация ассоциативных видов в системе Autodesk Inventor



8.4. Особенности трехмерного 
моделирования деталей

При построении эскизов для создания ЗО-моделей деталей целесообразно про­
ставлять параметрические размеры, с помощью которых легко изменять геометрию 
контуров и редактировать твердотельные модели. На рис. 8.5 представлен параме­
тризованный эскиз контура для создания модели уголка.
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Рис. 8.5. Параметризованный эскиз контура для создания модели уголка

Важным этапом создания моделей деталей, соединяемых стандартными крепеж­
ными изделиями, является выбор параметров отверстий для этих изделий. Для 
создания круглого отверстия со сложным профилем необходимо использовать

команду Отверстие ©  . Перед вызовом этой команды требуется выделить плоскую
грань, в которой располагается отверстие. Далее необходимо в диалоговом окне 
Отверстия выбрать профиль отверстия и задать необходимые параметры (рис. 8.6).
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Рис. 8.6. Диалоговое окно команды Отверстие 

Положение отверстия задается в области Размещение.



8.5. Выбор ориентации модели детали
При выполнении чертежа детали необходимо правильно выбрать главное изобра­
жение. Согласно ГОСТ 2.305-68, в качестве главного принимается изображение на 
фронтальной плоскости проекций. Предмет располагают относительно фронталь­
ной плоскости проекций так, чтобы изображение на ней давало наиболее полное 
представление о форме, размерах и функциональном назначении предмета.
При создании трехмерной модели необходимо осознанно выбрать плоскость по­
строения эскиза. Для создания вида спереди нужно выбирать плоскость построения 
эскиза, заданную осями ОХ и OY.
Если в дальнейшем потребуется создать чертеж по модели, полезно просмотреть 
изображение модели (уже при построении основы детали), выбрав вид спереди 
или другие виды, чтобы оценить, насколько данный вид соответствует главному 
изображению детали.

8.6. Создание ассоциативных видов
Трехмерные модели деталей создаются не столько для наглядной визуализации, 
сколько с целью получения конструкторской документации, в том числе чертежей 
деталей.
В системе Autodesk Inventor имеется возможность создания ассоциативных чер­
тежей трехмерных деталей. В таких чертежах все виды связаны с моделью так, что 
изменения в модели приводят к изменению изображения в каждом ассоциативном 
виде и наоборот.
Ассоциативное изображение формируется на обычном чертеже. В нем создаются 
выбранные пользователем ассоциативные виды и разрезы (сечения) трехмерной 
детали. Виды автоматически располагаются в проекционной связи. При необходи­
мости связь можно разорвать — это дает возможность произвольного размещения 
видов на чертеже.
В системе Autodesk Inventor определены следующие базовые операции создания 
ассоциативных изображений:

[gIS Базовый вид — создание первого вида чертежа; 
іШі

д а  Проекционный вид — создание одного или нескольких проекционных видов 
относительно вида, определенного пользователем;

Дополнительный вид — создание дополнительного вида путем проецирования 
iSL. базового вида относительно выбранной грани или отрезка;

^  Сечение — создание простых и сложных разрезов относительно вида, опреде- 
u  ленного пользователем;



Выносной элемент — дополнительное изображение в нужном масштабе какой- 
либо части объекта;

Разрыв — обрыв или укорочение существующего вида в ситуациях, когда раз­
мер обычного вида превышает размер листа или значительная часть обычного 
вида не несет полезной информации;

Местный разрез — удаление заданной области материала для показа скрытых 
деталей или элементов на существующем виде.



_ _____ Создание моделей
§ ) ГЛАВА и ассоциативных 

чертежей деталей

В этой главе описаны этапы создания в системе Autodesk Inventor ЗЭ-моделей 
восьми деталей, упомянутых во введении к этой книге, и ассоциативного чертежа 
для одной из моделей. Предыдущие главы 7 и 8 написаны под версию Autodesk 
Inventor 2010, глава 9 — под Autodesk Inventor 9.

9.1. Изолятор
В этом разделе мы создадим трехмерную модель изолятора, показанную на рис. 9.1.

1. Создайте новый документ, выбрав в каче­
стве типа документа вариант Обычный.ірі О

Обычный (wi).ipt

2. Выберите в окне браузера плоскость XY. 
При необходимости щелкните на кнопке
Вид на объект В результате плоскость
эскиза станет параллельной плоскости 
экрана монитора.

I Модель ’ _____ч
■ ■ я

д  Детагь2
Е^ЬСЭ Начало

^ Плоскость YZ 
Плоскость XZ



3. Щелкните на кнопке Эскиз «фэскю и по­
стройте эскиз согласно рисунку. Для этого 
выберите команду Окружность 0  и по­
стройте окружности произвольного радиу­
са и положения. Нанесите размеры, исполь­
зуя команду Нанести размер Выйдите 
из режима построения эскиза, щелкнув на
КНОПКе В о з в р а т  f t  Возврат

4. Нажмите клавишу F6 для перехода к изоме­
трическому представлению. Для создания 
модели на основе построенного эскиза вы­
берите команду Выдавливание т  Затем
щелкните на кнопке Эскиз в диалоговом 
окне (если она не нажата) и выделите вну­
треннюю область эскиза.

5. В диалоговом окне команды задайте ве­
личину выдавливания 20 мм и выберите 
направление выдавливания.

Форма [подробности I

л ]  3000 [*
f-Ограччасю-----
{Расстояние Н

-Результат— ja 120 m ^

[ і \ о ] [F
Г" Повторять форму

® |+1 г II Отаи 1

6. Выберите в окне браузера вариант Пло­
скость YZ и щелкните на кнопке Вид на объ­
ект Затем щелкните на кнопке Эскиз
<3£эскиз и создайте эскиз согласно приведен­
ному рисунку, используя команду Прямо­
угольник □  . Проставьте размеры и выйди­
те из режима создания эскиза, щелкнув на
КНОПКе В о з в р а т  f t  Возврат .

10-
-10

-10

10



7. Выберите команду Выдавливание Э  , щел­
кните на кнопке Эскиз в диалоговом окне 
(если она не нажата) и выберите внутрен­
ние области эскиза. Установите в диало­
говом окне команды вычитание в обоих 
направлениях. Обратите внимание на на­
жатую кнопку Вычитание (§j !

В итоге мы должны получить требуемую модель (см. рис. 9.1).

9.2. Вкладыш
В этом разделе мы создадим трехмерную модель вкладыша, показанную на рис. 9.2.

Рис. 9.2. Модель вкладыша

1. Создайте новый документ, выбрав в каче­
стве типа документа вариант Обычный, и 
в окне браузера выберите плоскость XY.
Щелкнув на кнопке Эскиз «фэото, постройте 
эскиз согласно рисунку. Нанесите разме­
ры, используя команду Нанести размер ф  . 
Выйдите из режима построения эскиза, 
щелкнув на кнопке Возврат в̂ожрат.

д )
рОграммвнив---
1*. j

[а
й | fcj 0J |й ”

Г  Повторять форму

®1 OK j Отмена |



2. Выберите команду Выдавливание ш  ^ д и ­
алоговом окне щелкните на кнопке Эскиз 
(если она не нажата) и выделите указанную 
на рисунке область эскиза.

3. В диалоговом окне команды задайте вели­
чину выдавливания 10 мм и щелкните на 
кнопке ОК.

к и 1

3

р О гр м и ч м м -----------

JPaccTOHtw »1

110 m

[ F  С 5 І Й І

Г  Повторять фориу
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4. В качестве плоскости построения следую­
щего эскиза выберите плоскость верхне­
го основания и щелкните на кнопке Эскиз
< $ £ э е к и з .

5. Постройте окружности диаметром 60 
и 20 мм, а также горизонтальный отрезок. 
Вторую окружность диаметром 20 мм по­
стройте относительно построенного отрез­
ка, используя команду Симметрия ■Й .Для
этого нужно указать сначала окружность, 
а затем — отрезок, щелкнув на кнопке Ось 
симметрии.

6. Выберите команду Обрезать н >  , чтобы
получить показанное на рисунке изобра­
жение.



7. Выделите указанную на рисунке область 
и выдавите данный контур на 20 мм, ис­
пользуя команду Выдавливание Щ  . Обра­
тите внимание на нажатую кнопку Объеди­
нение ійі !

Фориа ] Подробности 
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8. В качестве плоскости построения сле­
дующего эскиза выберите плоскость YZ
и щелкните на кнопке Эскиз <̂ эскю. По­
стройте прямоугольник и вертикальную 
вспомогательную линию согласно рисунку.

■*•30----- ►

1
15-

9. Используя команду Выдавливание т ,
выделите область прямоугольника и вы­
режьте его. Обратите внимание на на­
жатые кнопки-переключатели Вычитание 
Ц  и Оба направления^ !

Фориа (Подробности I

-Результат- 
•  в\

а |
гОграіичаиа----
|ec i l

fa
_aj йИГй

Г* Повторять форку

©1+1

10. В итоге мы получим показанное на рисун­
ке изображение. Выберите указанную на 
рисунке плоскость для построения сле­
дующего эскиза.



11. Изобразите квадрат и вертикальную ли­
нию (размеры даны на рисунке). Второй 
квадрат постройте, использовав коман­
ду Симметрия Л  и указав отражаемые
объекты (четыре отрезка — стороны ква­
драта), а также вертикальную линию, от­
носительно которой будет происходить 
отражение. Выйдите из режима построе­
ния эскиза.

12. Выдавите этот эскиз на 5 мм, используя 
команду Выдавливание ж  Обратите 
внимание на нажатую кнопку Вычитание
гЭ| и выбранное направление выреза!

13. Укажите размеры построенных квадратов.

В результате мы должны получить требуемое изображение (см. рис. 9.2).

9.3. Игольчатый радиатор
В этом разделе мы создадим трехмерную модель игольчатого радиатора, показан­
ную на рис. 9.3.

Рис. 9.3. Модель радиатора



1. Создайте новый документ, выбрав в каче­
стве типа документа вариант Обычный. Вы­
берите в окне браузера плоскость XY. При 
необходимости, щелкните на кнопке Вид на
объект ^  В  результате плоскость эскиза
станет параллельной плоскости экрана мо­
нитора. Постройте эскиз согласно рисунку. 
Проставьте размеры, используя команду
Нанести размер Затем выйдите из ре­
жима создания эскиза, щелкнув на кнопке 
Возврат fr  Возврат .

2. Нажмите клавишу F6 для перехода к изоме­
трическому представлению. Для создания 
модели на основе построенного эскиза вы­
берите команду Выдавливание т  , щелкни­
те на кнопке Эскиз в диалоговом окне (если 
она не нажата) и выберите внутреннюю 
область эскиза.

3. В открывшемся диалоговом окне устано­
вите параметры согласно рисунку. Задайте 
величину выдавливания 3 мм. В заверше­
ние щелкните на кнопке ОК.

4. В качестве плоскости построения следую­
щего эскиза выберите верхнюю плоскость 
основания и постройте эскиз согласно ри­
сунку.



5. Выполните команду Выдавливание s. 
установив расстояние 15 мм и угол на­
клона -1°. В результате мы получим иглу 
в виде усеченного конуса.
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6. Размножьте иглы, построив прямоуголь­
ный массив. Для этого выберите команду
Прямоугольный массив и задайте пара­
метры построения массива согласно ри­
сунку.
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7. Направления построения массива укажите, 
выделив ребра вдоль осей Y и X.

8. Скройте 5 иголок в центре радиатора, вы­
брав в контекстном меню окна браузера 
команду Погасить.



9. Вызовите команду Фаска ф  , отметьте все
шесть ребер отверстий и установите пара­
метры фаски: катет — 0,5 мм, угол накло­
на — 45°

В результате мы должны получить требуемую модель (см. рис. 9.3).

9.4. Уголок
В этом разделе мы создадим трехмерную модель уголка, показанную на рис. 9.4.

Рис. 9.4. Модель уголка

1. Создайте новый документ, выбрав в каче­
стве типа документа вариант Обычный. Для 
построения эскиза выберите в окне браузе­
ра плоскость YZ. Постройте эскиз согласно 
рисунку. Проставьте размеры, используя
команду Нанести размер . Затем выйди­
те из режима создания эскиза, щелкнув на 
КНОПКе ВОЗВраТ Возврат.

2. Выберите команду Выдавливание т  и вы­
полните операцию выдавливания в обе 
стороны от плоскости эскиза, задав в диа­
логовом окне команды величину 30 мм. Ре­
зультат показан на рисунке.

3. Для построения ребра жесткости выберите 
торцевую плоскость уголка и постройте 
эскиз согласно рисунку.
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4. Выберите команду Ребро жесткости и 
задайте толщину ребра 2 мм.
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5. Выберите направление, как указано на ри­
сунке.

6. Для зеркального отражения ребра выбери­
те команду Симметрия DM , в открывшем­
ся диалоговом окне щелкните на кнопке 
Плоскость симметрии и в окне браузера за­
дайте в качестве плоскости симметрии 
плоскость YZ, затем щелкните на кнопке 
Элементы и в окне браузера задайте ребро 
жесткости. На последующих рисунках по­
казаны фантом зеркального отражения 
и результат моделирования.



7. Для построения скруглений выберите ко­

манду Сопряжение 3 , выделите указан­
ные на рисунке ребра и задайте величину 
радиуса 3 мм.

8. В целях ознакомления смоделируем от­
верстие в основании. Для этого вызовите
команду Отверстие т  , в появившемся
диалоговом окне выберите отверстие с фа­
ской и задайте параметры, как показано 
на рисунке. Щелкнув на кнопках Ребро 1 
и Ребро 2, укажите ребра основания уголка.

9. Путем простановки размеров задайте ме 
стоположение центра отверстия.

В результате моделирования мы должны получить требуемую модель (см. рис. 9.4).

9.5. Втулка
В этом разделе мы создадим трехмерную модель втулки, показанную на рис. 9.5.

Рис. 9.5. Модель втулки
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1. Создайте новый документ, выбрав в каче­
стве типа документа вариант Обычный. Для 
построения эскиза выберите в окне браузе­
ра плоскость YZ. Постройте эскиз согласно 
рисунку. Не забудьте обязательно постро­
ить осевую линию, относительно которой 
мы будем создавать тело вращения (при 
построении отрезка должна быть нажата
кнопка Осевая линия -0- на стандартной 
панели инструментов). Проставьте разме­
ры, используя команду Нанести размер . 
В завершение выйдите из режима создания 
эскиза, щелкнув на кнопке Возврат ft возврат.

2. Выберите команду Вращение т  , в от­
крывшемся диалоговом окне щелкните на 
кнопке Эскиз (если она не нажата) и вы­
берите область эскиза, затем щелкните на 
кнопке Ось и укажите осевую линию.
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3. В качестве плоскости построения эскиза 
выберите торцевую плоскость большего ци­
линдра и создайте эскиз в виде замкнутого 
контура согласно рисунку.

4. Выберите команду Выдавливание Щ  и при
нажатой в диалоговом окне команды кноп­
ке Вычитание вырежьте контур, получив 
треугольное углубление.



5. Постройте круговой массив. Для этого
выберите команду Круговой массив ф
и укажите в разделе Элементы вырезанное 
углубление, а в разделе Ось массива — по­
верхность вращения. Количество элемен­
тов массива задайте равным 120.

В результате моделирования мы должны получить требуемую модель (см. рис. 9.5).

9.6. Кронштейн
В этом разделе мы создадим трехмерную модель кронштейна, показанную на 
рис. 9.6.

Рис. 9.6. Модель кронштейна

1. Создайте новый документ, выбрав в каче­
стве типа документа вариант Обычный. Для 
построения эскиза выберите в окне браузе­
ра плоскость XL. Постройте эскиз согласно 
рисунку. Проставьте размеры, используя
команду Нанести размер . В завершение 
выйдите из режима создания эскиза, щел­
кнув на кнопке Возврат возврат.
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2. Выберите команду Выдавливание @
и в диалоговом окне команды задайте ве­
личину выдавливания 50 мм. Результат по­
казан на рисунке.

3. Укажите переднюю плоскость модели и вы­
берите команду построения эскиза. Создай­
те эскиз в виде двух равных по диаметру 
окружностей. Выделите обе окружности, 
представленные на рисунке, и назначьте
взаимосвязи Касательность и Равенство

н&*-уіх

і!&я*Уіх

4. Командой Обрезать ^  обрежьте ненуж­
ные фрагменты примитивов.

5. Вызовите команду Выдавливание s , вы­
берите внутреннюю область эскиза и в диа­
логовом окне команды задайте величину 
выдавливания 8 мм.

6. Выберите торцевую плоскость основания 
и создайте прямоугольник с размерами 
110x20. Выйдите из режима создания эски­
за.



7. Выберите команду Выдавливание т щ ел­
кните на кнопке Эскиз в диалоговом окне 
(если она не нажата) и выберите внутрен­
нюю область прямоугольника. Установите 
на диалоговой панели команды вычитание 
через все. Обратите внимание на нажатую
кнопку Вычитание (g  !

8. В качестве плоскости построения эскиза 
выберите верхнюю плоскость основания и
вызовите команду Отверстие ш  . Выберите
вид отверстия — с зенковкой. Установи­
те параметры отверстия согласно рисунку. 
В области Размещение путем простановки 
размеров задайте положение центра отвер­
стия.

)¾ Отюситеікно ребер

_[*_|й]*врог

гЦГ 

а ЦТ

J*—*1-- 120,8 m 3
\̂| j 120град И

В
-•1 I*— Гшй" 7J

г U U j ;:srDis 7]
•Ораммам-------------
ІНаодозь й]

ІіГ г ¥  r 1(¾)] ОК || Отмене j

9. Для построения скруглений выберите ко­
манду Сопряжение 3  , выделите указан­
ные элементы и задайте радиус 3 мм.



10. Для зеркального отражения выберите ко­
манду Симметрия №  , щелкните на кнопке
Все тело целиком и укажите плоскость сим­
метрии — грань модели.

11. Еще раз зеркально отразите полученное 
(оно показано на рисунке) изображение.

k  IС рабочими элеиентани 

j Плоскость сжиетр»™

Г~ Удалить исходные объекты 

Q j  I OK j Отиена | » |

В результате моделирования мы должны получить требуемую модель (см. рис. 9.6).

9.7. Корпус
В этом разделе мы создадим трехмерную модель корпуса, показанную на рис. 9.7.

Рис. 9.7. Модель корпуса



1. Создайте новый документ, выбрав в ка­
честве типа документа вариант Обычный. 
Для построения эскиза выберите в окне 
браузера плоскость XZ. Постройте эскиз 
согласно рисунку. Не забудьте обязательно 
построить проходящую через начало коор­
динат (для удобства) осевую линию, от­
носительно которой будем создавать тело 
вращения (при построении отрезка должна
быть нажата кнопка Осевая линия -0- на
стандартной панели инструментов). Про­
ставьте размеры, используя команду На­
нести размер В завершение выйдите 
из режима создания эскиза, щелкнув на
КНОПКе В озвр ат  t  Возврат.

2. Выберите команду Вращение , выберите
область эскиза, в открывшемся диалоговом 
окне щелкните на кнопке Ось и укажите 
осевую линию. В завершение щелкните на 
кнопке ОК.

3. Укажите нижнюю плоскость модели и вы­
берите команду построения эскиза. Уста­
новите вид сверху и создайте эскиз соглас­
но рисунку. Выйдите из режима создания 
эскиза.

4. Выберите команду Выдавливание т  и вы­
полните выдавливание на 10 мм.

5. На верхней плоскости созданной на пред­
ыдущем шаге лапки создайте эскиз в виде 
окружности диаметром 11 мм.



6. Выполните вырез на 1 мм, используя ко­
манду Выдавливание ш Фантом выреза
и результат показаны на последующих ри­
сунках.

7. Постройте скругления величиной 2 мм, ис­
пользуя команду Сопряжение ^

8. Постройте круговой массив. Для этого
выберите команду Круговой массив ,
выделите в окне браузера три последние 
операции (построения лапки с отверсти­
ем и скруглениями) и в открывшемся диа­
логовом окне задайте параметры согласно 
рисунку. Фантом построения массива и 
результат показаны на последующих ри­
сунках.

КР|ТиВОРПММ 'ЧШЗ

n aJ

П  3  о  1360 град 3

®] 1

9. Выберите в окне браузера плоскость XZ, 
войдите в режим построения эскиза и соз­
дайте окружность с центром на оси враще­
ния модели и с размерами, указанными на 
рисунке. Используя команду Выдавливание
1¾ , выполните вырез построенного эски­

за из модели детали в двух направлениях 
насквозь.

ш к Ш



10. Выберите в окне браузера плоскость YZ, 
войдите в режим построения эскиза и соз­
дайте прямоугольник с размерами, указан­
ными на рисунке. Для простановки размера 
10 (центрирование по вертикали) создайте 
вспомогательную вертикальную линию, 
совпадающую с положением оси вращения 
модели. В завершение выйдите из режима 
создания эскиза.

11.Используя команду Выдавливание ш,
выполните вырез построенного эскиза из 
модели детали в одном направлении на рас­
стояние, превышающее толщину стенки 
модели, например на 20 мм.

В результате моделирования мы должны получить требуемую модель (см. рис. 9.7).

9.8. Пружина
В этом разделе мы создадим трехмерную модель пружины согласно имеющимся 
на чертеже размерам (рис. 9.8).

Рис. 9.8. Чертеж пружины



1. Создайте новый документ, выбрав в ка­
честве типа документа вариант Обычный. 
Для построения эскиза выберите в окне 
браузера плоскость YZ. Постройте эскиз 
согласно рисунку. Не забудьте провести 
горизонтальную вспомогательную линию 
на уровне оси пружины. Проставьте разме­
ры, используя команду Нанести размер . 
В завершение выйдите из режима создания 
эскиза, щелкнув на кнопке Возврат в̂озврат.

2. Выберите команду Пружина 2£ , после чего
на вкладке Форма открывшегося диалого­
вого окна с помощью кнопки Эскиз выбе­
рите окружность, а с помощью кнопки Ось 
укажите горизонтальную вспомогательную 
линию.

Форме I Размеры ] Граиишые условия |

ИІ
-Направление—

FW I
1» Ій

©1

3. Задайте указанные на рисунке параметры 
на вкладке Размеры. Форма Размеры j гражчюе условия J 

Способ задания
|шаг и <*кло витков
Шаг Длина
14,000 ж J  110,000 ми J
' Ісло витков УГол конусе
|10 >| 10,00 град .►]

1 0« I

4. Задайте указанные на рисунке параметры 
на вкладке Граничные условия. Результат 
моделирования показан на следующем ри­
сунке.

Форма I Размеры Грм»«е условия |
рѲконів-----------

|катура/ъная
Переходная часть

(натуральная
Переходная часть

10,00 град »1 
Плоская часть

J 0,00 град ► 1 
Плоская часть

J 0,00 град ►! 10,00 град

л і



5. Выберите в окне браузера плоскость YZ, 
постройте два прямоугольника согласно 
рисунку. Правая сторона одного из прямоу­
гольников должна проходить через центр 
окружности сечения.

6. Выберите команду Выдавливание т  и при 
нажатой в диалоговом окне команды кноп­
ке Вычитание (В| вырежьте прямоугольни­
ки из модели детали в двух направлениях 
насквозь.
Результат моделирования представлен на 
рисунке.

9.9. Построение ассоциативного чертежа 
кронштейна

В этом разделе мы построим чертеж созданной ранее (см. раздел 9.6) трехмерной 
модели кронштейна.

1. Создайте новый документ-чертеж. Открой­
те файл модели (если он еще не открыт) 
или выберите имя файла в списке Файл на 
вкладке Компонент диалогового окна Вид 
чертежа. На инструментальной панели Виды 
чертежа щелкните на кнопке Главный Вид
Івхі. В диалоговом окне выберите изобра­

жение, соответствующее виду слева, и ука­
жите мышью положение вида на листе.

л
Внд чоргеі.а 

Ксі«іси«кт )отм ч 1
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гМкштаб--------------------------1 гН азм ж е-------------------------1 1—
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верху у  
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права

іг______ а
| І  .  j ! (вИДІ ! Ciu_
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2. На месте главного изображения постройте 
фронтальный разрез. Для этого на инстру­
ментальной панели Виды чертежа выберите
команду Разрез ^  и, щелкнув в видовом
окне, укажите вид, на основе которого де­
лается разрез. Задайте положение секущей 
плоскости, построив разомкнутую линию.

3. В том же диалоговом окне можно устано­
вить параметры разреза. Разместите изо­
бражение разреза на листе (при необхо­
димости измените направление взгляда). 
Нам требуется отключить вывод названия 
и масштаба разреза, так как секущая пло­
скость разреза совпадает с плоскостью сим­
метрии детали. Чтобы скрыть обозначения 
секущей плоскости, выделите обозначение 
и на панели слоев отключите видимость 
слоя Линия разреза.

Разрез

-Назван*-------- -Масштаб

1*
Г* Видимость

И
Г  Видимость Іѳ

el
•Глубина сечения-

~3

©]

4. Вызовите команду Проекционный вид ^
и постройте вид сверху и аксонометри­
ческое изображение модели. Вид сверху 
стройте, проецируя вид слева, в противном 
случае (если спроецировать главное изо­
бражение) получился бы половинчатый 
вид.

5. Поверните вид сверху на 90°



6. Для расположения вида сверху под глав­
ным изображением выделите вид сверху, 
выберите команду Сервис ► Выровнять 
виды ► Вертикально и укажите главное изо­
бражение. Окончательно расположите изо­
бражения на листе. Нанесите необходимые
размеры, щелкнув на кнопке Нанести размер 
ф  . Для создания осевых линий исполь­

зуйте команды Указатель центра -{- и Осе­
вая линия

Готовый чертеж кронштейна показан на рис. 9.9.
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идгтк Моделирование 
-------в системе AutoCAD

О Глава 10. Общие сведения о системе AutoCAD 

О Глава 11. Основы моделирования в системе AutoCAD 

О Глава 12. Создание моделей и ассоциативных чертежей деталей





ГЛАВА
Общие сведения 
о системе AutoCAD

Система AutoCAD предназначена в основном для создания двухмерных чертежей, 
но поддерживает также поверхностное и твердотельное моделирование.

Документы AutoCAD хранятся в файлах с расширением .dwg.
Кроме того, в AutoCAD используются следующие расширения файлов:
О .dws — файлы стандартов со стандартными определениями именованных объ­

ектов чертежа (можно проверять соответствие стандартам имен слоев, типов 
линий, текстовых и размерных стилей);

О .dwt — файлы шаблонов с необходимыми параметрами чертежа;
О .dxf — файл чертежа в простом текстовом формате (используется как формат 

обмена файлами чертежей).

10.2. Основные элементы интерфейса
В AutoCADe теперь есть возможность выбора оформления рабочего пространства. 
Можно вызвать инструментальную панель Workspaces (Рабочее пространство) 
либо в строке состояния щелкнуть на кнопке Workspace Switching (Переключение

пространства (рис. 10.1).
Пункт AutoCAD Classic приведет систему к обычному знакомому пользователям 
виду, пункт 3D Modeling — к виду, похожему на Microsoft Office 2007, с вкладками 
на ленте и пиктографическим меню.

10.1. Основные типы документов

рабочего пространства) , открыв меню выбора оформления рабочего



2D Drafting 8t Annotation 
1 *  13D Modeling___________

AutuLAD
Initial Setup Workspace

Save Current As...
{§} Workspace Settings...

Customize...

Рис. 10.1. Меню выбора оформления рабочего пространства

Команды вызываются из обычного меню, контекстного меню, а также при помощи 
кнопок на инструментальных панелях.
При работе с документом на экране отображаются строка меню, командная строка, 
строка состояния и несколько инструментальных панелей: Standard (Стандартная), 
Properties (Свойства), Layers (Слои), Draw (Рисование) и Modify (Модификация).
Меню системы служит для вызова команд (рис. 10.2). Вызов некоторых из них 
возможен также с помощью кнопок инструментальных панелей. По умолчанию 
строка меню располагается в верхней части окна.

ж  *  ■  ^  ~  ■=■ а AutoCAD 2010 Drawing!.dwg

F ile  E d it V ie w  In s e r t  F o r г.ѵэі: Too!-: С-ГО'Л> ['imeriL-iur-1 M o d ify  Pa t .E-mr V '/ in d o 1.'.' H e lp E .p r e :

Рис. 10.2. Строка меню

При выборе пункта меню открывается доступ к командам этого пункта. Некоторые 
из команд имеют собственные подменю. Для вызова команды (выполнения соот­
ветствующего ей действия) щелкните мышью на ее названии.
В прежних версиях программы широко использовалось экранное меню (рис. 10.3), 
которое можно применять в качестве альтернативы обычному меню.

AutoCAD
* 4с * *
FILE 
EDIT 
VIEW 1 
VIEW 2 
INSERT 
FORMAT 
TOOLS 1 
TOOLS 2 
DRAW 1 
DRAW 2 
DIMNSION 
MODIFY 1 
MODIFY2

HELP^^^^
LAST



Экранное меню можно вызвать, установив флажок Display screen menu (Показать 
экранное меню) на вкладке Display (Экран) диалогового окна, открываемого коман­
дой Tools ► Options (Инструменты ► Параметры).
Стандартная панель содержит кнопки вызова команд стандартных операций для 
работы с файлами и объектами, команды изменения масштаба отображения объ­
ектов на экране и команды вызова панелей свойств, дизайн-центра и др. (рис. 10.4).

I D B ’ H X Ой Р  S  ЕР Щ § ^  £1 1  Ш

Рис. 10.4. Стандартная панель

Панель Layers (Слои) содержит кнопку вызова диалогового окна настройки и соз­
дания слоев, а также список слоев чертежа (рис. 10.5).

_ v j #  у

Рис. 10.5. Панель слоев

Панель Properties (Свойства) содержит списки свойств объектов чертежа: цвет, тип 
линии, толщина линии (рис. 10.6).

^  □  ByLayer ѵ |  |------  ByLayer v j  | ....... ByLayer v j  [ ByCoior

Рис. 10.6. Панель свойств

В командной строке выводятся запросы и сообщения (рис. 10.7). Командная строка 
предназначена для ввода или выбора пользователем команд AutoCAD. Для ввода 
команд или выбора параметров текущей команды можно применять горячие кла­
виши (подчеркнутый символ в названии параметра). Для просмотра списка всех 
действий пользователя нажмите клавишу F2.

X Comnand: -

Command:

■ Comnand: _line Specify first  point:

j Specify next point or [Undo] :

5 Specify next point or [Undo] : Ғ'
Я Comnand: ,<> '>}

Рис. 10.7. Командная строка

Строка состояния располагается в нижней части экрана (рис. 10.8). Слева выво­
дятся текущие координаты положения курсора, в средней части — кнопки вспо­
могательных режимов: Snap (Шаг), Grid (Сетка), Ortho (Ортогональное рисование), 
Polar Tracking (Полярное отслеживание), Object Snap (Объектная привязка), Object 
Snap Tracking (Объектное отслеживание), Allow/Disallow Dynamic UCS (Динамическое 
изменения пользовательской системы координат), Dynamic Input (Динамическое 
отображение ввода), Show/Hide Lineweight (Вес/Ширина элементов чертежа), Quick 
Properties (Быстрые свойства), MODEL (Модель) и др.
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Рис. 10.8. Строка состояния

Для включения/выключения некоторых вспомогательных режимов можно при­
менять клавиатурные сокращения:
О Snap (Шаг) — F9;
О Grid (Сетка) — F7;
О Ortho (Ортогональное рисование) — F8;
О Polar Tracking (Полярное отслеживание) — F10;
О Object Snap (Объектная привязка) — F3;
О Object Snap Tracking (Объектное отслеживание) — F11.
Пользователь может изменять состав меню и инструментальных панелей, а также 
создавать собственные панели. Для вызова диалогового окна (рис. 10.9), позво­
ляющего произвести эту настройку, служит команда Tools ► Customize ► Interface 
(Инструменты ► Настройка ► Интерфейс).
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Панель Draw (Рисование) служит для создания двухмерных примитивов 
(рис. 10.10).
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Рис. 10.10. Панель рисования

Панель Modify (Модификация) предназначена для редактирования примитивов 
(рис. 10.11).
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Рис. 10.11. Панель модификации

С помощью панели Modeling (Моделирование), показанной на рис. 10.12, можно 
создавать трехмерные примитивы и трехмерные объекты на основе эскизов (се­
чений).
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Рис. 10.12. Панель моделирования

10.3. Использование контекстных меню
Команды для выполнения многих часто используемых действий можно вызвать из 
контекстного меню. Это меню появляется на экране при щелчке правой кнопкой 
мыши. Состав меню разный для различных ситуаций. В нем собраны наиболее 
типичные для текущего момента работы команды.
Например, в состоянии ожидания при щелчке правой кнопкой мыши на графиче­
ской области появляется меню, показанное на рис. 10.13.
Таким образом, при выполнении различных действий можно быстро обратиться 
к нужной команде не только через строку меню или инструментальные панели, но 
и через контекстное меню.
Функции правой кнопки мыши можно настроить на вкладке User preferences (Поль­
зовательские предпочтения) в диалоговом окне, которое вызывается командой 
Tools ► Options (Инструменты ► Параметры). Для этого предназначены флажок 
Shortcut menus in drawing area (Контекстное меню в области рисования) и кнопка 
Right-click Customization (Правая кнопка мыши).
В AutoCAD есть возможность выполнять привязку к характерным точкам по­
строенных объектов. Такой режим называется объектной привязкой (object snap, 
или сокращенно OSNAP). Существует две разновидности привязки: разовая и по­
стоянная.
Разовая объектная привязка позволяет в текущий момент привязаться к точке по­
строенного объекта. Для этого надо нажать клавишу Shift и, удерживая ее, щелкнуть 
правой кнопкой мыши, после чего появится контекстное меню, в котором можно 
выбрать способ привязки (рис. 10.14).
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Постоянная объектная привязка настраивается в диалоговом окне (рис. 10.15), вы­
зываемом командой Tools ► Drafting Settings ► Object Snap (Инструменты ► Параметры 
чертежа ► Объектная привязка).
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Рис. 10.15. Диалоговое окно настройки режимов объектной привязки

10.4. Управление масштабом, сдвигом 
изображения и поворотом модели

Для управления масштабом изображения модели предназначены команды Window 
(Рамка), Dynamic (Динамическое изменение масштаба), Scale (Масштабировать), 
Center (Центр), Object (Объект), In (Увеличить), Out (Уменьшить), All (Все), Extents 
(До границ). Эти команды — в подменю Zoom (Масштаб) меню View (Вид), а кноп­
ки для их быстрого вызова — на панели Zoom (Масштаб), которая показана на 
рис. 10.16.
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Рис. 10.16. Панель управления масштабом изображения

Чтобы передвинуть изображение в окне, нажмите колесо мыши и перемещайте 
мышь. Можно также вызвать команду Pan (Панорамирование) , используя 
стандартную панель инструментов или меню View (Вид).



При создании модели может возникнуть необходимость посмотреть не нее с раз­
ных сторон. Для этого в AutoCAD предусмотрена возможность вращения модели. 
Чтобы повернуть модель, вызовите команду View ► Orbit или щелкните на нужной 
кнопке панели Orbit (рис. 10.17).
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Рис. 10.17. Панель инструментов Orbit

СОВЕТ Для поворота модели удобно перемещать мышь, удерживая клавишу Shift 
и колесико мыши, а для изменения масштаба отображения объекта можно 
вращать колесико мыши.

10.5. Управление ориентацией рисунка
Для изменения ориентации рисунка в AutoCAD можно воспользоваться командой 
View ► 3DViews (Вид ► ЗО-Вид) или вызвать панель View (Вид).
Панель View (Вид) содержит кнопки вызова команд выбора одного из шести 
основных стандартных видов, а также четыре варианта прямоугольной изометрии 
с разными направлениями взгляда (рис. 10.18).
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Рис. 10.18. Панель выбора вида

Следует помнить, что в AutoCADe всегда создают объект в плоскости XY. Для из­
менения положения этой плоскости в глобальной системе координат существуют 
команды, вызываемые из подменю Tools ► New UCS (Инструменты ► Новая пользо­
вательская система координат) или с помощью кнопок соответствующей панели 
инструментов (рис. 10.19).
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Рис. 10.19. Панель UCS

10.6. Управление режимом отображения 
детали

При работе в AutoCAD доступно несколько вариантов отображения модели: 
каркасное представление, с показом невидимых линий, со скрытыми невидимы­
ми линиями, закрашенное с кромками и закрашенное. Чтобы выбрать вариант 
отображения, используются команды подменю View ► Visual Styles (Вид ► Стиль 
визуализации) или кнопки соответствующей панели (рис. 10.20).
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Рис. 10.20. Панель стилей визуализации
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Рис. 10.21. Окно менеджера стилей визуализации

Вот список доступных стилей визуализации:
О Двухмерное каркасное представление (2D Wireframe) — отображаются все кромки 

модели. Растровые объекты, объекты OLE, типы линий и значения толщины 
линий видимы.

О Трехмерное каркасное представление (3D Wireframe) — отображаются все кромки 
модели.

О Невидимые линии скрыты (3D Hidden) — все кромки модели, которые невозмож­
но увидеть под выбранным углом, не отображаются.

О Реалистичное представление (Realistic) — выводится закрашенное изображение 
модели со сглаженными краями между гранями. Отображаются материалы, 
назначенные объектам.



О Закрашенное представление (Conceptual) — выводится закрашенное изображение 
модели. Переход между холодными и теплыми цветами выглядит как переход 
между темным и светлым. Эффект менее реалистичен, но он может сделать 
детали объекта более различимыми.

Последняя кнопка служит для вызова менеджера стилей визуализации (Manager 
Visual Styles), окно которого показано на рис. 10.21.



7 ^ 4  г п а р а  Основы моделирования 
Щ ) ГЛАВА в системе AutoCAD

Система AutoCAD позволяет создавать как простейшие примитивы, так и сложные 
поверхности, твердые тела. Базовые типы пространственных моделей, используе­
мых в CAD-системах, можно условно разделить на три группы:
О каркасные модели;
О поверхностные модели;
О твердотельные модели.
Каркасная модель — это совокупность двухмерных примитивов в трехмерном про­
странстве, определяющих ребра фигуры. Каркасная модель полностью описывает 
размеры объекта во всех трех измерениях. Поверхности объекта (грани) не опреде­
лены! Каркасное моделирование удобно применять для объектов с плоскими или 
простыми криволинейными поверхностями в качестве этапа вспомогательных 
построений для трехмерного проектирования более высокого уровня.
Поверхностная модель — это совокупность поверхностей, ограничивающих и опре­
деляющих трехмерный объект в пространстве. В AutoCAD поверхность строится 
путем определения ее ребер. В качестве основы для создания поверхности часто 
используется каркасная модель. Моделирование поверхностей применяется для 
детальной отработки внешней формы изделия. Поверхностная модель непригодна 
для решения таких задач, как определение инерционно-массовых характеристик 
изделия или получение необходимых изображений для оформления чертежей. 
Область применения данного вида моделирования — дизайн, решение задач ком­
поновки сложных изделий и т. п.
Твердотельное моделирование является основным видом трехмерного проектирова­
ния изделий машиностроения. Создаваемые тела воспринимаются системой как не­
кие единые объекты, имеющие определенный объем. Твердотельное моделирование 
позволяет не только эффективно решать компоновочные задачи, но и определять 
инерционно-массовые характеристики, а также получать с пространственного объ­
екта необходимые виды, разрезы и сечения для оформления рабочей документации.



К сожалению, система AutoCAD во многом проигрывает в удобстве трехмерного 
моделирования другим системам, рассматриваемым в данной книге. Например, 
в AutoCAD отсутствует дерево построения, в связи с чем возникают сложности при 
построении и редактировании моделей; менее удобно задавать положение двух­
мерных примитивов относительно существующих элементов для последующих 
трехмерных операций и пр.

11.1. Общие принципы твердотельного 
моделирования деталей

В общем случае порядок создания модели корпусной детали включает в себя фор­
мирование основания, создание дополнительных элементов, применение булевых 
операций для приклеивания или вырезания дополнительных элементов, построе­
ние зеркальной копии, создание дополнительных конструктивных элементов. На­
пример, вот как выглядит процедура создания кронштейна:
1. Формирование основания (рис. 11.1, а).
2. Создание дополнительных конструктивных элементов (рис. 11.1,6).
3. Создание дополнительного элемента (рис. 11.1, в).
4. Вычитание элемента для получения отверстия (рис. 11.1, г).
5. Создание дополнительного элемента (рис. 11.1, д).
6. Вычитание элемента для получения выреза (рис. 11.1, в).
7. Зеркальное отражение объекта (рис. 11.1, ж).
8. Еще одно зеркальное отражение объекта (рис. 11.1, з).
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11.2. Основные операции 
3D-моделирования

В системе AutoCAD определены следующие базовые операции создания твер­
дых тел:
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Polysolid — построение стенки как твердого тела;

Box — построение параллелепипеда;

Wedge — построение клина, основание которого всегда параллельно плоскости 
XY текущей пользовательской системы координат;

Cone — построение прямого кругового или эллиптического конуса;

Sphere — построение сферы;

Cylinder — построение кругового или эллиптического цилиндра;

Torus — построение тора;

Pyramid — построение пирамиды;

Extrude — выдавливание двухмерных примитивов вдоль оси Z или по пути, 
заданному некой линией, при этом в случае замкнутого контура создается 
твердое тело, в случае разомкнутого — поверхность;

Presspull — выдавливание замкнутых двухмерных областей;

Sweep — построение объекта путем перемещения эскиза вдоль траектории, при 
этом в случае замкнутого контура создается твердое тело, в случае разомкну­
того — поверхность;

Revolve — построение объекта путем вращения одного или нескольких эскиз­
ных контуров вокруг оси;

Loft — построение объекта с поверхностью, переходной между несколькими 
контурами, расположенными на разных рабочих плоскостях.

В отличие от остальных CAD-систем, в AutoCAD нет понятия эскиза, на основе 
которого образуется объемное тело.
Трехмерный объект строится из простейших трехмерных геометрических при­
митивов (параллелепипед, цилиндр, конус, шар...) с последующим применением 
булевых операций объединения, вычитания, пересечения. Также есть возможность 
использовать поверхностное моделирование для создания более сложных по кон­
фигурации поверхностей. И наконец, можно создать некий контур и применить



к нему одну из четырех формообразующих операций (рис. 11.2). Контур должен 
быть либо замкнутым и построенным с помощью команды Рііпе (Полилиния), 
либо объединенным с помощью команды Region (Область), в противном случае 
создается оболочка.
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Рис. 11.2. Основные формообразующие операции создания трехмерных объектов: а  —выдавли­
вание; 6  —  вращение; в  — кинематическая операция; г  — операция по сечениям

Построение трехмерной модели детали начинается с анализа ее конструкции. 
Необходимо внимательно осмотреть деталь, уяснить ее назначение, технологию 
изготовления, определить название.
При изучении конструкции тщательно анализируется форма детали путем мыс­
ленного расчленения ее на простейшие геометрические тела (параллелепипеды, 
призмы, цилиндры, конусы, торы, кинематические элементы и т. д.) или их части, 
отдельно рассматриваются наружные и внутренние поверхности. Следует иметь 
в виду, что любая деталь представляет собой различные сочетания простейших 
геометрических форм. При этом мелкие конструктивные элементы (фаски, скру- 
гления, проточки и т. п.) из рассмотрения на первом этапе исключаются.
После этого приступают к созданию модели основного формообразующего элемен­
та детали. При построении можно использовать любую из четырех перечисленных 
формообразующих операций и дополнительно применять булевы операции.



11.3. Система координат и плоскости 
проекций

AutoCAD поддерживает два вида систем координат: мировую систему координат 
WCS (МСК) и пользовательскую систему координат UCS (ПСК). Мировая систе­
ма координат существует всегда, ее невозможно удалить и изменить. Пользователь 
может создать и сохранить несколько пользовательских систем координат, позво­
ляющих упростить конструирование модели. Активной может быть только одна 
система координат. В программе AutoCAD МСК имеет ориентацию, при которой 
плоскость XOY горизонтальна, а координата Z соответствует высоте. Пользователь 
создает ПСК и согласует ее плоскость XOY с поверхностью объекта.
Часто на практике проще только задавать координаты X и Y относительно за­
данной плоскость объекта, чем вычислять значения X, Y, Z в мировой системе 
координат.
Изображение системы координат появляется в левом нижнем углу графической 
области; построение плоских объектов с различной ориентацией в пространстве 
достигается выбором на панели View (Вид) разных проекционных видов из шести 
основных: спереди, сзади, слева, справа, сверху, снизу После этого система ко­
ординат (плоскость XOY) становится параллельной выбранной плоскости про­
екций.
При построении как двухмерных, так и трехмерных объектов приходится активно 
пользоваться параметрами команды создания пользовательской системы коорди­
нат для переноса начала координат в какую-либо точку Origin или изменения 
направлений осей системы координат (рис. 11.3).
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Рис. 11.3. Панель параметров команды создания пользовательской системы координат

В системе AutoCAD чаще всего используют декартову или полярную систему 
координат (есть еще сферическая и цилиндрическая), причем координаты могут 
быть абсолютными и относительными.
В декартовой системе координат вводятся значения по осям X, Y, Z, разделенные за­
пятыми без пробелов, например, 0.0,0 — точка, совпадающая с началом координат. 
В полярной системе координат вводят длину и угол наклона, разделенные знаком 
меньше, например, 20<45 — это длина 20 от начала координат, а угол наклона от оси 
X составляет 45°

ПРИМЕЧАНИЕ Если построение идет в плоскости X0Y,to координату по оси Z можно опустить.
Дробная часть отделяется от целой точкой. По умолчанию углы в AutoCAD от­
считываются от горизонтали с положительным направлением против часовой 
стрелки.



Абсолютные координаты измеряются от начала координат МСК, относительные — 
от последней (предыдущей) точки.
Относительные координаты начинаются со знака @. Например, декартовы коор­
динаты точки, расположенной на расстоянии 7,2 мм по оси X и 23,4 мм по оси Y 
от предыдущей точки, запишутся так: @7.2,23.4. Координаты точки, удаленной от 
предыдущей на 55,5 мм и расположенной под углом 35° относительно оси X, за­
пишутся так: @55. 5<35.

11.4. Особенности трехмерного 
моделирования деталей

К сожалению, в системе AutoCAD нет дерева построения, в котором прописывают­
ся все операции, производимые с моделью, в результате нет возможности вернуться 
и отредактировать предыдущие действия, не отменив последующие.
Можно отменить действия командой Undo и вернуться к моменту работы, пред­
шествующему неверному шагу, а затем заново выполнить отмененные действия. 
Однако при этом может пропасть и полезная часть работы.
Основной способ редактирования модели — применение команд редактирования, 
собранных в подменю Modify ► Solid Editing (Модификация ► Редактирование тел) 
и на соответствующей инструментальной панели (рис. 11.4).
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Рис. 11.4. Панель команд редактирования тел

11.5. Выбор ориентации модели детали
При выполнении чертежа детали необходимо правильно выбрать главное изобра­
жение. Согласно ГОСТ 2.305-68, в качестве главного принимается изображение на 
фронтальной плоскости проекций. Предмет располагают относительно фронталь­
ной плоскости проекций так, чтобы изображение на ней давало наиболее полное 
представление о форме, размерах и функциональном назначении предмета.
При создании трехмерной модели необходимо осознанно выбрать плоскость по­
строения эскиза. В отличии от других CAD-систем, в AutoCAD главное изображе­
ние всегда начинают строить в текущем виде спереди.



11.6. Создание ассоциативных видов
Трехмерные модели деталей создаются не столько для наглядной визуализации, 
сколько с целью получения конструкторской документации, в том числе чертежей 
деталей.
В системе AutoCAD имеется возможность создания ассоциативных чертежей трех­
мерных деталей. В таких чертежах все виды связаны с моделью так, что изменения 
в модели приводят к изменению изображения в каждом ассоциативном виде (до
использования команды окончательного формирования чертежа — Soldraw [С^). 

Ассоциативное изображение формируется на вкладке Layout (Лист) с использова­
нием команды Solview . Команда создает видовые экраны пространства листа,
направление взгляда для каждого вида, а также слои. В зависимости от выбранного 
параметра команды, на листе строятся указанные пользователем ассоциативные 
виды, разрезы (сечения) трехмерной детали. Виды автоматически располагаются 
в проекционной связи.
В системе AutoCAD доступны следующие параметры команды Solview, предна­
значенные для создания ассоциативных изображений:
О Ucs — создание вида, представляющего собой проекцию модели на плоскость 

XOY ПСК;
О Ortho — создание ортогональной проекции на основе имеющегося вида путем 

проецирования модели в направлении, перпендикулярном выбранной пользо­
вателем границы видового экрана;

О Auxiliary — создание дополнительного вида путем проецирования модели на 
плоскость, расположенную под углом к координатным плоскостям ПСК;

О Section — создание разреза или сечения.



____ Создание моделей 
глава и ассоциативных 

чертежей деталей

В этой главе описаны этапы создания в системе Autodesk Inventor ЗБ-моделей 
деталей, упомянутых во введении к этой книге, и ассоциативного чертежа для 
одной из моделей.

12.1. Изолятор
В этом разделе мы создадим трехмерную модель изолятора, показанную на 
рис. 12.1.

Рис. 12.1. Модель изолятора



1. Установите вид сверху, выбрав команду 
View ► 3D Views ► Тор или щелкнув на кнопке
Top |fCp| в пиктографическом меню.
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2. Используя команду Draw ► Circle ► Center, Ra­
dius ( 7 ) , постройте окружность с коорди­
натами центра 0,0 и радиусом 60 мм. Затем 
постройте еще одну окружность с коорди­
натами центра 0,35 и радиусом 10 мм.
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3. Зеркально отразите внутреннюю окруж­
ность. Для этого выберите команду Modi­
fy ► Mirror или щелкните на кнопке ^  .
Выделите окружность, выйдите из режима 
выбора (щелчком правой кнопки мыши), 
в качестве положения оси зеркального от­
ражения укажите начало координат и гори­
зонтальный трек (при включенном режиме 
Object Snap Tracking). Подтвердите необходи­
мость построения нового объекта без удале­
ния копируемого.



4. Для удобства установите аксонометри­
ческий вид, щелкнув на кнопке View ► 3D
Views ► SW Isometric ^  , и выберите коман­
ду Presspull . Щелкните левой кнопкой
мыши внутри большей окружности и за­
дайте величину выдавливания 30 мм. Уста­
новите тонированный режим отображения 
командой View ► Visual Styles ► Conceptual.

5. Установите текущим вид слева, щелкнув 
на кнопке Left Командой Draw ► Mo­
deling ► Box создайте параллелепипед 
с координатами начальной точки -20,15, 
второй точки -@40,20 (относительные 
координаты) и длиной 140 мм. Создайте 
две копии, вызвав команду Modify ► Сору

. Выделите параллелепипед, выйдите
щелчком правой кнопкой мыши из режи­
ма выбора, укажите базовую точку — ле­
вый нижний угол и переместите его вправо 
по горизонтали на 55 мм и влево также на 
55 мм.

6. Установите текущим вид сверху. Переме­
стите все три параллелепипеда так, чтобы 
они перекрывали цилиндр. Для этого выде­
лите параллелепипеды, выберите команду
Move , укажите базовую точку, напри­
мер левый нижний угол нижнего паралле­
лепипеда, и переместите его до положения, 
показанного на рисунке. В завершение ко­
мандой Modify ► Solid Editing ► Subtract вы­
полните вычитание из цилиндра всех трех 
параллелепипедов.

В итоге мы должны получить требуемую модель (см. рис. 12.1).



12.2. Вкладыш
В этом разделе мы создадим трехмерную модель вкладыша, показанную на 
рис. 12.2.
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Рис. 12.2. Модель вкладыша

1. Установите вид сверху, выбрав команду 
View ► 3D Views ► Тор или щелкнув на кнопке
Top (jjp| в пиктографическом меню. С по­
мощью команды Draw ► Circle ► Center, Radius 
постройте две окружности с координата­
ми положения центра 0,0 и радиусами 40 
и 15 мм.

2. Выберите на панели инструментов Mode­
ling команду PresspuLL j , щелкните левой
кнопкой мыши между двумя окружностями 
и задайте величину выдавливания 10 мм. о

3. Установите вид сверху, выбрав команду 
View ► 3D Views ► Тор, и постройте две окруж­
ности с координатами центра 0,0 и радиу­
сами 40 и 30 мм. Затем постройте еще две 
окружности с координатами центра 0,25 и 
0,-25 и радиусом 10 мм.

4. Выберите команду Modify ►Trim -/— , выде­
лите построенные окружности, выйдите из 
режима выбора, щелкнув правой кнопкой 
мыши, и укажите фрагменты окружностей, 
которые необходимо обрезать (удалить), 
чтобы получить контур, представленный 
на рисунке.



5. Установите аксонометрический вид коман­
дой View ► 3D Views ► SW Isometric

6. Выберите команду Draw ► Region [(¾, вы­
делите 4 дуги и окружность, после чего вы­
йдите из режима выбора, щелкнув правой 
кнопкой мыши.

7. Выберите команду Draw ► Modeling ► Extrude 
j |p  , выберите построенную на предыду­
щем шаге область, состоящую из дуг 
и окружности, после чего выйдите из ре­
жима выбора, щелкнув правой кнопкой 
мыши. Если у вас плоскость XOY совпа­
дает с нижней плоскостью основания мо­
дели, то задайте величину выдавливания 
30 мм, если совпадает с верхней плоскостью 
основания — 20 мм. Завершите выполнение 
команды.

•
8. Выберите команду Modify ► Solid Editing ►

Subtract ©  , укажите сначала объект, из
которого выполняется вычитание (наруж­
ный объект), выйдите из режима выбора 
и затем укажите объект, который является 
вычитаемым (внутренний), после чего за­
вершите команду, щелкнув правой кнопкой 
мыши. Используя команду Modify ► Solid
Editing ► Union , объедините обе постро­
енные части модели. Установите режим 
отображения View ► Visual Styles ► Conceptual.

•
9. Перенесите начало координат. Для этого 

вызовите команду Tools ► New UCS ► Origin
| /  ( и с привязкой Center укажите центр
верхнего основания вырезанного цилин­
дрического отверстия. Создайте паралле­
лепипед с помощью команды Draw ► Mode-

1®!



ling ► Box. Выберите способ построения 
путем задания положения центра:
Specify first corner or [Center]: с
Задайте координату центра:
Specify center: 22.5.0
Создайте куб:
Specify corner or [Cube/Length]: с 
Задайте длину стороны:
Specify length: 10

10. Выберите команду Modify ► 3D Operations ► 
3D Mirror для создания копии параллелепи­
педа, выделите построенный куб и выйдите 
из режима выбора. Выберите плоскость YZ 
для зеркального отражения:
Specify first point of mirror 

plane (3 points) or [Object/Last 
/Zaxi s/Vi ew/XY/YZ/ZX/3poi nts]
<3points>: yz

Согласитесь с положением этой плоскости, 
проходящей через начало координат
Specify point on YZ plane <0.0.0>:

Создайте объект, не удаляя копируемый 
объект:
Delete source objects? [Yes/No] <N>: N

11. Выполните команду вычитания из моде­
ли двух параллелепипедов: Modify ► Solid 
Editing ► Subtract

г
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12. Установите вид слева, выбрав команду 

View ► 3D Views ► Left, и перенесите нача­
ло координат. Для этого вызовите коман­
ду Tools ► New UCS ► Origin и с привязкой 
Midpoint укажите среднюю точку полукру­
глого выступа.



13. Постройте параллелепипед, выбрав коман­
ду Draw ► Modeling ► Box. Задайте первый 
угол с координатами 0,0, второй — с коор­
динатами 30,-10. Длину задайте 100 мм. 
Установите вид сверху.

14. Переместите параллелепипед вдоль оси X 
на 45 мм, вызвав команду Modify ► Move. Вы­
делите параллелепипед, задайте базовую 
точку с привязкой к любой его характерной 
точке (например, вершине) и переместите 
его мышью с включенным режимом 0TRACK 
(должна появиться пунктирная линия 
вдоль оси X) на заданную величину, введен­
ную с клавиатуры. В завершение командой 
Modify ► Solid Editing ► Subtract выполните 
вычитания параллелепипеда из модели.

В итоге мы должны получить требуемую модель (см. рис. 12.2).

12.3. Радиатор игольчатый
В этом разделе мы создадим трехмерную модель игольчатого радиатора, показан­
ную на рис. 12.3.
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Рис. 12.3. Модель радиатора

1. Установите вид сверху, выбрав команду 
View ► 3D Views ► Тор или щелкнув на кнопке 
Тор Д Р | в пиктографическом меню. С по­
мощью команды Rectangle £ 3  постройте
прямоугольник с размерами 25x50 мм и 
скруглениями 3 мм (после вызова команды 
Rectangle нажмите клавишу F, потом Enter, 
введите 3, снова Enter, после чего задай­
те начальную (0,0) и конечную (@25,50)



12.3. Радиатор игольчатый 195

точки прямоугольника. Используя ко­
манду Draw ► Circle ► Center, Radius ( ? ) , по­
стройте три окружности: две диаметром 
2,7 мм и одну диаметром 4,5 мм.

2. Для удобства установите аксонометри­
ческий вид, щелкнув на кнопке View ► 3D
Views ► SW Isometric Выберите коман­
ду Presspull jg j , щелкните левой кнопкой
мыши внутри контура прямоугольни­
ка, выйдите из режима выбора, щелкнув 
правой кнопкой мыши и задайте вели­
чину выдавливания 3 мм. Установите ре­
жим отображения командой View ► Visual 
Styles ► Conceptual.

*
3. Перенесите начало координат в верхнюю 

плоскость основания, используя команду
Tools ► New UCS ► Origin , и задайте новое
положение начала координат:
Specify new origin point <0.0.0>: 0,0,3

4. Постройте окружность с координатами 
центра X = 2,5, Y = 10 и диаметром 3 мм.

5. Выберите команду Draw ► Modeling ► Extrude
( Я  , выделите окружность и выйдите из
режима выбора. Выберите параметр Taper 
angle (скос), введя букву t  в командной 
строке:
Specify height of extrusion or 

[Direction/Path/Taper angle]
<15.0000>: t

Укажите угол 1°:
Specify angle of taper 

for extrusion <1>:
Задайте величину выдавливания 15 мм:
Specify height of extrusion or 

[Direction/Path/Taper angle]
<15.0000>:



6. Для создания прямоугольного массива вы­
берите команду Modify-Array qq  . В диа­
логовом окне, щелкнув на кнопке Select 
objects, выделите построенный конус и за­
дайте количество строк (Rows) 7 и столб­
цов (Columns) 5. Укажите расстояние между 
строками и колонками в 5 мм. Для провер­
ки правильности ввода значений, вклю­
чите режим предварительного просмотра, 
щелкнув на кнопке Preview. Щелкните на 
кнопке ОК.
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7. Удалите 5 иголок в центре радиатора, как 
показано на рисунке. Используя команду
Modify ► Solid Editing ► Union @  , объеди­
ните все построенные части модели. В за­
вершение создайте фаски на всех ребрах 
отверстий (6 штук) размером 0,5x45°, ис­
пользуя команду Modify ► Chamfer.

В итоге мы должны получить требуемую модель (см. рис. 12.3).

12.4. Уголок
В этом разделе мы создадим трехмерную модель уголка, показанную на рис. 12.4.



1. Установите вид спереди, выбрав команду 
View ► 3D Views ► Front или щелкнув на кноп­
ке Front в  в пиктографическом меню.
Постройте замкнутую (с последним пара­
метром С — от слова Close) полилинию ко­
мандой Draw ► Polyline .

JM L.

2. Скруглите радиусом 5 мм внутренний угол, 
вызвав команду Modify ► Fillet /^ ] .

3. Для удобства установите аксонометри­
ческий вид, щелкнув на кнопке View ► 3D
Views ► SW Isometric Выберите коман­
ду Draw ► Modeling ► Extrude , выделите
полилинию, выйдите из режима выбора, 
щелкнув правой кнопкой мыши, и выпол­
ните выдавливание на 30 мм. Установите 
режим отображения командой View ► Visual 
Styles ► Conceptual.

4. Установите вид спереди, щелкнув на кноп­
ке »  . Командой J )  создайте замкнутую 
полилинию согласно рисунку.

5. Выберите команду Draw ► Modeling ► Extrude 
f t l , выделите полилинию, выйдите из ре­
жима выбора, щелкнув правой кнопкой 
мыши, и выполните выдавливание на 2 мм.



Зеркально отразите построенную окруж­
ность, выбрав команду Modify ► 3D Operati­
ons ► 3D Mirror. Для этого выделите ребро, 
выйдите из режима выбора, щелкнув пра­
вой кнопкой мыши, и с привязкой Midpoint 
задайте положение плоскости зеркального 
отражения тремя точками — средними точ­
ками на ребрах горизонтального и верти­
кального оснований модели. Подтвердите 
необходимость построения нового объекта 
без удаления копируемого.

7. Объедините все три элемента командой 
Modify ► Solid Editing ► Union @ .

8. Используя команду Modify ► Fillet , соз­
дайте скругления на ребрах и углах основа­
ний с радиусом 3 мм.

9. Установите вид сверху, щелкнув на кноп- 
ке jJP j. Создайте цилиндр с привязкой 
Midpoint к ребру горизонтального осно­
вания, через которое проходит плоскость 
симметрии детали и с включенным вспо­
могательным режимом 0TRACK от ребра на 
расстоянии 15 мм диаметром 4,5 мм и про­
извольной высоты, но не менее 5 мм (по­
ложим 10 мм). Установите вид спереди,
щелкнув на кнопке , сдвиньте цилиндр,
используя команду Modify ► Move, таким об­
разом, чтобы он вышел за пределы плоско­
стей горизонтального основания уголка.



10. Выберите команду Modify ► Solid Editing ►
Subtract CD , укажите сначала объект, из
которого происходит вычитание (основа­
ние уголка), выйдите из режима выбора 
и затем укажите объект, который вычита­
ется (цилиндр). Завершите выполнение 
команды, щелкнув правой кнопкой мыши.

В итоге мы должны получить требуемую модель (см. рис. 12.4).

12.5. Втулка
В этом разделе мы создадим трехмерную модель втулки, показанную на рис. 12.5.

Рис. 12.5. Модель втулки

1. Установите вид справа, выбрав команду 
View ► 3D Views ► Right или щелкнув на кноп­
ке Right Q  в пиктографическом меню. 
Используя команду Draw ► Polyline Ви̂> ,
постройте полилинию согласно рисунку. 
Будущая ось вращения должна проходить 
через начало координат.

2. Для удобства установите аксонометри­
ческий вид, щелкнув на кнопке View ► 3D
Views ► NE Isometric , затем выберите

“Ч

команду Draw ► Modeling ► Revolve (TJ и соз­
дайте тело вращения заданного профиля, 
вращая профиль вокруг оси X.



3. Установите вид спереди, щелкнув на кноп­
ке в  , и с помощью команды Draw ► Con­
struction line постройте три вертикаль­
ные (с параметром V) вспомогательные 
линии на расстоянии 0,4 мм друг от друга 
(средняя проходит через начало коорди­
нат). Затем выберите команду Draw ► Poligon 
О с параметром I (от Inscribed — опи­

санная окружность), укажите количество 
вершин 3, положение центра на средней 
вспомогательной линии. При необходи­
мости сместите треугольник по вертикали
командой Move так, чтобы его две сто­
роны проходили через точки пересечения 
крайних вспомогательных линий и окруж­
ности цилиндра (выделены на рисунке).

4. Установите аксонометрический вид, щел­
кнув на кнопке View ► 3D Views ► NE Isometric 

, и выберите команду Draw ► Modeling ► 
Extrude Выделите полилинию, вый­
дите из режима выбора, щелкнув правой 
кнопкой мыши, и выполните выдавливание 
на 10 мм. При необходимости переместите 
построенную призму на виде справа так, 
чтобы она полностью пересекала большую 
цилиндрическую поверхность. Установите 
режим отображения командой View ► Visual 
Styles ► Conceptual. Вспомогательные линии 
можно удалить.

Установите вид спереди. С помощью ко­
манды Draw ► Array § §  постройте круговой
массив элементов, полученных на предыду­
щем шаге, и в открывшемся диалоговом 
окне установите параметры согласно рисун­
ку. В завершение вычтите из тела вращения 
размноженные призмы. Для этого вызовите
команду Modify ► Solid Editing ► Subtract ©  ,
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2. Чтобы весь контур воспринимался как 
один объект, выберите команду Draw ► Bo­
undary и щелкните левой кнопкой мыши 
внутри контура.

3. Для удобства установите аксонометри­
ческий вид, щелкнув на кнопке View ► 3D
Views ► SE Isometric ^  Затем выберите
команду Draw ► Modeling ► Extrude (9̂ ! ,
выделите полилинию, выйдите из режима 
выбора, щелкнув правой кнопкой мыши, 
и выполните выдавливание на -50 мм. 
Установите режим отображения View ► 
Visual Styles ► Conceptual.

4. Установите вид спереди, после чего со­
здайте четыре дуги (две радиусом 10 мм 
и две радиусом 15 мм) и три отрезка. Затем 
выберите команду Modify ► Object ► Polyline 
и объедините построенные примитивы 
в одну полилинию. Для этого используйте 
параметр Join (объединить):
Command: _pedit Select polyline or 

[Multiple]:
Object selected is not a polyline 
Do you want to turn it into one? <Y>

Здесь подтвердите преобразование в поли­
линию.
Enter an option [Close/Join/Width/Edit 

vertex/Fit/Spline/Decurve/Ltype 
gen/Reverse/Undo]: j 

Select objects:
Здесь выделите все примитивы.
6 segments added to polyline

А теперь завершите выполнение команды.
Enter an option [Open/Join/Width/Edit 

vertex/Fit/Spli ne/Decurve/Ltype 
gen/Reverse/Undo]:

Полтвеплите выход из команды.
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выделите щелчком левой кнопки мыши 
тело вращения, выйдите из режима выбора, 
щелкнув правой кнопкой мыши, и укажите 
вычитаемые объекты. Для этого выделите 
все объекты рамкой и, нажав клавишу 
Shift, уберите из выделения тело вращения. 
Завершите выполнение команды, щелкнув 
правой кнопкой мыши. Так моделируется 
рифление на поверхности вращения.

В итоге мы должны получить требуемую модель (см. рис. 12.5).

12.6. Кронштейн
В этом разделе мы создадим трехмерную модель кронштейна, показанную на 
рис. 12.6.

Рис. 12.6. Модель кронштейна

1. Установите вид спереди, выбрав команду 
View ► 3D Views ► Front или щелкнув на кноп­
ке Front «  в пиктографическом меню, и
постройте изображение согласно рисунку.
При построении используйте привязки
Tangent (касательная) о  , Parallel (парал­
лельно) , Quadrant (квадрант) .



5. Так как окружности радиусом 15 мм сое­
диняются в одной точке с вертикальным 
сегментом, переместите с помощью марке­
ров точку их соединения немного вправо 
(как на рисунке). В противном случае из- 
за самопересечения контура нельзя будет 
применить трехмерную операцию выдав­
ливания!

6. Установите аксонометрический вид, щел­
кнув на кнопке View ► 3D Views ► SE Isometric
^  и выберите команду Draw ► Mode­

ling ► Extrude Выделите построенную
полилинию, выйдите из режима выбора, 
щелкнув правой кнопкой мыши, и выпол­
ните выдавливание на 8 мм. Установите 
режим отображения командой View ► Visual 
Styles ► Conceptual, после чего объедини­
те все элементы командой Modify ► Solid
Editing ► Union .

1
7. Установите вид справа, затем коман­

дой UCS ► Origin перенесите начало
координат в правый нижний угол моде­
ли. Создайте параллелепипед командой
Draw ► Modeling ► Box £ jj  с размерами
110x20 и глубиной 70. Установите вид спе­
реди, при необходимости переместите па­
раллелепипед вдоль оси X так, чтобы он 
пересекал всю модель. Используя команду
Modify ► Solid Editing ► Subtract ©  , вырежь­
те его из модели.

\

8. Установите вид сверху. Используя вспо­
могательные режимы Object Snap и 
Object Snap Tracking, постройте цилиндр 
(Draw ► Modeling ► Cylinder) с центром в се­
редине ножки, радиусом 5 мм и высотой не 
менее 10 мм (например, 20 мм).



9. Установив вид спереди, переместите ци­
линдр, используя команду Modify ► Move 
так, чтобы он выступал с обеих сторон 
основания.

10. Используя команду Modify ► Solid Editing ► 
Subtract CD , вырежьте из модели по­
строенный цилиндр. С помощью коман­
ды Modify ► Chamfer создайте фаску с 
катетами 5,4 и 3,1 мм. Для создания скру- 
глений вызовите команду Modify ► Fillet 

, задайте радиус 3 мм и выделите ука­
занные на рисунке ребра.

И. Создайте зеркальную копию, используя 
команду Modify ► 3D Operations ► 3D Mirror. 
Для этого выберите объект копирования 
(всю модель), выйдите из режима выбора 
и задайте плоскость зеркального отраже­
ния тремя точками, например, как показа­
но на рисунке, без удаления копируемого 
объекта:
Command: _mirror3d 
Select objects: 1 found

Выберите модель.
Select objects:

Выйдите из режима выбора.
Specify first point of mirror plane 

(3 points) or [Object/Last/Zaxis/
View/XY/YZ/ZX/3poi nts] <3poi nts>:

Укажите три точки, задающие плоскость.
Specify second point on mirror plane: 

Specify third point on mirror plane: 
Delete source objects? [Yes/No] <N>:

В завершение объедините оба объекта 
командой Modify ► Solid Editing ► Union 
и создайте зеркальную копию относитель­
но плоскости YZ, проходящей через 
точку с координатами 0,0.



12.7. Корпус
В этом разделе мы создадим трехмерную модель корпуса, показанную на рис. 12.7.

Рис. 12.7. Модель корпуса

1. Установите вид спереди, выбрав команду 
View ► 3D Views ► Front или щелкнув на кноп­
ке Front в пиктографическом меню, 
и с помощью команды Draw ► Polyline
постройте полилинию согласно рисунку 
Затем постройте вертикальный отрезок, 
проходящий через начало координат, кото­
рый будет служить осью вращения.

Ж
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2. Для удобства установите аксонометри­
ческий вид, щелкнув на кнопке View ► 3D
Views ► SE Isometric ^  , и создайте тело
вращения. Для этого выберите команду

И*—ч
Draw ► Modeling ► Revolve , выделите по­
лилинию, выйдите из режима выбора щел­
кнув правой кнопкой мыши, и укажите вер­
тикальную линию в качестве оси вращения. 
Установите режим отображения командой 
View ► Visual Styles ► Conceptual.

3. Щелкнув на кнопке Тор установите
вид сверху и создайте полилинию соглас­
но рисунку. Левая граница профиля лап­
ки произвольна (должна заходить на тело 
модели).



4. Установите аксонометрический вид, щел­
кнув на кнопке View ► 3D Views ► SE Isometric

, и выберите команду Presspull Jgj*.
Щелкните внутри построенного контура 
(вложенная окружность будет отверстием) 
и задайте величину выдавливания 10 мм.

5. Перенесите начало координат, используя 
команду Tools ► New UCS ► Origin k .  За­
дайте новое положение начала координат 
с привязкой к центру верхнего основания 
отверстия в лапке. Постройте окружность 
диаметром 11 мм.

6. Командой Extrude Ш  выполните выдав­
ливание данной окружности на величину 
-1 мм. Командой Subtract CD вычтите по­
лученный цилиндр из модели лапки. Уста­
новите вид сверху, щелкнув на кнопке Тор

Для построения кругового массива выбе­
рите команду Draw ► Array ЦЩ, выделите 
лапку и в открывшемся диалоговом окне
задайте параметры согласно рисунку. После 
построения массива, объедините все 4 эле­
мента командой Modify ► Solid Editing ► Union



8. Чтобы построить скругления, выберите 
команду Modify ► Fillet, выделите указан­
ные элементы (пересечение боковых по­
верхностей лапок с основной моделью) и 
задайте радиус 2 мм.

9. Установите вид спереди, щелкнув на 
кнопке Front , и с помощью команды 
Draw ► Modeling ► Cylinder Q  создайте ци­
линдр с размерами основания, указанны­
ми на рисунке, и длиной 65 мм.

10. Сместите цилиндр вдоль оси так, чтобы 
он полностью пересекал модель корпуса.

И. Командой Modify ► Solid Editing ► Subtract 
©  вычтите полученный цилиндр из мо­
дели детали.



12. Установите вид слева, щелкнув на кноп­
ке Left jlp  , и создайте параллелепипед 
с размерами основания, указанными на
рисунке, и длиной 35 мм. Для задания 
положения основания параллелепипеда 
удобнее воспользоваться абсолютными и 
относительными координатами (-10,17 
и @20,15).

13. Командой Modify ► Solid Editing ► Subtract 
©  вычтите полученный параллелепи­
пед из модели детали.
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В итоге мы должны получить требуемую модель (см. рис. 12.7).

12.8. Пружина
В этом разделе мы создадим трехмерную модель пружины согласно размерам, 
указанным на рис. 12.8.

1. Установите вид спереди и для построения
спирали выберите команду Helix . Па­
раметры установите следующим образом: /Т(Шл\ѴлшРCommand: _Helix
Number of turns = 3.0000 Twist=CCW

Введите координаты начальной точки
центра:



Specify center point of base: 0.0,0 
Specify base radius or [Diameter]

<1.0000>: d
Задайте диаметр цилиндра в начальной 
точке:
Specify diameter <2.0000>: 25 

Диаметр цилиндра в конечной точке такой 
же:
Specify top radius or [Diameter]

<12.5000>:
Specify helix height or [Axis 

endpoi nt/Turns/turn Height/tWi st] 
<1.0000>- t

Задайте количество витков:
Enter number of turns <3.0000>: 10 
Specify helix height or [Axis 

endpoint/Turns/turn Height/tWist] 
<1.0000>: h

Задайте расстояние между витками (шаг):
Specify distance between turns 

<0.2500>: 4

2. Установите вид сверху и постройте в любом 
месте пространства модели окружность (се­
чение пружины) диаметром 2 мм.

3. Для удобства установите аксонометри­
ческий вид, щелкнув на кнопке View ► 3D
Views ► SE Isometric и выберите коман­
ду Draw ► Modeling ► Sweep (¾)
Command: _sweep
Current wire frame density: IS0LINES=4 
Select objects to sweep: 1 found

Выделите окружность сечения:
Select objects to sweep:

Выйдите из режима выбора (щелкнув 
правой кнопкой мыши).
Select sweep path or 

[Alignment/Base point/Scale/Twist]:
Укажите спираль.



4. Выберите вид справа и с помощью коман­
ды Draw ► Modeling ► Box £ jl  постройте па­
раллелепипед так, чтобы один из углов его 
основания лежал в плоскости YOZ, высо­
той и длиной он был больше диаметра пру­
жины (больше 30), а ширину имел 15 мм.

5. Командой Сору скопируйте постро­
енный параллелепипед и, используя вспо­
могательный режим Object Snap Tracking, 
расположите его на расстоянии 35 мм от 
исходного, как показано на рисунке. Для 
этого укажите базовую точку (любую вер­
шину параллелепипеда) и сместите его по 
горизонтали на 50 мм (расстояние плюс 
ширина).

6. Установите вид спереди, переместите оба 
параллелепипеда так, чтобы они полностью 
пересекали пружину, и задайте аксономе­
трический вид, щелкнув на кнопке View ► 3D 
Views ► SE Isometric ^

7. Командой Modify ► Solid Editing ► Subtract 
CD вычтите из модели пружины оба па­
раллелепипеда, чтобы смоделировать шли­
фовку витков пружины.

12.9. Построение ассоциативного 
чертежа вкладыша

В этом разделе мы построим чертеж созданной нами ранее (см. раздел 12.2) трех­
мерной модели вкладыша.



1. Откройте файл модели вкладыша, затем 
перейдите на вкладку Layoutl, выделите 
и удалите видовое окно (щелкнув на рам­
ке окна), после чего выберите команду
Draw ► Modeling ► Setup ► View ^5].
Command: _solview

Постройте вид сверху, выбрав параметр 
построения первого вида U (от UCS):
Enter an option
CUcs/Ortho/Auxi1iary/Section]: U

В мировой системе координат — W (от 
World):
Enter an option [Named/Wor1d/?/Current] 

<Current>: W
Укажите масштаб 1:
Enter view scale <1>:

Задайте положение центра вида на листе:
Specify view center:

Specify view center <specify 
viewports

Обведите изображение рамкой видового 
окна:
Specify first corner of viewport:
Specify opposite corner of viewport:

Задайте название вида — top:
Enter view name: top

2. He завершая работу команды, задайте па­
раметр построения разреза — S (от Section):
Enter an option 

[Ucs/Ortho/Auxiliary/Section]: S
Укажите плоскость разреза в виде горизон­
тальной линии с привязкой к квадранту 
окружности:
Specify first point of cutting plane:
_qua of

Specify second point of cutting plane:
Укажите сторону взгляда для построения 
изображения (под линией разреза, как 
показано на рисунке):
Specify side to view from:



3. Согласитесь с масштабом 1:
Enter view scale <1>:

Задайте положение центра нового изобра­
жения на листе:
Specify view center:
Specify view center <specify viewports

Обведите изображение рамкой видового 
окна:
Specify first corner of viewport:
Specify opposite corner of viewport:

Задайте название представленного на ри­
сунке изображения — front:
Enter view name: front

4. Постройте вид слева. Для этого, не завер­
шая работу команды, задайте параметр 
Ortho:
Enter an option 

[Ucs/Ortho/Auxiliary/Section]: 0
Укажите левую границу видового экрана 
показанного на рисунке вида front:
Specify side of viewport to project:

Задайте положение центра нового изобра­
жения на листе:
Specify view center:
Specify view center <specify viewports

Обведите изображение рамкой видового 
окна:
Specify first corner of viewport:
Specify opposite corner of viewport:

5. Задайте название представленного на ри 
сунке изображения — 1 eft:
Enter view name: left

6. Для вставки аксонометрического изобра­
жения задайте параметр UCS:
Enter an option 

[Ucs/Ortho/Auxiliary/Section]: U



В мировой системе координат — World:
Enter an option 

[Named/World/?/Current] <Current>: W
Согласитесь с масштабом 1:
Enter view scale <1>:

Задайте положение центра вида на листе:
Specify view center:
Specify view center <specify viewports

Обведите изображение рамкой видового 
окна:
Specify first corner of viewport:
Specify opposite corner of viewport:

Задайте название вида
Enter view name: aks

Завершите работу команды.
Так как сейчас вставлено изображение 
вида сверху, выделите рамку построенного 
видового окна, щелкните на кнопке Paper 
|paper| в строке состояния, чтобы видовое 
окно перешло в режим пространства моде­
ли, и выберите команду View ► SE Isometric
^  Установите желаемый масштаб изо­

бражения командами группы Zoom. Вый­
дите из режима пространства модели, щел­
кнув на кнопке Model |model|.

7. Для окончательно формирования изо­
бражений вызовите команду Draw ► Mode­
ling ► Setup ► Drawing [С^ и укажите кур­
сором все рамки видовых окон, кроме 
аксонометрии, и завершите выполнение 
команды. Измените штриховку на изо­
бражении разреза, для чего щелкните на 
изображении разреза и войдите в режим 
пространства модели, щелкнув на кнопке 
Paper |paper|. Выделите штриховку и отредак­
тируйте ее свойства, выбрав стиль Ansi31.
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ГЛАВА
Общие сведения 
о системе T-FLEX CAD

T-FLEX CAD — это полнофункциональная система автоматизированного проекти­
рования, обладающая всеми современными средствами разработки проектов любой 
сложности. Система объединяет параметрические возможности трехмерного моде­
лирования со средствами создания и оформления конструкторской документации 
[3]. Технические новшества и хорошая производительность в сочетании с понятным 
интерфейсом делают T-FLEX CAD универсальным и эффективным средством про­
ектирования различных изделий. Возможности параметризации в T-FLEX CAD 
обеспечивают максимальную эффективность проектирования моделей различных 
исполнений и типоразмеров.

13.1. Основные элементы интерфейса
После запуска системы на экране монитора появляется стартовое окно, которое по­
зволяет либо создать новый документ, либо продолжить работу с предыдущим. На 
рис. 13.1 представлен фрагмент стартового окна с вкладкой приветствия, которое 
появляется при первом запуске системы.

30 Модель Чертёж

Рис. 13.1. Фрагмент стартового окна



В процессе создания документа рабочее окно системы T-FLEX CAD меняется, 
объединяя различные служебные окна и элементы управления, необходимые для 
функционирования системы (рис. 13.2).
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Рис. 13.2. Рабочее окно

Вызов команды в T-FLEX CAD можно осуществить несколькими способами: вы­
брать в текстовом меню или на панели инструментов, ввести имя команды в строке 
состояния. Некоторые команды можно также вызывать с помощью функциональ­
ных клавиш.
Для управления системой используются окна и поля диалога различных типов. 
Управление окнами и полями диалога осуществляется с помощью команд подменю 
Настройка ► Окна и Настройка ► Настройка ► Панели либо при помощи контекстного 
меню, появляющегося при щелчке правой кнопки мыши вне окна текущего чер­
тежа.
Изображение выводится в окно текущего чертежа. Данное окно может содержать 
окна двумерного и трехмерного видов либо одно из них.
Текстовое меню содержит все команды системы и разделено на следующие группы: 
О Файл — команды для работы с чертежами и библиотеками чертежей;
О Правка — команды редактирования элементов системы;
О Построения — команды для создания вспомогательных элементов построения; 
О Чертеж — команды для создания элементов изображения;



О Операции — команды операций с трехмерной моделью чертежа;
О Оформление — модуль оформления чертежа;
О Параметры — команды для работы с параметрической моделью чертежа;
О Сервис — команды конфигурирования системы и установки параметров чертежа; 
О Настройка — команды настройки системы;
О Вид — команды перемещения по чертежу и конфигурирования экрана системы; 
О Окно — команды для работы в многооконном режиме;
О ? — команды получения справочной информации по системе и командам.
Не все команды меню могут быть доступны. Если подвести курсор к какой-либо 
группе и нажать указателем на кнопку, то появится выпадающее меню с инфор­
мацией о данной группе команд. Доступные в данный момент команды выглядят 
более контрастными.

13.2. Окна и элементы управления
Расположение инструментальных панелей задается в системе по умолчанию и, как 
правило, не требует перемещения. Непосредственно под текстовым меню рас­
положена стандартная инструментальная панель, содержащая пиктографические 
кнопки для вызова основных команд системы (рис. 13.3).

<Г' / '  О O ' *• У  А Ш Л* "О Я “ 'АН S O  ©
Рис. 13.3. Стандартная панель

При наведении курсора на какую-либо кнопку в строке состояния появляется на­
звание команды, вызываемой при щелчке на этой кнопке.
Инструментальные панели Главная и Вид содержат некоторые «вложенные» пик­
тографические меню. При этом на инструментальной панели по умолчанию ото­
бражается только одна кнопка, справа от которой расположена кнопка доступа jvj
к остальным кнопкам пиктографического меню. Кнопки пиктографического меню 
можно разместить и непосредственно на инструментальной панели, для этого до­
статочно щелкнуть на кнопке, расположенной в правом конце панели J
Восстановить начальные установки можно с помощью одноименной команды под­
меню Настройка ► Окружение.
В системе имеется несколько инструментальных панелей. Управление ими осу­
ществляется с помощью команды Настройка ► Настойка. После выбора этой команды 
на экране появляется диалоговое окно Настройка, содержащее ряд вкладок, детали­
зирующих настройку системы (рис. 13.4).
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Рис. 13.4. Меню настройки

Для установки требуемых команд необходимо перейти на вкладку Команды, вы­
брать нужную команду и перетащить ее мышью на соответствующую панель. Под­
ключать наиболее часто используемые панели можно также при помощи команд 
контекстного меню Панели. Это меню появляется при щелчке правой кнопкой 
мыши вне рабочего окна чертежа.
Панели могут быть плавающими или располагаться вдоль одной из границ главного 
окна системы. В плавающем состоянии панель имеет заголовок с названием.
Непосредственно под инструментальными панелями находится системная панель, 
объединяющая несколько элементов управления (рис. 13.5). Системная панель 
может присутствовать или отсутствовать на экране. Отметим, что наличие на 
панели тех или иных элементов управления зависит от текущей выбранной ко­
манды.

[5 1 Вид спереди -  И Р о :  ( о  X Щ І Н Н  S  Ч і  O S P P

Рис. 13.5. Системная панель

Ниже перечислены элементы управления системной панели.
О В раскрывающемся списке имен слоев перечислены слои, заданные в системе. 

Выбор имени слоя в списке возможен в командах ввода и редактирования эле­
ментов системы.

О Поле уровня отражает уровень элементов построения и изображения системы. 
Изменение уровня, которое доступно в командах создания и изменения эле­
ментов системы, происходит непосредственным вводом значения в поле или 
щелчками на кнопках счетчика. Уровень может быть задан переменной.

О Поле приоритета отражает приоритет элементов изображения системы. Измене­
ние приоритета доступно в командах создания и изменения элементов системы. 

О Палитры типов линий изображения присутствуют на панели при прорисовке 
или редактировании линий. На системной панели их четыре. Первая и третья



палитры содержат варианты начала и окончания линий изображения, вторая — 
стили линий. Четвертая палитра предназначена для выбора наиболее часто ис­
пользуемых стилей линий изображения.

О  Палитра материалов отражает список доступных материалов модели, выбирая 
пункты этого списка, можно изменять назначенный материал.

При работе в окне ЗБ-вида на системной панели находятся кнопки выбора 
ЗЭ-элементов (несколько таких кнопок видны на рис. 13.5). При работе в окне 
2Э-вида набор кнопок в этой части панели меняется. Управление доступом к дан­
ным группам кнопок производится с помощью команды Правка ► Селектор или
кн о п к и  Селектор ѳ на системной панели. После вызова команды на экране по­
является диалоговое меню настройки селектора (рис. 13.6). Основное поле данного 
окна содержит список всех элементов системы.

Разрешён выбор элементов:_______________________

■[у]Векторы привязки I > I і + j
5¾ Узлы 1

іГ'] Линии изображения ■ ~ і

[ g j  Линии построения ; + / -~!
; Гу] Размеры 1----- J
3] Тексты 
^Штриховки 
Гу Допуски 
IjVj Фрагменты 
[vj Шероховатости

[П Сохранить как конфигурацию: 1

Количество элементов в списке ближайших: ю 

Список ближайших элементов в виде: Контекстного меню ▼

j OK {  ̂ Отменить

Рис. 13.6. Меню настройки селектора

Выбор требуемых элементов или их исключение производится установкой или 
сбросом соответствующего флажка. Щелчок на кнопке ОК приводит к сохране­
нию заданных параметров и завершению выполнения команды. В дальнейшем 
можно быстро настроить селектор в соответствии с сохраненной конфигурацией.
Это делается с помощью кнопки Выбор конфигурации селектора на системной
панели. При щелчке на ней раскрывается список, содержащий все имеющиеся 
конфигурации селектора.
При создании (редактировании) текста становится доступным соответствующий 
набор кнопок форматирования. При создании (редактировании) штриховки ста­
новится доступным ряд полей, позволяющих задать параметры.
При активном режиме ЗО-построений активизируется панель, кнопки которой 
позволяют управлять пространственной ориентацией модели (рис. 13.7).



Рис. 13.7. Панельтрехмерных построений

По умолчанию в системе открыто 3D -ok ho с  изображением трех рабочих плоско­
стей, отображающих виды спереди, слева и сверху. Каждая из плоскостей имеет 
соответствующую подпись и подсвечивается при наведении на нее курсора.
Первые две кнопки управляют представлением модели: параллельным или пер­
спективным. Следующая группа кнопок позволяет устанавливать отдельные про- 
екционные виды. Окрашенная сторона изображенного на пиктограммах кубика 
соответствует требуемому виду. Последние две кнопки служат для аксонометри­
ческого представления модели (спереди и сзади).
Строка состояния, содержащая текущую оперативную информацию, расположена 
в нижней части экрана и содержит поля вывода названия текущей команды, под­
сказки для пользователя, координат курсора и параметров линий.
Автоматическое меню (автоменю) расположено слева от окна текущего чертежа. 
При незагруженной команде автоменю остается пустым. При загруженной команде 
в автоменю выводятся кнопки, соответствующие доступным действиям пользова­
теля в текущий момент работы с командой. Подключение автоменю производится 
вызовом команды: Настройка ► Окна ► Автоменю. При работе с автоменю возможно 
два варианта получения результата. Первый — результат проявляется непосред­
ственно после щелчка на кнопке. Второй — при щелчке на кнопке рядом с курсором 
появляется символ, соответствующий выбранной кнопке. Для получения результа­
та необходимо подвести курсор к нужному месту изображения и щелкнуть левой
кнопкой мыши. Например, при щелчке на кнопке Прямая

появляется «картинка» в виде линии со стрелкой уr j >

рядом с курсором

Окно свойств используется в большинстве команд создания элементов чертежа, 
ЗЭ-построений и задания параметров создаваемого или редактируемого объекта. 
По умолчанию в левой части экрана расположено окно, объединяющее системные 
окна Свойства, Меню документов и Дерево 3D модели. Переключение между окнами 
осуществляется при помощи вкладок. При необходимости любое окно можно 
расположить в произвольном месте экрана, а команда контекстного меню Спрятать 
позволяет его скрыть.
Еще один пункт контекстного меню окна свойств — Показывать автоматически. Уста­
навливать этот флажок имеет смысл, если окно свойств будет спрятано. Тогда при 
вызове команды или обращении к окну параметров какого-нибудь элемента окно 
будет появляться на экране, а при выходе — исчезать.
Управлять видимостью окна можно с помощью команды текстового меню

на стандартной панели либоНастройка ► Окна ► Свойства или кнопки Свойства

при помощи команды Свойства контекстного меню. Это меню появляется при щелч­
ке правой кнопкой мыши вне рабочего окна чертежа.



Служебные окна системы (свойств, ЗО-модели, документов, общего вида, макро­
сов, диагностики и другие) можно расположить в окне программы по усмотрению 
пользователя. Неиспользуемые служебные окна можно отключить.
Для вывода служебных окон используют меню Настройка ► Окна. То же диалоговое 
окно можно вызвать щелчком правой кнопки мыши в области автоменю или любой 
другой инструментальной панели.

13.3. Команды перемещения по чертежу
Для перемещения или изменения размера изображения чертежа внутри рабо­
чего окна чертежа служит команда Задать рабочее окно. Вызывается команда
Вид ► Масштаб ► Рамка из меню или с помощью кнопки Рамка , расположенной
на панели Вид. При вызове данной команды в автоменю появляется группа кнопок, 
позволяющая производить действия как с текущим окном, так и с самим изобра­
жением. Часть этих кнопок дублируется соответствующими командами системы. 
По умолчанию инструментальная панель Вид находится справа от окна текущего 
чертежа.
Получить увеличенное изображение фрагмента чертежа можно, заключив его с по­
мощью мыши в произвольную прямоугольную рамку.
Установить параметры работы с окном можно, щелкнув в автоменю на кнопке За- 

После этого на экране появляется меню параметров, в которомPSдать параметры

задается процентное соотношение сдвига рабочего окна вправо/влево, вверх/вниз 
и определяется процентное соотношение увеличения или уменьшения рабочего 
окна.
Расположенные в автоменю кнопки с пиктограммами стрелок определяют на­
правления перемещения окна. Шаговое изменение размеров окна производится
с помощью кнопок Увеличение □ и Уменьшение п . Плавное перемещение по
чертежу может осуществляться с помощью полос прокрутки, подключение которых 
производится командой Окно ► Полосы прокрутки.

Команда Задать абсолютные координаты окна 

в диалоговом окне. Установить границы рабочего окна по максимальным габаритам 
изображения позволяет команда Максимизировать

служит для перерисовки рабочего окна в соответствии с размером формата<щ

u t  задает координаты рабочего окна 
максимальным габаритам 
Команда Все изображение

а  позволяет перейти в предыдущее рабочее окно.чертежа. Команда Предыдущее

При ее вызове чертеж перерисовывается в соответствии с размером предыдущего 
рабочего окна.
Перемещение по чертежу может осуществляться путем выделения соответствую­
щей области чертежа в окне общего вида. Окно общего вида предназначено для



13.4. Дерево модели
Структура ЗБ-модели представлена в виде дерева в окне 3D модель и наглядно 
отражает связи между ЗБ-элементами и операциями, выполняемыми в модели 
(рис. 13.9). Для открытия данного окна необходимо щелкнуть правой кнопкой 
мыши вне окна текущего чертежа и в появившемся контекстном меню выбрать 
соответствующую команду. Это окно появляется в левой части экрана (в области 
служебных окон).
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Рис. 13.9. Дерево модели

Каждому элементу модели по умолчанию присваивается имя, состоящее из назва­
ния типа элемента и номера. Имя элемента может быть изменено.
Первым идет пункт 3D построения, содержащий вспомогательные ЗВ-элементы и их 
родительские операции и элементы. Следующий пункт, Операции, содержит список 
ЗВ-операций, сгруппированных по типу (на рисунке это операции Вращение, Вы­
талкивание и т. д.). Далее следует само дерево ЗВ-модели.
В корне дерева модели размещаются тела. В зависимости от геометрии тела (твер­
дотельный или листовой объект) в дереве модели отражается соответствующая ему 
пиктограмма. Каждому телу модели по умолчанию присваивается имя, состоящее 
из слова «Тело» и номера, например, Тело_0. Любому телу можно назначить произ­
вольное персональное имя. Слева от пиктограммы тела расположен специальный 
значок, с помощью которого можно просмотреть историю создания данного тела. 
Для этого необходимо щелкнуть на нем левой кнопкой мыши. История состоит из 
последовательности операций, представленной в виде списка. Каждому элементу 
модели, указанному в истории, также присваивается по умолчанию уникальное 
имя, которое может быть изменено по усмотрению пользователя.
В дереве модели иногда очень удобно выбирать объекты при работе со многими 
командами, когда выбор этих объектов в ЗВ-окне затруднен.
Щелкнув на элементе дерева модели правой кнопкой мыши, можно вызвать кон­
текстное меню. Помимо обычных команд для работы с выбранным элементом, 
контекстное меню содержит несколько дополнительных команд, предназначенных 
для работы с конкретными телами, операциями и деревом модели в целом.



На рис. 13.10 представлен пример контекстного меню одного из объектов, входя­
щих в модель, дерево которой изображено на рис. 13.9. Часть пунктов этого меню 
являются командами, другие представляют собой подменю, открывающие доступ 
к дополнительным командам.

С ) Вращения: 1 
Выталкивания ■ 2

+ і р

т 0

Рис. 13.10. Контекстное меню объекта Тело_0

В некоторых случаях операции можно перетаскивать по дереву модели мышью, 
меняя тем самым структуру самой модели.
При работе с деревом модели можно выполнять булевы операции. Если выделить 
некоторое тело в дереве и начать его перемещение, то рядом с курсором появится 
пиктограмма булевой операции сложения. Если при перемещении нажать клавишу 
Ctrl или Shift, вид пиктограммы булевой операции меняется, отражая вычитание 
или пересечение соответственно. Вместо самих тел можно выбирать последние 
в их истории операции.
При удалении из дерева модели элемента, связанного с другими элементами или 
операциями, появляется диалоговое окно удаления элементов, в котором предлага­
ются различные схемы выполнения операции. В зависимости от ответа удаляются 
выбранный объект и все связанные с ним объекты либо система пытается оставить 
в модели элементы, созданные на основе удаляемого, переназначив ссылки.

13.5. Построение чертежа в системе 
T-FLEX CAD

Основной режим работы системы — режим создания параметрического чертежа. 
Используя возможности параметрического проектирования, можно создать чертеж, 
который будет легко изменяться в зависимости от предъявляемых к нему требова­
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ний. Этот чертеж можно также задействовать в качестве элемента параметрической 
библиотеки для создания других, более сложных, чертежей.
В непараметрическом режиме чертеж строится аналогично большинству извест­
ных систем, то есть сразу наносятся линии изображения. В этом случае задание 
параметрических связей между линиями чертежа невозможно.
При создании чертежа система использует несколько типов элементов:
О Элементы построения. Эти элементы формируют каркас чертежа. К элементам 

построения относятся линии построения и узлы. Линии построения и узлы — 
это основные элементы, формирующие параметрическую модель чертежа. 
По аналогии с черчением их можно сравнить с тонкими вспомогательными 
карандашными линиями. Путем задания различных типов линий построения 
и узлов устанавливается взаимосвязь элементов построения и определяется 
порядок расчета их положения при параметрическом изменении чертежа. Они 
присутствуют только на экране и не выводятся при печати.

О Элементы изображения. К элементам изображения относятся линии изобра­
жения, размеры, тексты, штриховки, допуски формы и расположения поверх­
ностей, надписи, шероховатости. Они могут «привязываться» к элементам по­
строения. В этом случае при изменении положения линий построения и узлов 
элементы изображения меняют свое положение, что и является основной идеей 
параметризации. Эти элементы составляют изображение чертежа при выводе 
на печать.

К сложным элементам изображения относятся фрагменты и картинки. Фрагмен­
ты — это изображения части чертежа, которые могут использоваться в других 
чертежах для получения сборочных чертежей. Под параметрическим фрагментом 
понимается изображение, позволяющее при вставке в другой чертеж задать по­
ложение и параметры, от которых зависит его вид. Картинки — это графические 
изображения чертежей системы T-FLEX CAD и других систем, сохраненные 
в различных форматах. Картинки, как и фрагменты, можно использовать в других 
чертежах. При этом вид картинок будет неизменным, можно лишь задавать их по­
ложение и масштаб.
К вспомогательным элементам относятся переменные, базы данных, отчеты, а так­
же некоторые другие служебные данные.
Для построения параметрического чертежа вызывается команда Файл ► Новый чер­

теж. Этой команде соответствует кнопка Новый чертеж на инструментальной
панели. В результате откроется новое окно и создастся новый чертеж без имени. 
Создание чертежа начинается с задания элементов построения. Для этого, напри­
мер, можно вызвать команду Построения ► Прямая или щелкнуть на кнопке Прямая

на инструментальной панели. Элементы построения могут создаваться раз­
личными способами. Сначала можно задать базовые линии построения, от которых 
в дальнейшем выстраиваются новые линии построения. Далее строятся прямые или 
окружности, зависимые от базовых, например, параллельные прямые, окружности



касательные к прямым. Тем самым определяется способ построения новых линий, 
который запоминается в системе. На пересечении построенных прямых создаются 
узлы, которые требуются для дальнейших построений. Затем строятся прямые 
и окружности, которые могут задаваться различными способами относительно 
построенных ранее.
Линии построения могут иметь числовой параметр (расстояние от параллельной 
прямой, угол, радиус окружности и т. д.). Значение параметра задается во время 
создания элемента построения. Некоторые из конструктивных элементов могут 
не иметь параметра, например прямая, проходящая через два узла. В качестве 
параметра элемента построения может использоваться переменная. Значение 
переменной может быть задано константой или выражением. В выражении могут 
присутствовать другие переменные, различные арифметические и логические опе­
рации, условные операции, обращения к стандартным математическим функциям, 
а также обращения к внешним базам данных. Элементы построения на чертеже 
отображаются пунктирными линиями.
Дальнейшая прорисовка элементов чертежа производится линиями изображения,
для чего вызывается команда Чертеж ► Изображение

Построение непараметрического чертежа (эскиза) в T-FLEX CAD производится 
вызовом команды Чертеж ► Эскиз Ў  . Данная команда может использоваться для
создания как эскиза, так и параметрического чертежа в режиме автоматической 
параметризации. Поэтому проверьте, чтобы на стандартной панели не была на­
жата кнопка Автоматическая параметризация . При создании эскизов полностью
исключается предварительное создание элементов построения. При построении 
элементов эскиза используются объектные привязки и динамические подсказки, 
которые делают процесс создания чертежа простым и удобным. Однако такие 
чертежи не обладают преимуществами параметрических чертежей, касающимися 
эффективного изменения параметров (размеров). Создание таких чертежей мо­
жет дать определенный выигрыш в тех случаях, когда не требуется последующая 
существенная модификация.
Параметрический чертеж может быть создан также в режиме автоматической па­
раметризации. В этом случае для черчения применяются средства эскиза. Пользо­
ватель строит только линии изображения, пользуясь необходимыми объектными 
привязками, а система автоматически определяет параметрические зависимости 
между линиями построения.

13.6. Принципы создания 30-моделей
Основной метод создания ЗБ-моделей подразумевает выполнение боль­
шинства построений модели непосредственно в ЗБ-окне. При другом подхо­
де ЗЭ-модель создается на основе готовых 2Э-чертежей или вспомогательных 
2Б-построений.



Создание ЗО-модели по 20-элементам применяется, когда по имеющемуся 
20-чертежу нужно построить ЗО-модель. Необходимым условием для начала 
создания ЗО-модели является наличие в 20-чертеже детали нужного количества 
видов. Если требуется получить параметрическую трехмерную модель, то пара­
метрические отношения можно задавать уже в двумерном чертеже. В принципе, 
наличие полностью оформленного чертежа не обязательно. Главное, чтобы были 
определены задающие 20-элементы (профили штриховок, точки, пути и т. д.), 
которые будут использованы в командах задания ЗО-модели.
Первым шагом в создании модели является построение рабочих плоскостей. За­
частую бывает достаточно иметь три стандартные взаимно перпендикулярные ра­
бочие плоскости (фронтальную, горизонтальную и профильную), соответствующие 
виду спереди, сверху и слева. Кроме плоскостей функции, аналогичные рабочим 
поверхностям, моіут быть реализованы на цилиндрических, сферических и торои­
дальных поверхностях посредством специальных систем координат. Достаточным 
является наличие одной стандартной рабочей плоскости.
Затем создаются необходимые ЗО-элементы построений (ЗО-узлы, ЗО-профили). 
ЗО-узлы служат для привязки ЗО-профилей, задания векторов выталкивания, осей 
вращения и т. д. Для создания ЗБ-профиля необходимо предварительно создать 
на 20-виде соответствующие контуры, используя штриховку. Если предполагается 
задействовать штриховку только для ЗО-построений, то рекомендуется делать ее 
невидимой, чтобы не загромождать чертеж.
После этого создается твердое тело при помощи одной из базовых формообра­
зующих операций на основе существующих вспомогательных ЗО-элементов. 
В основном к этому способу ЗО-моделирования прибегают в случае несложной 
конструкции. К несложной конструкции можно отнести такую, для понимания 
которой достаточно одной или двух проекций. Как правило, это оси, втулки, про­
стые плиты, крепежные изделия и т. д.
Обычно построение ЗО-модели начинается с создания нового документа с по­
мощью команды Файл ► Новая 3D модель . Далее выбирается рабочая плоскость,
на которой вычерчивается начальный профиль тела будущей модели. Для того 
чтобы начать чертить, вызывается команда Построения ► Прямая У  . После ак­
тивизации рабочей плоскости любой командой 20-черчения появляется панель 
управления активной рабочей плоскостью (рис. 13.11).

Рис. 13.11. Панель управления

Панель можно перетащить в любое свободное место вне рабочего окна построения.
Для создания параметрической модели необходимо сначала строить линии по­
строения, затем — линии изображения. На основе начерченных линий изображения 
система может автоматически построить ЗО-профиль, который можно исполь­



зовать в ЗБ-операциях в дальнейшем. На следующих этапах с помощью команд 
формообразования создается объемное твердое тело (или тело в виде оболочки).
На основании построенных моделей можно получить чертежи, спроецировав не­
обходимые виды, разрезы, сечения, проставив на них требуемые размеры и включив 
элементы оформления.



Ш )  ГЛАВА
Основы моделирования 
в системе T-FLEX CAD 3D

В данной главе приведены классификация и краткое описание объектов системы 
T-FLEX CAD 3D, а также описаны основные методы и приемы проектирования 
ЗО-моделей.

Модель в T-FLEX CAD 3D представляет собой набор связанных или не связанных 
геометрических компонентов. Геометрический объект системы T-FLEX CAD может 
состоять из топологических элементов (см. далее).
Простейшим элементом в системе является вершина. Вершина представляет собой 
точку в пространстве и служит для ограничения ребер. Одна вершина может при­
надлежать одновременно нескольким ребрам.
Ребро представляет собой участок кривой, ограниченный двумя вершинами. Если 
ребро замкнутое, оно может содержать только одну вершину.
Цикл — это набор ребер, образующий один замкнутый контур. Цикл является эле­
ментом, ограничивающим поверхность грани. В каждой вершине цикла сходится 
не более двух ребер.
Грань — ограниченный участок поверхности. В качестве границ грани выступают 
циклы.
Тело представляет собой набор геометрических объектов (вершин, граней и ребер), 
замыкающих непрерывный объем. Самое простое твердое тело образуется при дви­
жении какой-либо ограниченной поверхности (контура) и обладает такими атрибу­
тами, как масса, объем, площадь и т. д. Листовое тело — это набор геометрических 
объектов (вершин, граней и ребер), замыкающих непрерывную площадь и не за­
мыкающих объем. В одной ЗО-модели может быть неограниченное количество тел.

14.1. Основные определения



Операцией называется любой шаг по созданию нового или модификации существу­
ющего твердотельного или листового геометрического объекта. Для выполнения 
каждой операции существует отдельная команда. Те операции, в результате кото­
рых получаются новые тела, относятся к операциям первого уровня, или к базовым 
операциям (операции вращения, выталкивания, создания отверстия и т. п.). Опе­
рации, предназначенные для изменения геометрии и модификации существующих 
тел, относятся к операциям второго уровня, или к модифицирующим операциям 
(булевы операции, операции сглаживания, отсечения и т. п.).
Для создания твердых тел и поверхностей предназначены команды меню Операции, 
а для создания вспомогательных ЗО-элементов — команды меню Построения.

14.2. Вспомогательные 3D-элементы
Вспомогательные элементы служат для задания формы будущего тела, ориентации 
его в пространстве, определения направлений, векторов, осей, траекторий и т. д. 
Каждый элемент имеет отдельную команду создания и редактирования. После за­
пуска такой команды в автоменю появляется дополнительный набор кнопок для 
задания параметров. Часть параметров, доступных в автоменю, является общей 
для всех элементов.
Рабочая плоскость — это элемент, позволяющий задавать исходные данные для 
ЗО-операций, и прежде всего для создания ЗО-профилей. Без создания рабочей 
плоскости невозможно построить ЗО-модель. Рабочие плоскости могут быть за­
даны в 2D- или в ЗЭ-окне.
Следует различать рабочие плоскости, построенные в 2D - и 3D-OKHax. Положение 
рабочих плоскостей в трехмерном пространстве определяется либо мировой систе­
мой координат (стандартные плоскости), либо элементами ЗО-модели. При созда­
нии в окне 20-вида рабочая плоскость привязывается к элементам двухмерного 
чертежа. Каждой заданной в ЗБ-окне рабочей плоскости ставится в соответствие 
отдельная страница чертежа, а задаваемая в 2Э-окне рабочая плоскость занимает 
определенную область на текущей странице чертежа. Если на одной странице рас­
положено больше одной рабочей плоскости, то эти рабочие плоскости не могут 
быть использованы для работы в режиме активной рабочей плоскости.
Для того чтобы рабочие плоскости визуально отобразились в ЗБ-окне, необходимо 
в параметрах каждой рабочей плоскости при создании или редактировании уста­
новить параметр Показывать на 3D виде.

В ЗБ-окне могут быть созданы следующие рабочие плоскости:
О стандартная;
О копия рабочей плоскости;
О параллельная плоскости (грани) со смещением;
О параллельная плоскости (грани) через ЗО-точку;
О параллельная плоскости (грани), касательная к поверхности;
О через три ЗО-точки;



О через ЗЭ-точку и ребро;
О через ребро (ось поверхности вращения) под углом к поверхности;
О через ребро (ось поверхности вращения), касательная к грани (поверхности); 
О через ребро (ось поверхности вращения) и ЗБ-точку;
О перпендикулярно ребру или пути;
О касательная к грани;
О на основе другой рабочей плоскости.
В 20-окне могут быть созданы следующие рабочие плоскости:
□ стандартная;
□ дополнительная;
□ по 2Б-проекции;
□ по ЗБ-системе координат.
Стандартные рабочие плоскости соответствуют шести стандартным видам согласно 
ГОСТ 2.305-68. На рис. 14.1 три рабочие плоскости визуализированы в ЗБ-окне.

X
Рис. 14.1. Расположение рабочих плоскостей

Рабочие поверхности — это вспомогательные ЗБ-элементы, представляющие со­
бой образ геометрической поверхности определенного типа. В качестве таких 
поверхностей могут использоваться цилиндр, сфера и тор. По функциональному 
назначению рабочие поверхности схожи с рабочими плоскостями. В основном они 
предназначены для переноса 2Б-объектов чертежа в ЗБ-пространство. Каждая ра­
бочая поверхность всегда связана с параметрической областью, расположенной на 
странице 2Б-чертежа. На основе плоского 2Б-изображения, лежащего на данной 
странице, можно создавать вспомогательные ЗБ-элементы (ЗБ-узлы, ЗБ-профили, 
ЗБ-пути), которые будут лежать на соответствующей рабочей поверхности — ци­
линдре, сфере или торе.
Основное назначение рабочих поверхностей — построение вспомогательных объ­
ектов (ЗБ-профилей, ЗБ-путей, ЗБ-узлов) для создания деталей с поверхностями



двойной кривизны: лопаток турбин, гребных винтов, корпусов кораблей, фюзеля­
жей летательных аппаратов.
ЗВ-узлы  представляют собой трехмерные точки. ЗЭ-узлы определяются в про­
странстве тремя координатами: X, Y, Z. Создаются ЗЭ-узлы на основе ЗЭ-элементов 
либо в 2Б-окне с использованием узлов двумерного чертежа и рабочих пло­
скостей. ЗБ-узлы служат для привязки других ЗБ-элементов (ЗБ-профилей, 
ЗБ-фрагментов, ЗЭ-систем координат), задания направления (векторов выталки­
вания) и осей вращения.
3D профиль — это элемент построения, предназначенный для выделения участка 
поверхности (рис. 14.2). ЗБ-профиль является одним из основных элементов — 
именно он используется как исходный для многих операций. Контур ЗБ-профиля 
может быть замкнутым или разомкнутым. Замкнутый профиль несет информацию 
об участке поверхности фиксированной площади — он может применяться в каче­
стве основы для создания твердых тел в различных операциях. Разомкнутый про­
филь может использоваться в качестве основы только для создания листовых тел.

Рис. 14.2. Расположение профилей

При черчении ЗБ-профиля доступны штриховки и линии изображения (для ак­
тивной рабочей плоскости).
3D-nymb — это конечная пространственная кривая, имеющая направление 
(рис. 14.3) и использующаяся в качестве направляющей в операциях По траек­
тории, Трубопровод, По сечениям. ЗБ-путь может быть задан на основе штриховки, 
20-путей, как набор ребер трехмерного тела, как кривая, построенная по последо­
вательности ЗЭ-узлов, преобразованием существующих ЗЭ-путей и др. ЗБ-путь



может быть замкнутым. Предусмотрен отдельный тип ЗБ-пути со скруглениями 
для создания трубопровода.

Рис. 14.3. Пример 30-пути

3D-системой координат называют элемент, позволяющий осуществлять привязку 
трехмерных объектов в пространстве. Используется при вставке ЗЭ-изображения 
и ЗО-фрагментов, в операциях копирования, для разборки сборочных ЗБ-моделей 
и др. Для построения этого элемента нужно определить начальную точку и на­
правления осей системы координат. При привязке объекта совмещаются исходная 
(на новом объекте) и целевая (к которой осуществляется привязка) системы ко­
ординат.
ЗО-коннектор — особый вид локальных систем координат, позволяющий, помимо 
выполнения функций привязки, автоматически связывать внешние переменные 
стыкуемых параметрических элементов сборочных ЗБ-моделей.
Массив построений — это особый составной элемент построения. Массив построе­
ний представляет собой определенным образом организованную совокупность 
копий любых элементов построения, кроме сечений, источников света и камер 
(рис. 14.4). Копии, входящие в состав такого массива, могут использоваться как 
обычные элементы построения.
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построения копий исходных элементов)

Рис. 14.4. Пример массива построений

Массивы построений создаются и редактируются с помощью любой из операций 
создания ЗО-массивов.
Сечением называют элемент, в общем случае представляющий собой результат 
выталкивания на бесконечное расстояние плоской кривой или ломаной линии



(рис. 14.5). Выталкивание происходит перпендикулярно плоскости, на которой 
лежит кривая. В частном случае ЗО-сечение может состоять из одной плоскости 
или набора плоскостей. Тогда его можно использовать при построении двухмерных 
разрезов. ЗО-сечение может использоваться при визуализации объектов ЗО-сцены 
и в операции отсечения.

Рис. 14.5. Сечение ЗР-модели

Сечение может быть задано набором ЗО-узлов или вершин, рабочей плоскостью, 
2 D-проекцией.

14.3. Основные операции 
30-моделирования

В системе Т-FLEX определены следующие базовые операции создания твердых тел: 
О выталкивание;
О вращение;
О по сечениям;
О по траектории;
О по параметрам;
О создание отверстия;
О создание спирали;
О создание пружины;
О создание трубопровода.
Эти операции могут вызываться как из меню, так и непосредственно из инстру­
ментальных панелей.

Операция Выталкивание используется для создания тела, образующегося при
поступательном перемещении контура вдоль указанного направления. При помощи 
данной операции можно получать как твердые, так и листовые тела. Выталкивание 
можно производить не только по вектору выталкивания, но и по нормали к по­
верхности контура в одну или в обе стороны. Выталкивание контура также может 
производиться от грани до грани, от поверхности до поверхности, через весь объем 
выбранного тела.



Для работы с командой совместно используются автоменю и окно свойств. Они 
работают синхронно и дополняют друг друга. Состояние автоменю зависит от 
стадии выполнения операции, от предназначения и типа выбираемых объектов. 
Для создания операции нужно выполнить следующие действия:

1. Выделить контур выталкивания, щелкнув на кнопке Выбрать контур

отмены служит кнопка Отменить выбор контура *

Для

2. Указать направление выталкивания (необязательное действие при выталкива­
нии по нормали).

3. Задать длину или границы выталкивания (в ряде случаев — необязательное 
действие).

4. Задать дополнительные параметры, такие как уклон сглаживания, режим тон­
костенного элемента, создание булевой операции (необязательное действие).

5. Подтвердить необходимость операции, щелкнув на кнопке Закончить ввод |

При использовании создаваемого тела в булевой операции необходимо:
1. Включить режим создания булевой операции, щелкнув в автоменю на кнопке

Сложение , и выбрать исходное тело для булевой операции. Булева операция 
создается при нажатой кнопке.

2. Выбрать тип создаваемой операции в палитре автоменю, содержащей кнопки
Сложение , Вычитание и Пересечение %

автоменю3. С помощью кнопки Выбрать исходное тело для булевой операции

выбрать первый операнд булевой операции (в некоторых случаях — необяза­
тельное действие).

Если в сцене присутствует всего одно тело, то оно выбирается автоматически. Соз­
даваемое в операции выталкивания новое тело является вторым операндом булевой 
операции. После подтверждения необходимости операции сначала создается тело 
в операции выталкивания, а затем выполняется булева операция заданного типа.

Операция Вращение позволяет получить трехмерное тело вращением контура
вокруг заданной оси на заданный угол. Плоскость профиля может располагаться 
произвольным образом относительно оси. Исходный контур может располагаться 
произвольным образом относительно оси, но он не должен пересекать ось враще­
ния. При помощи данной операции можно получать как твердые, так и листовые 
тела.
Общая последовательность действий для создания операции такова:

1. Нажать кнопку Выбрать контур Л* и выделить контур вращения.

2. Задать ось вращения при нажатой кнопке Выбрать ось вращения . Ось вра­
щения может быть задана любым объектом, на основе которого система смо­
жет определить геометрию прямой. Ось вращения может быть задана двумя 
ЗО-точками.



3. Задать начальную и конечную точки вращения (необязательное действие).
4. Задать параметры вращения (необязательное действие).
5. Подтвердить создание операции, щелкнув на кнопке Закончить ввод j ф  |.

При создании операции вращения существует возможность выполнить булеву 
операцию с уже существующими телами. Для этого используются те же параметры, 
что и в операции выталкивания.

Операция По сечениям предназначена для создания новых тел со сложной
геометрией. Сплайновые результирующие поверхности формируются на основе 
заданных в одном или двух направлениях элементов каркаса с учетом выбранных 
граничных условий. В качестве основы могут служить практически любые элемен­
ты модели, несущие в себе геометрию одного из трех типов: «точка», «проволока», 
«лист». В зависимости от типа геометрии исходных элементов результат может 
быть получен как в виде твердого тела, так и в виде набора поверхностей.
Сечение имеет такое свойство, как направление обхода контура. При задании опе­
рации на выбранном сечении в направлении обхода рисуется стрелка. Направление 
обхода контура требуется при расчете поверхности, оно должно совпадать для всех 
выбранных сечений. В большинстве случаев для успешного результата система са­
мостоятельно определяет направления сечений. Но при необходимости оно может 
быть изменено пользователем для каждого отдельного сечения.
Точки соответствия позволяют задать направление построения поверхности между 
характерными точками разных сечений. Всегда существует как минимум одно со­
ответствие между точками сечений. Изначально оно строится между стартовыми 
точками сечений. Новые последовательности точек соответствия добавляются 
пользователем самостоятельно. Любую последовательность точек соответствия, 
в том числе стартовых, можно редактировать. На предварительной схеме задавае­
мой операции (она рисуется в 3D-OKHe по мере выбора элементов) каждый набор 
точек соответствия соединяется прямыми линиями (рис. 14.6).



Для работы с командой и задания необходимых компонентов совместно использу­
ется диалоговое окно свойств и автоменю. Они работают синхронно и дополняют 
друг друга. Состояние автоменю зависит от этапа задания операции, от предназна­
чения и типа выбираемых объектов. Режимы выбора объектов могут переключаться 
с помощью как автоменю, так и окна свойств.
При расчете данной операции поверхность формируется на основе элементов 
каркаса и заданных граничных условий. Элементами каркаса являются сечения 
и направляющие.
Для создания операции нужно выполнить следующие действия:
1. Задать сечения. Задание операции всегда начинают с выбора сечений. Для 

успешного создания операции требуется задать как минимум два сечения. При 
задании сечений в автоменю становятся доступными кнопки Выбрать сечения

tjt)  и Выбрать профиль 0  . Далее можно выбирать элементы в ЗБ-окне.
2. Задать направляющие, щелкнув на кнопке Выбрать направляющие (необя­

зательное действие).
3. Задать точки соответствия, щелкнув на кнопке Задать точки соответствия 

(необязательное действие).
4. Задать граничные условия (необязательное действие). Граничное условие 

в виде вектора может быть задано в произвольной точке на элементах каркаса 
операции По сечениям, в том числе в точке на сечении, на направляющей, в точке 
соответствия.

5. Для задания вектора используется дочернее диалоговое окно свойств. Оно вы­
зывается при щелчке на кнопке Векторы Векторы . Эта кнопка есть на всех трех
вкладках основного окна свойств. При переключении по вкладкам основного 
окна дочернее диалоговое окно может оставаться на экране. Его вид меняется 
в зависимости от режима операции и от того, какой элемент операции в данный 
момент является активным.

6. Подтвердить создание операции.

Операция По траектории т \  к позволяет создавать тела, поверхность которых об­
разуется в результате перемещения профиля произвольной формы вдоль простран­
ственной кривой. При движении ЗБ-профиля по траектории можно управлять его 
кручением относительно оси траектории и масштабированием.
В качестве исходного контура может использоваться любой объект с проволоч­
ной или листовой геометрией. Также можно задействовать многоконтурный 
ЗБ-профиль. Движение контура происходит за счет его многократного копирова­
ния вдоль выбранной траектории. Копии контура называются еще промежуточ­
ными сечениями. Для расчета промежуточных сечений система вычисляет ориен­
тацию системы координат промежуточного сечения. Исходная система координат 
рассчитывается для запоминания исходного положения контура. Копирование 
контура происходит от исходной системы координат к рассчитанной системе ко­
ординат промежуточного сечения (рис. 14.7).



Рис. 14.7. Пример выполнения операции

Общий алгоритм действий для создания операции следующий:
1. Выбрать способ ориентации контура. Способ ориентации контура желатель­

но установить в первую очередь, так как в зависимости от результата выбо­
ра система для дальнейших действий предложит определенный набор параме­
тров.
Выбор способа производится в специальном раскрывающемся списке, 
находящемся в окне свойств операции. Доступны все три возможных варианта 
ориентации контура: Контур перпендикулярен траектории, Контур параллелен 
исходному, По направляющим.

2 .

3.

Выбрать контур, щелкнув на кнопке Выбрать контур *

Выбрать элементы для задания траектории, щелкнув на кнопке Выбрать траек­

торию

4. Задать коррекцию исходного положения контура (необязательное действие). 
После выбора траектории система предлагает осуществить коррекцию исходно­
го положения контура. Если выполнения этого шага не требуется, то можно 
перейти к следующим действиям принудительно, щелкнув на соответствующей 
кнопке автоменю.

5. Задать дополнительные направляющие или поверхность (необязательное дей­
ствие).

6. Задать параметры операции (необязательное действие).
7. Подтвердить создание операции.
Операция По параметрам М  > служит для расширения возможностей операции По

траектории. Вызов команды производится из дополнительного пиктографического 
меню, раскрывающегося после щелчка мышью на стрелке кнопки По траектории. 
Исходный профиль задается таким образом, что при изменении одной перемен­
ной могут меняться его положение и геометрия. Указывается диапазон изменения 
значений управляющей переменной. Тело получается после изменения геометри­
ческой формы и положения профиля в результате пересчета по всему диапазону 
значений переменной.
Операция Создание отверстия 9 позволяет создавать стандартные отверстия. 
Работает вместе со специальной параметрической библиотекой отверстий, согла­



сованной с современными стандартами. Команда множественна. Наведя указатель 
мыши на кнопку команды и удерживая кнопку мыши нажатой, можно увидеть 
дополнительное пиктографическое меню с кнопками запуска других доступных
операции Щ а д а і і і М

В стандартную библиотеку входят шаблоны для отверстий следующих типов:
О квадратное;
О под концы установочных винтов (тип 1, 2, 3);
О под крепежные детали;
О резьбовое;
О центровое (формы А, В, С, Е, F, Н, R, Т).
Команда позволяет одновременно создавать отверстия в нескольких телах, а также 
резьбовые отверстия. При создании резьбового отверстия на новой грани выво­
дится косметическая резьба.
Для создания отверстия необходимо выполнить следующие действия (порядок 
выполнения действий может быть другим):
1. Выбрать тип и основные геометрические параметры создаваемого набора от­

верстий. Выбор типа создаваемых отверстий осуществляется в окне свойств 
операции.

2. Задать точки привязки отверстий (грань тела, ЗБ-узел, круговое ребро).
3. Выбрать необходимую глубину отверстий.
4. Изменить ориентацию осей и углы поворота отверстий, выбранные системой 

по умолчанию (необязательное действие).
5. Завершить создание отверстий (с помощью команды Закончить ввод | ц ў  |).

Операция Создание спирали (вызывается из меню Операции) позволяет получить 
трехмерное тело типа «спираль» путем перемещения профиля произвольной 
формы по винтовой кривой. Профиль может быть ориентирован ортогонально оси 
спирали или ортогонально винтовой кривой.
Для создания спирали необходимо выполнить следующие действия:
1. Задать ось спирали с помощью двух ЗО-узлов.
2. Выбрать ЗБ-профиль.
3. Задать ориентацию профиля в пространстве.
4. Задать начальное положение профиля, то есть выбрать стартовую точку поло­

жения профиля (необязательное действие).
5. Задать параметры спирали (радиус спирали и т. д.).
6. Подтвердить создание операции.
Операция Создание пружины (вызывается из меню Операции) позволяет получить 
трехмерное тело типа «пружина» путем перемещения профиля-окружности вдоль 
винтовой кривой. При этом существует возможность задания «сжатия» и «шли­
фовки» на концах пружины.



Для создания пружины необходимо выполнить следующие действия:
1. Задать ось пружины.
2. Задать параметры пружины (радиус проволоки, основной радиус пружины 

и т. д.).
3. Выбрать стартовую точку положения профиля пружины (необязательное дей­

ствие).
4. Подтвердить создание операции.
Операция Создания трубопровода \% \  * позволяет получить трехмерное тело путем
перемещения окружности заданного радиуса по 3D-nyra. 3D-nyTb — это конечная 
пространственная кривая, имеющая направление. Может задаваться на основе 
штриховки, 2Б-путей, как набор ребер трехмерного тела, как кривая, построенная 
по последовательности ЗБ-узлов, преобразованием существующих ЗО-путей и др. 
ЗБ-путь может быть замкнутым.
Для создания трубопровода необходимо выполнить следующую последователь­
ность действий:
1. Выбрать ЗБ-путь. Выбрать необходимый ЗБ-объект можно в ЗБ-окне. 

Если в качестве пути трубопровода выбирается ЗБ-путь, построенный по 
2Б-элементам, его можно выбрать в 2Б-окне. Выбранная ЗБ-кривая и опреде­
ляющие её элементы подсвечиваются. В общем случае на этом можно завершить
создание операции при помощи команды Закончить ввод j ^  |. Дальнейшие
действия являются необязательными.

2. Указать начальный и конечный узлы трубопровода (узлы должны обязательно 
принадлежать заданному пути).

3. Отменить выбор всех исходных данных можно, щелкнув на кнопке Отменить 

выбор &
4. Задать параметры операции (диаметр трубопровода, толщину стенок и т. д.).
5. Подтвердить ввод элементов командой Закончить ввод j &  j.

14.4. Дополнительные операции 
над твердыми телами

Результаты выполнения операций изменения формы тела, созданного командами 
предыдущей группы, существенно зависят от конкретных условий их использова­
ния, в частности, от заданных с помощью автоменю параметров и от самих объек­
тов, над которыми выполняются те или иные действия. Поэтому далее в основном 
приводятся описания команд в самом общем виде.
Булевы операции позволяют из твердых тел получать новые тела путем сложения, 
вычитания и пересечения. Данной операции соответствует кнопка Булева операцияш инструментальной панели. Команда Сложение j %  позволяет объединить твер­



— удалить из объема одного тела объем, 
— получить тело, которое%

дые тела в одно, команда Вычитание 1¾ 

занимаемый другими телами, а команда Пересечение 

является пересечением твердых тел.
Для работы с командой используются совместно автоменю и окно свойств. Они 
функционируют синхронно и дополняют друг друга. Состояние автоменю зави­
сит от стадии задания операции, от назначения и типа выбираемых объектов. При 
запуске команды кнопки доступных параметров обрамлены квадратной рамкой. 
В качестве операндов могут быть выбраны как твердые, так и листовые тела.
Булева операция может также выполняться над набором тел, при этом их часть 
может быть выбрана в качестве первых операндов, а другая часть — в качестве 
вторых. В процессе выполнения операции происходит объединение всех первых 
операндов в одно тело и всех вторых операндов в другое тело. Затем выполняется 
выбранная булева операция над этими телами. В результате получается одно много­
компонентное тело.
В некоторых сочетаниях операндов в булевых операциях результат получить не­
возможно.
Для выполнения операции нужно проделать следующие действия:

Выбрать булевы операнды и второй объекты., указав первый 

Выбрать тип булевой операции.
Выбрать части операндов для формирования выборочной булевой операции 
(не обязательно).
Задать соответствия элементов (не обязательно).
Задать дополнительные параметры (при необходимости).
Задать параметры сглаживания (не обязательно).
Подтвердить создание операции.

После создания булевой операции она помещается в папку Булевы в окне (дереве) 
ЗЭ-модели. Слева от каждой булевой операции отображается пиктограмма, соот­
ветствующая типу операции.
При создании многих операций возможно автоматическое исполнение булевой 
операции. Создаваемое тело при этом всегда является вторым операндом булевой 
операции. В качестве первого операнда выбирается любое из уже существующих 
тел ЗЭ-модели.
В системе выделены следующие операции сглаживания: сглаживание ребер, сгла­
живание граней и сглаживание трех граней.
Сглаживание ребер — операция, которая позволяет модифицировать уже созданное 
тело за счет сглаживания его вершин, ребер и граней. Вызвать команду можно непо­
средственно из панели инструментов, щелкнув на кнопке Сглаживание ребер «9
Вызов команды может осуществляться также из контекстного меню, вызванного 
при выборе одного из элементов, на котором можно построить операцию сглажи­
вания. Таковыми являются грани, ребра, циклы, вершины, операции.



Основное отличие этой операции от других видов сглаживания состоит в том, что 
новая поверхность строится от выбранного ребра и сопрягается только с прилегаю­
щими гранями. Операция позволяет строить фаску, скруглять ребра переменным 
радиусом или эллиптической поверхностью.
При схождении двух ребер разной выпуклости по касательной в вершине с тремя 
или более гранями возможно использование специальной функции обработки 
вершины — создание Y-формы сглаживания. Данный способ обработки вершины 
позволяет создавать в переходной зоне поверхности с более низким искривлением 
по сравнению с обычным сглаживанием.
Сглаживание граней — операция, которая позволяет строить поверхность перехода 
от одного набора гладко сопряженных граней к другому. Наборы сглаживаемых 
граней не обязаны иметь общие ребра (пересекаться). Команда имеет много пара­
метров, позволяющих управлять формой поверхности перехода, задавать условия 
обрезки, ограничения и др.
Не следует рассматривать данную операцию как альтернативу операции сглажи­
вания ребер. Эти две операции со своими плюсами и минусами удачно дополняют 
друг друга.
Для работы с командой и задания необходимых компонентов совместно использу­
ются диалоговое окно свойств и автоменю. Они функционируют синхронно и до­
полняют друг друга. Состояние автоменю зависит от стадии выполнения операции, 
от предназначения и типа выбираемых объектов. Режимы выбора объектов могут 
переключаться как с помощью автоменю, так и при помощи окна свойств.
Для создания операции нужно выполнить следующие действия:
1. Выделить первый набор граней (левая стенка).
2. Выделить второй набор граней (правая стенка).
3. Задать тип сглаживания (при необходимости).
4. Выбрать направляющую (при необходимости, в зависимости от типа сглажи­

вания).
5. Выбрать режим сглаживания (при необходимости).
6. Выбрать форму сечения поверхности сглаживания (при необходимости).
7. Задать геометрические параметры поперечного сечения поверхности сглажи­

вания.
8. Задать граничные условия и специальные возможности (необязательное дей­

ствие).
9. Подтвердить создание операции.
Сглаживание трех граней — частный случай сглаживания граней, выведенный 
в отдельную команду. Операция позволяет построить поверхность перехода между 
«правой» и «левой» стенками, касательную к «средней» стенке.
Операция Отсечение позволяет разделить тело на две части или отсечь лишнюю 
часть тела. В качестве поверхности отсечения можно использовать один из сле­
дующих элементов: сечения, рабочие плоскости, листовое тело, ЗБ-профиль, грань 
тела.



Операция Разделение предназначена для разделения на отдельные тела операций, 
содержащих несколько твердых тел. Например, тело, полученное в результате 
создания линейного или кругового массива, после выполнения данной команды 
будет разделено на отдельные элементы массива. Также команда может быть ис­
пользована при работе с импортированной из другой системы моделью, которая 
состоит из нескольких тел.
Операция Симметрия + позволяет создавать тела, являющиеся копиями уже 
существующих тел, относительно заданной плоскости симметрии.
Для выполнения операции необходимо выполнить следующие действия:

1. Выбрать ЗО-операцию Выбрать 3D операцию о . Кнопка активна при входе
в операцию. Для симметрирования можно выбрать любую из уже существую­
щих операций. Выбор операции осуществляется прямо в ЗО-сцене или в дереве 
ЗО-модели.

2. Выбрать плоскость симметрии, щелкнув на кнопке Выбрать плоскость симме­

трии .̂ Кнопка активна после выбора объекта и позволяет выбрать любой
ЗО-элемент, способный идентифицировать плоскость (плоское ребро, путь или 
грань, рабочую плоскость и т. п.).

3. Выбрать способ достижения симметрии — перемещение или дублирование. 
Способ достижения симметрии устанавливается в окне свойств операции с по­
мощью флажка Перенос без дублирования. При сброшенном флажке выполняется 
дублирование исходного тела, при установленном — перемещение.

4. Задать общие параметры операции, щелкнув на кнопке Задать параметры элемента 

(необязательное действие).

5. Завершить создание операции, щелкнув на кнопке Закончить ввод | ^  | (в ав­
томеню или окне свойств команды).

Операция Оболочка позволяет создавать эквидистантные тела или строить обо­
лочки на основе твердых тел. Оболочка представляет собой полое, тонкостенное 
твердое тело со стенками указанной толщины. При построении оболочек часть 
граней исходного твердого тела можно удалять.
Принцип построения операции заключается в следующем: для каждой грани 
исходного листового или твердого тела на заданном расстоянии строится экви­
дистантная поверхность. В зависимости от желания пользователя эквидистанта 
может строиться либо наружу, либо внутрь поверхностей обрабатываемого тела (по 
нормали или против нормали). Эквидистантные поверхности можно использовать 
для получения эквидистантных тел. Также эквидистанты могут ограничить часть 
внутреннего объема исходного твердого тела для получения оболочки.
Операция Резьба позволяет создавать косметические резьбы на цилиндрических 
и конических гранях ЗО-модели. Косметической такая резьба называется потому, 
что при выполнении команды на выбранную грань накладывается текстура, изобра­
жающая резьбу с учетом заданных границ, а также значений шага и направления.



В отличии от резьбы, созданной при помощи операции Спираль, данная операция не 
создает сложной геометрической поверхности и не требует больших затрат времени 
на создание и пересчет модели. При создании 2Б-проекций система автоматически 
создает линии изображения, соответствующие нанесенной резьбе. При оформлении 
чертежа размеры, привязанные к таким линиям изображения, будут отображать 
условное обозначение резьбы.
Параметры стандартных резьб содержатся в специальной базе данных. Эти пара­
метры (шаг, высота профиля, обозначение) могут рассчитываться автоматически 
по таблицам базы данных или задаваться пользователем вручную для создания 
нестандартной резьбы. При необходимости база данных может быть дополнена 
пользователем.
Вызов команды может осуществляться из контекстного меню при выбранной ци­
линдрической или конической грани (пункт Создать ► Резьба). В этом случае при 
вызове команды несущая грань считается уже выбранной.
Операции группы Уклон позволяют создавать уклоны граней и тел. Выбор разно­
видности команды производится непосредственно в меню. Операция Уклон граней 
позволяет отклонять выбранные грани на заданные углы с автоматической кор­
рекцией смежных граней. Операция Уклон тела позволяет получать ЗБ-тела путем 
отклонения граней выбранного тела на заданные углы относительно выбранных 
ребер этого тела.
Операции группы Массив позволяют создавать сразу несколько копий исходных 
ЗО-объектов. В качестве исходных объектов для создания массивов (объектов ко­
пирования) могут выбираться операции и тела, а также ЗБ-элементы построения 
и грани.
Расположение создаваемых копий (элементов массива) зависит от вида массива: 
линейный, круговой, массив по точкам, массив по пути, параметрический массив. 
Выбор разновидности команды производится непосредственно в меню.
Для создания любого массива после вызова соответствующей команды необходимо 
выполнить следующие действия:
1. Выбрать тип создаваемого массива — массив элементов построения, операций, 

тел или граней.
2. Выбрать исходные объекты массива.
3. Выбрать направляющие элементы и задать основные параметры массива (дей­

ствия, выполняемые на данном шаге, зависят от типа создаваемого массива).
4. Задать дополнительные параметры массива. Набор доступных режимов, уста­

навливаемых с помощью данных параметров, зависит от типа массива.
5. Задать ограничения и исключения (если это необходимо и возможно).
6. Подтвердить создание массива.



14.5. Создание чертежей по 30-модели
Независимо от способа создания трехмерной модели можно в любой момент по­
лучить двумерный чертеж или отдельные недостающие виды модели. Такая задача 
решается путем проецирования трехмерного тела или отдельных его элементов на 
заданную плоскость.
Перед тем как создавать чертежи с помощью проекций, желательно определить­
ся, на каком формате они будут выполняться, на скольких листах, каков общий 
масштаб на каждом листе. Все эти параметры устанавливаются в диалоговом окне 
Параметры документа (команда Настройка ► Статус). Для каждой страницы могут быть 
заданы свои параметры. Эти параметры можно поменять в любой момент.
Для получения какого-либо вида проекции предназначены команды подменю 
Чертеж ► 3D проекция:

О  Создать три стандартных вида;

О  Создать разрез или сечение;

О  Создать дополнительный вид;

О  Создать местный разрез;

О  Создать набор стандартных видов;

О  Создать стандартный вид;

О  Проекция на рабочей плоскости;

О  Проекция по проекции;

О  Произвольный вид;

О  Выбрать файл Зй-модели для проецирования.

Выбрать тип создаваемой проекции можно также в раскрывающемся списке окна 
свойств.
Общий алгоритм построения 2D-проекции состоит из нескольких обязательных 
и необязательных действий:
1. Определить направление проецирования одним из следующих способов:

□  Использовать одну из команд построения стандартных видов (создать три 
стандартных вида, набор стандартных видов или стандартный вид).

□  Создать вид по стрелке с помощью обозначения вида.
□  Определить направление проецирования с помощью рабочей плоскости.
□  С помощью набора дополнительных опций можно определить произволь­

ное направление по элементам ЗБ-модели.
□  Задать вектор направления проецирования и угол поворота в параметрах 

проекции.
□ При создании сечения или разреза направление проецирования определя­

ется автоматически.
□  При создании местного разреза направление проецирования определяется 

автоматически.



2. Задать точку привязки в 2Б-окне. Для этого нужно указать место на чертеже 
(2Б-узел или свободная точка), в котором следует построить проекцию. При 
этом будущая проекция выводится в виде рамки, обозначающей габариты про­
екции.

3. Выбрать сечение для применения на проекции. Данное действие следует вы­
полнить, только если строится разрез или сечение.

4. Выбрать тела, к которым будет применяться сечение. Данное действие следует 
выполнить, только если строится разрез или сечение, причем сечение должно 
применяться к отдельным элементам.

5. Выбрать элементы модели для проецирования (необязательное действие). По 
умолчанию проецируется вся ЗЭ-сцена, но можно проецировать и отдельные 
тела или части тел.

6. Задать параметры проекции (необязательное действие) можно в диалоговом 
окне Параметры проекции.

7. Выбрать тип создаваемой 20-проекции (линии изображения, векторная кар­
тинка и т. п.). Тип создаваемой 2Б-проекции определяется в раскрывающемся 
списке, расположенном в разделе Основные параметры окна свойств команды.

Подтвердить ввод командой автоменю Закончить ввод 1 У  ] .

Построение видов
Построение стандартных видов. Наиболее простой способ быстро получить чер­
тежи ЗО-модели — построить один или несколько стандартных видов.
Для удобства возможность построения наиболее часто используемых трех стан­
дартных видов реализуется командой Создать три стандартных вида ш После вы­
бора этой команды в автоменю становится доступной группа кнопок, предназначен 
ных для построения набора стандартных видов: Изменение положения проекции J  

Разрыв или установка связи проекции с видом спереди Выбор элементов модели 

для проецирования ^  . При создании стандартных видов в автоменю доступно еще 
несколько кнопок, общих для всех видов проекций.
Если система определит, что габариты строящейся проекции не умещаются в пре­
делы рабочей зоны страницы, то она предложит скорректировать параметры для 
размещения изображения в пределах страницы.
Располагать создаваемую 2Б-проекцию можно как на текущей странице, так 
и на вновь созданной. Для работы со страницами чертежа используется команда 
Настройка ► Страницы.

При проецировании независимых тел, проникающих друг в друга, возможно не­
верное определение видимости линий. В таком случае рекомендуется сначала 
объединить тела в единое тело с помощью булевой операции.



После произведенного выбора в 2Б-окне появятся синие рамки, привязанные 
к курсору. Эти рамки обозначают габариты будущих проекций. Для привязки 
какого-то конкретного вида его нужно выделить. Выделение вида осуществляется 
одним щелчком мыши внутри синего прямоугольника или выбором требуемого 
пункта в раскрывающемся списке окна свойств. После выбора проекции необхо-
димо выбрать точку привязки на 20-виде. Если кнопка Привязка вида Р еще
недоступна, то ее нужно задействовать в автоменю. Для этого щелкните левой 
кнопкой мыши, и проекция будет привязана по месту положения курсора. Коман­
да привязки вида позволяет привязывать проекцию к свободной точке (по месту 
щелчка) или к 2D-y3лу.
Если привязывается вид спереди (главный), остальные виды сохраняют свое по­
ложение относительно главного с соблюдением условий проекционной связи с 
главным видом. Точка привязки вида располагается по центру проекции. Если тре­
буется совместить точку привязки с конкретным элементом ЗЭ-модели (ЗБ-узлом 
или вершиной), то следует строить проекцию с помощью набора инструментов,
который открывается при выборе кнопки Произвольный вид

Команда Создание набора стандартных видов отличается от предыдущей тем, что
позволяет задать произвольное количество стандартных видов с помощью специ­
ального меню. После щелчка на этой кнопке появляется окно диалога, в котором 
надо задать требуемые виды.

По команде Создание одного стандартного вида выбор производится в предлагае­
мом системой списке. В список стандартных видов входит вид Изометрия. Пункты 
этого списка есть и в окне свойств — в общем списке типов 20-проекций.

Создание дополнительного вида. Режим создания дополнительного вида (вида по
стрелке) включает команда Создать дополнительный вид . Далее необходимо
выбрать элемент обозначения вида по стрелке. При этом подсветится ближайшая
к стрелке проекция: система будет использовать ее в качестве главного вида. Допол­
нительный вид строится относительно главного. По умолчанию дополнительный 
вид сохраняет проекционную связь с главным видом. Разорвать эту связь можно,
щелкнув на кнопке Разорвать или установить связь проекции с видом спереди

Последние действия — расположите проекцию на чертеже и, если нужно, выберите 
элементы модели для проецирования.

Создание разреза или сечения
Перед тем как начать строить разрез или сечение, нужно иметь в наличии ряд эле­
ментов. Во-первых, предварительно требуется построить либо ЗБ-сечение (команда 
Построения ► Сечение), либо обозначение сечения на чертеже (команда Создать обо-



значение вида д-д ). Причем последний элемент должен быть построен на одной
из существующих проекций. Только в этом случае возможно его использование 
для построения разрезов.
Режим создания разреза или сечения устанавливается с помощью кнопки Соз­

дать разрез или сечение ^  . Далее необходимо выбрать обозначение сечения
на 2D-чертеже или ЗБ-сечение. Нормаль к плоскости сечения будет задавать 
направление проецирования. Элементы выбираются с помощью кнопок Создать

20-проекцию на основе 30-сечения hT|J и  Выбрать обозначение вида для создания про­

екции Li± . Далее с помощью соответствующих команд нужно задать точку при­
вязки проекции на 20-виде.
Разрыв или установка связи создаваемой проекции с заданным сечением осущест- 
вляется с помощью кнопки Установить или разорвать проекционную связь с главным

. Далее можно выбрать элементы для проецирования и элементы, к кото-й:ивидом

рым будет применяться сечение. Выбор элементов для проецирования выполняется 
при помощи кнопки Выбор элементов модели для проецирования По умолчанию
сечение применяется ко всем объектам, выбранным для проецирования. При по­
строении сечения или разреза на основе 2D-обозначения вида учитывается наличие 
разрыва на исходной проекции.
Параметры для управления использованными сечениями объединены в одну груп­
пу и размещены на вкладке Сечения окна свойств (рис. 14.8). Применяемые сечения 
показаны в списке Использовать сечения. В данном списке отображаются имена или 
идентификаторы ЗО-сечений. Для выбора дополнительного ЗО-сечения нужно по­
местить курсор в свободную строку, помеченную многоточием, после чего указать 
на нужный элемент в пространстве модели или в окне 30-модель.

Выбор сечения также можно осуществить при помощи команды Определить при­

меняемые сечения f t автоменю.
Тип проекции, построенной с использованием сечений (разрез, сечение, разрез 
с разворотом/радиальный разрез, сечение с разворотом), можно выбрать в рас­
крывающемся списке. Разворот может быть выполнен только в случае, если ис­
пользовалось сложное сечение (состоящее из нескольких сегментов).
Каждое сечение можно применять сразу ко всем проецируемым или только к от­
дельно выбранным объектам из числа проецируемых. Список операций/тел, к ко­
торым применяется выбранное сечение, отображается в списке Применять к. Для 
выбора элементов, к которым будет применяться сечение, используйте список
в окне свойств или кнопку Выбрать операцию в автоменю (эта кнопка позволяет
выбирать не только операции, но и тела).
С помощью раскрывающегося списка можно установить способ использования 
списка тел. Доступные варианты: К выбранным элементам, Ко всем, кроме выбранных, 
Ко всем элементам. Пункт Ко всем элементам выбран по умолчанию и применяется, 
когда список элементов пуст.
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Рис. 14.8. Окно установки параметров

Параметр Разрез с разворотом/Радиальный разрез работает в одном из двух режи­
мов — в зависимости от того, какой тип сложного сечения в данном случае при­
менялся. Если сложное сечение состоит из отрезков, то все сечение полностью 
разворачивается. Если хотя бы один из сегментов сложного сечения представляет 
собой дугу окружности, то включается режим построения радиального разреза. При 
этом все дуги при развороте сечения исключаются. Параметр Сечение с разворотом 
заставляет всегда строить развернутое сечение, даже если в нем присутствуют дуги 
окружностей.
В общем случае последовательность действий при нанесении сечения или разреза 
(разреза с разворотом сечения) может быть следующей:
1. Создать сечение (команда Построения ► Сечение). Если чертежа 2Б-вида не су­

ществует, то можно задать сечение по 2В~проекции (кнопка Создать сечение на

основе 2D проекции |ЦЩ ) или построить сечение по ЗЭ-виду (кнопка Построить 

сечение по 3D виду +ф  п. Также можно создать ЗБ-сечение по 20-сечению, соз­
даваемому при помощи команды Чертеж ► Обозначение вида, выбрав параметр
Создать обозначение вида

2. С помощью команды Чертеж ► 2D проекция выбрать параметр Создать разрез или 

сечение .



3. Выбрать сечение.
4. Задать точку или узел привязки.
5. Задать параметры 2Б-проекции с помощью команды Чертеж ► 2D проекция 

(необязательное действие).
6. Выбрать тело (ребро, грань, цикл). По умолчанию проецируется вся ЗЭ-сцена. 
Назначить, как именно будет использоваться плоскость сечения (для получения 
сечения, разреза, разреза с разворотом сечения), вы можете путем настройки па­
раметров 2Б-проекции (вкладка Вид).
Например, построив сечение по 2Б-проекции, можно получить разрез модели 
в виде, представленном на рис. 14.9.

Если необходимо изменить положение разреза, то воспользуйтесь командой 
Установить ► Разорвать проекционную связь с сечением . После этого укажите
новую точку привязки и угол поворота (в параметрах 20-проекции). Пример рас­
положения разреза показан на рис. 14.10.

Рис. 14.10. Разрез с разворотом

Для создания местного разреза используется кнопка Создать местный разрез

позволяющая создавать местные разрезы на существующей проекции. Границы 
местного разреза определяются по контуру штриховки, которую требуется создать 
перед построением местного разреза. Для выбора ограничивающей штриховки не­
обходимо щелкнуть на кнопке Выбор штриховки



По окончании создания местного разреза штриховка закроет собой часть основной 
проекции. Линии местного разреза будут нарисованы с более высоким приорите­
том, чем у штриховки и у линий основной проекции.
Геометрия линий изображения, ограничивающих контур исходной штриховки, 
может учитываться при определении границ местного разреза. Например, если 
контур штриховки задан волнистыми линиями, то границы местного разреза также 
будут волнистыми. Режим учета типа линий можно включить или выключить при 
настройке параметров местного разреза.
Далее необходимо определить положение плоскости разреза. Нормаль плоскости 
автоматически совпадает с направлением взгляда основной проекции — той, на ко­
торой строится местный разрез. Далее позиционировать плоскость разреза можно 
либо по ЗО-узлу, либо по 20-узлу на другой проекции. Например, если вы строите 
местный разрез на виде слева, то 20-узел можно указать на одном из соседних 
стандартных видов — спереди, сверху, снизу, сзади.

2D- или ЗР-узел можно выбрать с помощью кнопки Выбор Зй-точки 
20-узла ■

и . или Выбор
задающей плоскость разреза.

Местный разрез автоматически привязан к проекции, на которой он построен. 
Но иногда может потребоваться разорвать эту связь и привязать местный разрез 
к чертежу в другом месте. Разрывает связь команда Установить или разорвать про-

, При разорванной связи доступна кнопка из-
(либо

екционную связь с главным видом
д .DT.QЗі

менения положения проекции к чертежу Изменить положение проекции

свободная привязка, либо привязка к 20-узлу).
При создании местного разреза рекомендуется выбирать элементы модели для 
проецирования. Если выбрать только те элементы, которые попадают в область 
разреза, то проекция будет пересчитываться быстрее (рис. 14.11).

ч V

j b . x  .'■нГЕГТ
-0-:-¾¾

Рис. 14.11. Пример формирования местного разреза

Создание разрыва на проекции
Часто при создании чертежей длинномерных деталей приходится вырезать не­
который участок вида детали с целью обеспечить компактность чертежа. Разрыв



можно сделать при построении всех видов проекции, кроме разреза с разворотом 
сечения. При работе с разрывами следует помнить о ряде особенностей:

О При привязке радиального или обоих узлов линейного размера к линиям такой 
проекции или к потомкам линий проекции система автоматически корректирует 
размер для получения истинного значения.

О Если разрыв создается на уже существующей проекции (при ее редактирова­
нии), к которой привязаны некоторые элементы (например, размеры), то эти 
элементы могут не найтись вследствие изменения топологии проекции после 
создания разрыва.

Команда построения разрыва на проекции доступна во многих режимах построения 
проекций: Вид с разрывом

тальный разрыв

Добавить вертикальный разрыв , Добавить горизон- 

, Задать угол, Копировать линии разрыва

Сжимать пространство можно только в двух взаимно перпендикулярных направле­
ниях. Количество разрывов в обоих направлениях не ограничено. Разрыв задается 
прямоугольной областью. Две границы ее определяются габаритами проекции, 
остальные две задаются пользователем с помощью мыши и соответствующих 
параметров.
Прямоугольная область разрыва в момент создания и редактирования штрихуется 
линиями, показывающими направление сжатия пространства (перпендикулярно 
к линиям разрыва). Предварительное изображение проекции строится синими 
линиями.
На рис. 14.12 показан пример проекции с разрывом.

Рис. 14.12. Построение проекции с разрывом

Дополнительная настройка разрывов производятся также при помощи окна 
свойств (рис. 14.13).
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Г  Длина выносных линий: 15 
Г* Не сдвигать разрывы 
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Рис. 14.13. Вид окна настройки

Для настройки свойств линий, ограничивающих разрыв, нужно вызвать дополни­
тельное диалоговое окно (рис. 14.14) щелчком на кнопке Тип линий в окне свойств.

4ъ\ Разрывы

Начало і Конец И
#187.387 193.8 J
чг- 79.677 261.639 d

Начало:

Конец:

187.38658Hrj

193.80039

Измерять: |в единицах модели  ̂I

ЛеваяПо горизонтали: 

Повертикали: {нижняя 

-Общие параметры - 

Угол: Го

"3

Расстояние: |і о іі
Г "  Длина выносных линий: | 

Г“  Не сдвигать разрывы

Тип линий...

Рис. 14.14. Окно выбора типа линий



Разрыв проекции может быть ограничен разными по форме линиями. Это может 
быть прямая, волнистая или ломаная линия. Для волнистой и ломаной линий 
можно установить такие параметры, как амплитуда и период. Параметры масштаба 
штрихов, толщины и типа линии определяют стиль линии разрыва. Для ломаной 
линии нужно устанавливать такое значение периода, чтобы на линии разрыва была 
одна щепка. Размер щепки управляется амплитудой.
Следует учитывать особенность работы механизма построения проекции с раз­
рывом. При расчете проекции программа «в уме» строит отсечение по указанному 
типу разреза. Поэтому чем линия разрыва сложнее, тем дольше происходит реге­
нерация проекции с разрывом.
При создании нового разрыва параметры разрыва можно скопировать с существую-
щей проекции. После щелчка на кнопке Копировать линии разрыва программа
ожидает выбора проекции, параметры которой будут скопированы на текущую про­
екцию. Действие является одноразовым, то есть при изменении разрывов исходной 
проекции разрывы на проекции, куда они были скопированы, не изменяются.



Создание моделей 
ц ф  глава и ассоциативных 

чертежей деталей

В этой главе описаны этапы создания в системе Т-FLEX ЗБ-моделей деталей, упо­
мянутых во введении к этой книге, и ассоциативных чертежей для двух моделей.

15.1. Изолятор
В этом разделе мы создадим трехмерную модель изолятора, показанную на 
рис. 15.1.

Рис. 15.1. Модель изолятора

1. Создайте новый документ, выбрав в меню 
команду Файл ► Новая 3D модель или щел­
кнув на кнопке Новая 3D модель на па­
нели инструментов. При необходимости 
подключите вкладку Структура 3D модели. 
Выберите рабочую плоскость Вид сверху. 
Чтобы начать чертить, вызовите команду
Построения ► Прямая

Ф  Без имени 3
C j  3D Построения 

j  ■_) Рабочие плоскости : 
I ! Вид сверху 
П Вид слева 
П Вид спереди



2. Щелкните в автоменю на кнопке Создать две 

перпендикулярные прямые и узел I
1 и за­

фиксируйте указателем мыши положение 
узла в начале координат. Постройте еще 
два узла, отстоящих от начала координат 
на 50 мм. Далее постройте три окружности: 
одну с радиусом 100 и две — 20 мм каждая,
щелкнув на кнопке Построить окружность

. Завершите выполнение командыО
щелчком на кнопке Выход из команды | Ц  

в автоменю.

3. На системной панели инструментов щел- 
кните на кнопке Создать изображение

и замените линии построения линиями 
изображения. Для этого (если необходи­
мо) щелкните на кнопке Специальный тип

и в появившемся списке выбе-линии

рите основную линию. Смените с помощью 
указателя мыши тип линий и завершите 
выполнение команды.

—Тонкая
— Основная
— Осевая 
■-Невидимая 
-I Линия_сгиба

и на4. Выберите команду Выталкивание

вкладке параметров установите длину 
50 мм. Предварительно просмотреть ре­
зультаты выполнения операции можно 
с помощью кнопки Предварительный про­

смотр Г ш  ]. Завершите ввод данных ко-
' и закончитемандой Завершить ввод ц ў

операцию. В результате должна получиться 
модель, показанная на рисунке.

5. Отметьте правой кнопкой мыши верхнюю 
грань полученной модели и в появившемся 
контекстном меню выберите команду Чер­
тить на грани, затем вновь вызовите команду
Построить прямую и с помощью команд
построения параллельных прямых из авто­
меню нанесите линии так, как показано на



рисунке. Расстояние между ближайшими 
к центру вертикальными прямыми долж­
но быть равным 40 мм. С помощью ко­
манды Создать изображение ^  постройте
по вспомогательным линиям три прямо­
угольника. В заключение вновь выберите
команду Выталкивание и на вкладке
параметров установите длину 25 мм, после 
чего завершите ввод данных командой За­

вершить ввод j кў j и закройте операцию.

В результате мы должны получить требуемую модель (см. рис. 15.1).

15.2. Вкладыш
В этом разделе мы создадим трехмерную модель вкладыша, показанную на 
рис. 15.2.

Рис. 15.2. Модель вкладыша

1. Создайте новый документ, выбрав в меню 
команду Файл ► Новая 3D модель или щел­
кнув на кнопке Новая 3D модель на па­
нели инструментов. При необходимости 
подключите вкладку Структура 3D модели, 
затем выберите рабочую плоскость Вид 
сверху. Чтобы начать чертить, вызовите
команду Построения ► Прямая

3D Модель
) Без имени 1 
• 3D Построения 

j  Рабочие плоскости: 3

Jffl Вид слева 
S  Вин спереди



2. В автоменю щелкните на кнопке Создать 

две перпендикулярные прямые и узел
I
I

после чего зафиксируйте указателем мыши 
положение узла в начале координат. За­
тем постройте две окружности с радиусами 
100 и 40 мм, щелкнув на кнопке Построить

окружность ф  . Завершите выполнение ко­
манды щелчком на кнопке Выход из команды

I ц  J в автоменю.

3. На системной панели инструментов щел- 
кните на кнопке Создать изображение ^

и замените линии построения линиями 
изображения. Для этого щелкните на кноп
ке Специальный тип линий и в появив­
шемся списке выберите основную линию. 
Смените с помощью указателя мыши тип 
линий и завершите выполнение команды.

— Тонкая 
"Основная
— Осевая 
■"Невидимая 
-1 Линия_сгиба

4. Выберите команду Выталкивание щр и на 
вкладке параметров установите Длину 
40  мм. Предварительно просмотреть ре­
зультаты выполнения операции можно 
с помощью кнопки Предварительный про­

смотр ЫШ Завершите ввод данных ко­
мандой Завершить ввод и закончите
операцию. В результате получится модель, 
показанная на рисунке.

©
5. Щелкните правой кнопкой мыши на верх­

ней грани полученной модели и в появив­
шемся контекстном меню выберите пункт 
Чертить на грани. С помощью кнопок По-

и Построить окружностьстроить прямую

О инструментальной панели выполните
вспомогательные построения, как показано



на рисунке. Расстояние между параллель­
ными прямыми — 130 мм, радиусы окруж­
ностей — 25 и 8С 
команды Узел

мм. Далее с помощью 
автоменю отметьте точ­

ки пересечения окружностей. Перейдите 
с помощью команды Создать изображение

А  в режим рисования изображений. 
Укажите с помощью команды Узел ав­
томеню любой узел и одну из исходящих 
дуг. Последовательно фиксируя указатель 
в следующем узле и отмечая соответству­
ющую дугу, замкните контур, как показано 
на рисунке. Завершите выполнение коман- 
ды щелчком на кнопке Выход из команды

6. Вновь выберите команду Выталкивание 

щелкните в автоменю на кнопке Вычитание 

, а на вкладке параметров задайте дли
ну 20 мм. Завершите ввод данных командой
Завершить ввод и закончите операцию.
Затем выделите указателем мыши одну из 
внутренних граней основания, как показано 
на рисунке, и в контекстном меню выберите 
пункт Чертить на грани. Далее вызовите ко­
манду Построения ► Прямая или щелкните на
кнопке Построить прямую и построите
вспомогательные параллельные прямые 
так, чтобы образовался квадрат со стороной 
20 мм. Щелкните на кнопке Создать изобра­

жение и замените линии построения
линиями изображения. При необходимости 
увеличьте масштаб изображения.



7. Вызовите из меню команду Чертеж ► Ко­
пия ► Копирование симметрично. В автоменю 
будет доступна лишь одна кнопка — Режим

добавления элементов копирования +_ Вы­
делите указателем стороны нарисованного 
квадрата, при необходимости увеличьте 
масштаб изображения. Завершите выде­
ление элементов щелчком на кнопке За­

вершить ввод I V  |. Выберите в качестве
оси симметрии горизонтальную ось окруж­
ности основания модели и завершите опе­
рацию щелчком на кнопке Выход из команды

уста-8. Выберите команду Выталкивание

новите на вкладке параметров команды 
глубину 10 мм, убедитесь в правильности 
задания параметров, щелкнув на кнопке
Предварительный просмотр ГЖ  ], и при не­
обходимости откорректируйте параметры. 
Завершите ввод данных командой Завер­

шить ввод 1 I и закончите операцию. 
В результате должна получиться модель, 
показанная на рисунке.

9. Установите вид спереди с помощью коман­
ды Вид ► Проекция ► Вид спереди ѳ и по­
стройте вспомогательные прямые: горизон­
тальную на расстоянии 30 м м  от основания 
и две вертикальные на расстоянии 20 мм 
от осевой. Щелкнув на кнопке Построить

, нарисуйте прямоугольник,прямую

как показано на рисунке, используя в каче­
стве базового один из узлов на пересечении 
вспомогательных прямых, после чего за­
вершите операцию.



Ю.Выберите команду Вы талкивание

и в автоменю задайте операцию Вычитание

. На вкладке команды в окне установки
направления выберите вариант Через все. 
Отметьте указателем требуемый профиль 
вычитания. При подводке к профилям ука­
зателя будет производиться подсветка со­
ответствующих контуров профилей.

г x l
ЩйѵЯЭВ 1w

jA 'т т1 111. Завершите ввод данных командой Завер­
шить ввод Ы \  и закончите операцию.
В результате получится модель, показанная 
на рисунке.

12. Для вырезания четверти объема выбе­
рите в качестве рабочей горизонталь­
ную плоскость и вызовите команду 
Построения ► Сечение. Для создания сечения 
на рабочей плоскости щелкните в автоменю 
на кнопке Создать сечение на основе рабочей

плоскости ДЦ. С помощью команды Вы­

брать следующий узел, определяющий сечение 
гх|xJ задайте узлы секущих плоскостей, как

показано на рисунке. Завершите ввод и за­
кончите операцию.

13. Для визуализации сечения выполните ко­
манду Вид ► Применить сечение. Управлять 
видимостью сечения можно также из де­
рева модели.

В результате мы должны получить требуемую модель (см. рис. 15.2).



15.3. Радиатор игольчатый
В этом разделе мы создадим трехмерную модель игольчатого радиатора, показан­
ную на рис. 15.3.

Рис. 15.3. Модель игольчатого радиатора

1. Создайте новый документ, выбрав в меню 
команду Файл ► Новая 3D модель или щел-
кнув на кнопке Новая 3D модель на
панели инструментов. Выберите рабочую 
плоскость Вид сверху, после чего вызовите 
команду Построения ► Прямая или щелкните
на кнопке Построить прямую У  на панели
инструментов.

3D Модель 
й  Без имени 1

Ё )  3D Построения 
л Рабочие плоскости : 3

Jffl Вид слева 
]Щ Вид спереди

2. В автоменю щелкните на кнопке Создать две 

перпендикулярные прямые и узел I
I и за­

фиксируйте указателем мыши положение 
узла в начале координат. Завершите выпол­
нение команды щелчком на кнопке Выход

из команды L Ц  I автоменю. Постройте для

ч............Ар ч 9 у

удобства вспомогательные параллельные 
прямые согласно приведенному рисунку. 
Расстояние от центра до горизонтальных 
прямых должно составлять 12,5 мм, до вер­
тикальных — 20 и 25 мм. Затем в режиме 
создания линий изображения постройте по 
вспомогательным линиям прямоугольник 
и три окружности: две с диаметрами 2 ,7  
и одну — 4,5 мм.



3. Выберите команду Выталкивание ^  , убе­
дитесь, что в автоменю нажата кнопка Сло- 

, задайте длину 3 м м  и завершитежение

ввод данных щелчком на кнопке Завершить 

ввод Гѵ~~|.

4. Вызовите команду Построения ► Прямая или 
щелкните на кнопке Построить прямую

С помощью команды Создать две перпенди­

кулярные прямые и узел -+- зафиксируйте
указателем мыши положение узла в начале 
координат и завершите выполнение коман­
ды щелчком на кнопке Выход из команды

I И  I в автоменю. Постройте две парал­

......А........ .

- © - j .......$ V..........о -

лельные относительно осей прямые, ис­
пользуя оси как элементы привязки. Ука­
жите значение смещения в окне свойств: 
для горизонтальной линии — 10 мм, для 
вертикальной — 15 мм. Затем перейдите 
в режим создания изображений, щелкнув
на кнопке Создать изображение А и по­
стройте окружность диаметром 3 мм.

5. Выберите команду Вы талкивание

и в окне свойств команды введите пара­
метры: длина — 15, уклон — 2. Завершите 
ввод данных щелчком на кнопке Завершить

ввод I V  |.

6. Выберите в меню команду Операции ► Мас­
сив ► Линейный. В окне Общие на вкладке 
параметров команды укажите вариант Мас­
сив операций. В поле ЗБ-модели выделите 
указателем иглу радиатора, в окнах направ­
лений выберите вариант Количество копий 
и шаг и установите шаг, равным 5, количе­
ство копий — 7 и 5 для первого и второго

%  Вьбфвтьф»

Касательная к кривой в точке 

Нормаль к кривой в точке 

Бтормаль к кривой в тх**се 

Нормал к поверхности в точсе 

Нормаль к плоскому ребру 

Прямой путь оебро_______ ____ ■



направлений соответственно. Наведите 
мышь на кнопку Выбор направления w .

и в появившемся меню установите пара­
метр Выбирать все.

7. С помощью команд пиктографического
укажите на-меню Выбор направления

правления, по которым будет создаваться 
массив, отметив два ребра основания, па­
раллельных осям X  и Y. Щелчком на кноп­
ке Вид сверху установите вид сверху
модели и удалите 5 иголок в центре радиа­
тора, для чего воспользуйтесь командой
Выбор элементов XD □ □ в автоменю.

8. Просмотрите полученный результат с по­
мощью команды Предварительный просмотр 
и завершите операцию щелчком на кнопке
Завершить ввод I ^  I.

О О
о о 

о о 0 о  о 
о

о____________

9. Для создания фасок на отверстиях выбе­
рите в меню команду Операции ► Сглажи­
вание ► Ребер, установите в окне параметров 
команды параметр Фаска (длина, угол), от­
метьте все шесть ребер отверстий и уста­
новите длину 0,5 мм и угол 45°. Завершите 
операцию щелчком на кнопке Завершить

ввод Гѵ П , но не завершайте выполнение
команды. В заключение установите в окне 
параметров команды параметр Скругление, 
щелкните в автоменю на кнопке Выбрать

ребро и укажите 4 вертикальных ре­
бра основания радиатора. Введите значение 
радиуса скругления 3 мм и завершите по­
строения.

В результате мы должны получить требуемую модель (см. рис. 15.3).



15.4. Уголок
В этом разделе мы создадим трехмерную модель уголка, показанную на рис. 15.4.

1. Создайте новый документ, выбрав в меню 
команду Файл ► Новая 3D модель или щел
кнув на кнопке Новая 3D модель

л на
панели инструментов. Выберите рабочую 
плоскость Вид слева и вызовите команду 
Построения ► Прямая или щелкните на кноп-
ке Построить прямую на панели инстру­
ментов.

3D Модель 
^  Безммеииі 
* О  3D Построения

л- О  Рабочие плоскости: 3 
-  Jffl Вин сверку 
-Д 5  Вид слева 
-•Jffl Виа спереди

2. Выберите в меню команду Настройка ► Сетка 
и установите все флажки в появившемся 
окне. С помощью команды Создать две пер-

зафикси-Iпендикулярные прямые и узел

руйте указателем мыши положение узла 
в начале координат и постройте по сетке 
вспомогательные линии, как показано на 
рисунке. Затем перейдите в режим созда-

и с помо-ния эскиза по команде Эскиз

щью команды Специальный тип линий

установите основной тип линии. Выполни 
те эскиз в соответствии с рисунком.



3. Выберите в автоменю команду Скругление

и выполните операцию в соответствии
с рисунком. Завершите выполнение коман­
ды щелчком на кнопке Выход из команды

К  j в автоменю и вызовите команду
Чертеж ► Штриховка. В данном случае эта 
команда будет использована для создания 
ЗБ-профилей модели. Установите в автоме­
ню режим автоматического поиска конту­
ров, щелкнув на кнопке ш , и заштрихуй­
те по отдельности два контура, после чего 
завершите выполнение команды.

4. Вызовите команду Выталкивание за­
тем, поочередно выделяя указателем про­
фили собственно уголка и ребра жесткости, 
выполните команду, устанавливая при этом 
расстояния выдавливания 60 для уголка, 
и 3 для ребра жесткости. При выделении 
профилей в системе будет производиться 
их подсветка.

Выберите в меню команду Операция ► Копия 

, затем с помощью команды Выбрать 3D 

автоменю выделите указа-&операцию

телем ребро жесткости. Ребро после выбо 
ра будет подсвечено. С помощью команды
Выбрать точку для создания исходной СК ,

укажите характерную точку копируемого 
объекта (точка локальной системы коор­
динат). В выбранной точке система вы­
светит подсвеченные координатные орты. 
Команда Выбрать точку для создания целе­

вой СК ■Яцпозволяет задать точку целевой
системы координат, координатные орты 
которой будут также подсвечены. Выпол­
нив данные команды, щелкните на кнопке
Завершить ввод ^  для завершения ввода.



6. Для создания скруглений вызовите коман­
ду Операции ► Сглаживание ► Ребер и устано­
вите в окне параметров команды параметр 
Скругление. Щелкните в автоменю на кноп­
ке Выбрать ребро и укажите сглажи­
ваемые ребра. Введите значение радиуса 
скругления 5 мм и завершите построения.

7. Отметьте правой кнопкой мыши верхнюю 
грань основания и в появившемся кон­
текстном меню выберите пункт Чертить на 
грани. Воспользовавшись командой Узел

постройте в центре выделенной грани
2Б-узел. Не выходя из режима черчения на 
грани, вызовите команду Построения ► 3D 
Узел и создайте в том же месте узел, щел­
кнув на кнопке Завершить ввод [ ^  |. За­
вершите операцию командой Выход из 

команды ;;«Цѵ •. Затем вызовите команду
Операции ► Отверстие и установите пара­
метры отверстия согласно рисунку. Далее 
с помощью команды Выбрать грань, узел

автоменю укажитеили круговое ребро 

ЗБ-узел и щелкните на кнопке Завершить 

ввод Завершите операцию щелчком
на кнопке Выход из команды Чтобы
закончить черчение на рабочей плоскости,
воспользуйтесь командой Завершить У  .

& & & тО О

В результате мы должны получить требуемую модель (см. рис. 15.4).



15.5. Втулка
В этом разделе мы создадим трехмерную модель втулки, показанную на рис. 15.5.

Рис. 15.5. Модель втулки

Создайте новый документ, выбрав в меню 
команду Файл ► Новая 3D модель или щел-
кнув на кнопке Новая 3D модель на
панели инструментов. Выберите рабочую 
плоскость Вид спереди и вызовите коман­
ду Построения ► Прямая или щелкните на
кнопке Построить прямую У  на панели
инструментов.

3D Модель
!ц%; Безимеж5 
л 30 Построения

Рабочие плоскости: 3
bjs В на сверху

в иа слева
L....JS в ид спереди

2. С помощью команды Создать две перпенди­

кулярные прямые и узел -+- зафиксируйте
указателем мыши положение узла в нача­
ле координат. Постройте вспомогательные 
прямые и нарисуйте профиль вращения 
модели согласно рисунку. Размер фасок 
должен быт равен 1x45° Не забудьте по­
строить осевую линию.

20
10

0 у

12

Осевая

3. Убедитесь, что в автоменю нажата кнопка

Сложение

вращением

Вызовите команду Создать

, после чего щелкните на 
кнопке Завершить ввод [ &  | и завершите 
операцию командой Выход из команды I К  I



4. Выделите торцевую плоскость модели и вы­
берите в меню команду Чертить на грани, за­
тем вызовите команду Построения ► Прямая 
или щелкните на кнопке Построить прямую

на панели инструментов. Постройте
вспомогательную вертикальную линию, 
проходящую через центр окружности. Да­
лее вызовите команду Настройка ► Сетка, 
установите все флажки в появившемся 
окне и задайте шаг сетки по осям 0,5 мм. 
Увеличьте масштаб изображения так, чтобы 
можно было построить треугольник по раз­
мерам, указанным на рисунке.

5. Вызовите команду Выталкивание , щел­
кните в автоменю на кнопке Вычитание

в окне задания параметров команды уста­
новите требуемые параметры (глубину, 
угол, шаг) и выполните команду. На ри­
сунке показан соответствующий фрагмент 
изображения модели.

Вызовите команду Операции ► Массив ► 
Круговой и на вкладке команды в окне Об­
щие установите параметр Массив операций, 
а в окне Поворот — Общий угол и шаг. В нача­
ле выполнения команды в автоменю будет
доступна кнопка Выбор 3D операции

Выберите операцию непосредственным 
указанием на вкладке 3D Модель.

3D Модель

І^і ВтцлкаІ.дЛ)
*  30 Построена 

!> Й | Проекщ#*: 3
ЁЭ 30 Профили: 2 
Й І Рабочие плоскости: 6 

. сЗ  30 Узлы: 2 
Операции

* 0Р  Тело_0
I - ......Врзііізние О

I-1 Выталкивание..!

7. После указания операции становится до­
ступной кнопка Выбор точек оси вращения

MtfiJ. Выберите начальную и конечную
точки оси. Установите значения угла 360 
и шага 2 (приближенно). Щелчком мыши 
нажмите и повторным щелчком отожмите
кнопку Предварительный просмотр На
экране останется фантом предварительно 
построенного рифления. Увеличьте мас­
штаб просмотра.



Уточните значение шага так, чтобы треу­
гольные профили касались друг друга, по­
сле чего завершите операцию щелчком на
кнопке Завершить ввод [ и закончите
выполнение команды щелчком на кнопке
Выход из команды [ Ц  |. В результате будет
создано дополнительное тело — круговой 
массив призм. Для дальнейшего построе­
ния рифления необходимо щелкнуть на
кнопке Булева операция на панели ин­
струментови выполнить булеву операцию 
Вычитание . Операция может занять
некоторое время. Результат моделирования 
показан на рисунке.

В результате мы должны получить требуемую модель (см. рис. 15.5). На рисунке 
представлен ее вид с вырезанной четвертью, позволяющий раскрыть внутреннюю 
структуру построенной модели.

15.6. Кронштейн
В этом разделе мы создадим трехмерную модель кронштейна, показанную на 
рис. 15.6.

Рис. 15.6. Модель кронштейна



1. Создайте новый документ для построения 
ЗБ-модели, выберите в качестве рабочей 
плоскости вид спереди и нарисуйте эскиз 
профиля модели согласно приведенному 
рисунку.

»убе-Вызовите команду Выталкивание 

дитесь, что в автоменю нажата кнопка Сло 

жение и установите параметр длины
равным 50 мм. Затем выделите построен­
ный контур, щелкните на кнопке Завер­

шение ввода и закончите операцию
щелчком на кнопке Выход из команды

3. Выделите правой кнопкой мыши в дереве 
модели плоскость Вид спереди и в появив­
шемся контекстном меню выберите ко­
манду Создать/Построить рабочую плоскость. 
Прямым указанием курсора в графическом 
окне выделите переднюю грань модели 
и создайте рабочую плоскость. Затем соз­
дайте эскиз двух заштрихованных полуко­
лец в соответствии с рисунком. Узел нача­
ла координат разместите в центре рабочей
плоскости. С помощью команды Узел

панели инструментов создайте в центрах 
полуколец два узла и завершите выполне­
ние команды.



4. Вызовите команду Выталкивание ^

тановите параметр длины равным 1 
Выделите один из построенных конт 
Проверьте правильность построений 
мощью команды Предварительный про

Щ  и щелкните на кнопке Завершил 

. Не заканчивая работу с кома
выталкивания, повторите операциі 
второго контура.

иус-
8 мм.
уров. 
с по­
ем отр

> ввод

ндой 
1 для

1
5. Выберите рабочую плоскость Вид сп 

Создайте показанный на рисунке пр 
угольник с размерами 20x110 мм. Выз<
команду Выталкивание ^  , убедитесі 
в автоменю нажата кнопка Сложение 

и щелкните на кнопке Завершить ввод

ірава.
)Я М О -

эвите 
ь, что

V

Й И |

6. Откажитесь от предлагаемого системой 
подтверждения выбора операндов логи­
ческих операций. В результате должна по­
лучиться модель, показанная на рисунке.

7. Вызовите команду Булева операция

и в автоменю установите операции
читание 1¾^. Укажите в качестве пер
операнда «основную» модель, а в кач< 
второго — тело, созданное на предыд] 
шаге, после чего щелкните на кнопке 3 
шить ввод ^  и завершите выполн 
команды.

&
з Вы-

)В О ГО

естве
учцем
авер-
ение 1



8. Вызовите команду Построения ► Рабочая 
плоскость и прямым указанием курсора 
создайте рабочую плоскость на верхней 
грани опорной части модели. Затем пе­
рейдите в режим черчения на созданной 
рабочей плоскости и с помощью команды
Создать две перпендикулярные прямые и узел

разместите узел в центре грани, послеI
чего вызовите команду Построения ► 3D 
Узел и создайте ЗБ-узел поверх 2Б-узла.

9. Для создания крепежного отверстия вы­
полните команду Операции ► Отверстие. 
Установите параметры отверстия, как по­
казано на рисунке.

10. Указав мышью на ЗБ-узел, создайте объ­
ект, щелкните на кнопке Завершить ввод

i f  и завершите выполнение команды.

11. Выполните сглаживание ребер, восполь­
зовавшись одноименной командой меню 
Операции. При выполнении команды за­
дайте радиус 3 мм и щелкните в автоменю
на кнопке Выбор ребер и



12. Для дальнейшего построения модели необ­
ходимо объединить в единое целое создан­
ные на предыдущих шагах объекты-тела. 
После просмотра дерева модели вызовите
команду Булева операция ( | р  и в автоме-

Л !ню установите операцию Пересечение

Укажите первый (Тело_0 в дереве модели) 
и второй операнды команды, после чего
щелчком на кнопке Завершить ввод I ф

подтвердите выбор. Не заканчивая рабо­
ту с командой, повторите операцию, из­
менив второй операнд. По завершении вы­
полнения команды внешний вид модели 
останется прежним, но ее структура изме­
нится. Следует отметить, что объединять 
элементы можно непосредственно в дереве 
модели.

13. Выберите в меню команду Операции ► Сим­
метрия, выделите курсором модель и пло­
скость вида спереди, после чего щелкните

. В заклю-на кнопке Завершить ввод

чение повторите операцию для тел модели 
относительно плоскости вида слева.

3D Модель 
ІДЙ Кронштейн! grb 
j  -ІсЭ 3D Построения 

t> ■■ Q  Проекции: 3 
t> ■ Й  3D Профили: 4 
t> Рабочие плоскости: 6 
І> "(Й 3D Узлы: 1 

і> -ІсЭ Операции 
Тело О

.......Ф  Выталкивание О
Вьгталкивание_3

t>.......|§J Отверстие 7
> .......3  Сглаживание_8

Выгалкивание_2
Вьпгалкивание_1

В результате мы должны получить требуемую модель (см. рис. 15.6).

15.7. Корпус
В этом разделе мы создадим трехмерную модель корпуса, показанную на рис. 15.7.



1. Создайте новый документ для построения 
ЗБ-модели. Выберите в качестве рабо­
чей плоскости вид спереди и, щелкнув на
кнопке Создать изображение , нарисуйте
в режиме создания элементов изображения 
чертеж профиля корпуса согласно приве­
денному рисунку.

2. Вызовите команду Создать вращением 

Убедитесь, что в автоменю нажата кноп 

Д г  олучен-ка Сложение

ный результат с помощью команды Пред­

варительный просмотр □ Г  1. Завершите
операцию, щелкнув на кнопке Завершить 

ввод I ѵ  1, и закончите работу с командой 
щелчком на кнопке Выход из команды

3. Выделите в окне модели горизонтальную 
плоскость (вид сверху) и в контекстном 
меню выберите команду Создать ► Построить 
рабочую плоскость. По умолчанию допол­
нительная плоскость расположена над 
горизонтальной на расстоянии 10 мм. Со­
гласитесь с предлагаемыми параметрами, 
создайте плоскость, щелкнув на кнопке
Завершить ввод | &  |, и закончите работу 
с командой.

4. Выделите указателем мыши созданную 
плоскость и в контекстном меню выбери­
те пункт Чертить на рабочей плоскости. Вы­
зовите команду Построения ► Прямая или
щелкните на кнопке Построить прямую

на панели инструментов. Постройте вспо­
могательные линии и выполните чертеж 
фрагмента профиля в соответствии с ри­
сунком. Штриховка обязательна.



5. Вызовите команду Выталкивание и,
выбрав соответствующее направление
действия команды, выполните выдавли­
вание профиля тела на величину 10 мм.

6. С помощью кнопки Вид сверху уста­
новите вид на модель сверху и выберите 
команду Операции ► Отверстие, после чего 
в окне настройки команды введите пара­
метры в соответствии с рисунком.

7. Выделите круговое ребро для задания 
центра отверстия, после чего завершите 
ввод и закончите работу с командой.

8. Выберите команду Операции ► Массив ► 
Круговой и в окне дерева модели укажи­
те последнее созданное тело. Произвести 
выбор требуемого объекта можно и непо­
средственно в графическом окне модели, 
указав на него мышью.

ІЭРМодеіь
Kopngclgrt)

4 ІСЭ 30 Построения 
fr •-£> 3D Профили: 2 
і; СЗ Рабочие плоскости: 4 
і -ІсЭ 30 Узлы: 2 

¢2) Операции 
*  Т вло_0

ifo Вращеше_0

9. В окне настройки команды установите 
параметры в соответствии с рисунком.

Ко/мчество копий и шаг 

Коі»Л 3 

Шаг 120 

Угол

10. Задайте точки оси вращения массива 
и выполните команду.



11. Для создания фронтального отверстия 
отметьте в дереве модели плоскость Вид 
спереди и в контекстном меню выберите 
команду Создать/Построить рабочую пло­
скость.

Ю Модель 
ijjij Корпусі 2.grb 
л 3D Построения 

[> • 3D Профили: 2 
л  Рабочие плоскости: 4 

JEB Вид сверху 
Jl§ Вид слева 
JS Виц спереди 

[> JEB Рабочая плоскость_3 
h Й  3D Узлы: 4 

і’ - Операции 

*-j3 Тело_0 
в ■■■%* Круговоймассив_5

12. В графическом окне модели укажите на 
цилиндрическую поверхность модели 
и создайте дополнительную плоскость.

1

13. На созданной рабочей плоскости с помо­
щью команды Создать две перпендикуляр­

ные прямые и узел -+- создайте узел на 
расстоянии 25 мм от основания модели.
Выберите далее команду Построения ► 3D 
Узел и постройте его в том же месте. Вы­
зовите команду Операции ► Отверстие и соз­
дайте сквозное отверстие размером 10 мм,
щелкнув в автоменю на кнопке Насквозь 

U  . Завершите черчение на рабочей пло­
скости.

14. Установите вид слева,’включите режим 
построения эскиза и создайте прямоуголь­
ник с размерами, указанными на рисунке.

г ШП И г . і с;..
- • »120 ”

15. Выберите команду Выталкивание ^  . 

Убедитесь, что в автоменю нажата кнопка 
Сложение 1¾ ^при необходимости укажи­
те контур выдавливания, после чего уста­
новите требуемое направление действия 
команды и параметр длины, равный 30. 
Завершите ввод и закончите работу с ко­
мандой.

•



16. Вызовите команду Булева операция

щелкните в автоменю на кнопке Вычитание

и укажите в качестве первого объекта
операции цилиндрическую основу моде­
ли, а в качестве второго — объект, создан­
ный на предыдущем шаге. Завершите ввод 
и закончите работу с командой.

В результате мы должны получить требуемую модель (см. рис. 15.7).

15.8. Пружина
В этом разделе мы создадим трехмерную модель пружины, показанную на рис. 15.8.

Рис. 15.8. Модель пружины

1. Создайте новую ЗБ-модель, выберите в ка­ -х
честве рабочей плоскости вид сверху и на­
рисуйте отрезок длиной 50 мм. Затем вы­
берите в меню команду Операции ► Пружина.
После этого в автоменю окажется нажатой
кнопка Ввод начальной точки оси пружины

JL
ТГІ . Отметьте последовательно в качестве

начальной и конечной точек оси конечные
точки отрезка. Установите (для удобства
просмотра) направление витков пружины
против часовой стрелки.



2. Установите значение шага витков пружины 
равным 5 и щелкните на кнопке Предвари­

тельный просмотр Q  . Вид полученной
модели показан на рисунке. Вернитесь в ре­
жим ввода параметров, повторно щелкнув
на кнопке Предварительный просмотр @  .

#

3. Установите дополнительные параметры 
так, как показано на рисунке, и в режиме 
предварительного просмотра ознакомьтесь 
с влиянием на форму пружины остальных 
параметров команды.

[а ] Дополнительные параметры

(21Сжать [2 f r l  

0  Шлифов. |1

(3  бьровнять по начальной точке

В результате мы должны получить требуемую модель (см. рис. 15.8).

15.9. Создание ассоциативного чертежа 
радиатора

В этом разделе мы построим чертеж созданной нами ранее (см. раздел 15.3) трех­
мерной модели радиатора.

1. В окне ЗО-модели выберите в меню коман­
ду Чертеж ► 2d проекция , в автоменю 
щелкните на кнопке Создать набор стандарт­

ных видов ф  и в открывшемся диалого­
вом окне укажите два вида, как показано 
на рисунке. Затем переместите прямоуголь­
ный фантом вида спереди в нужное место 
чертежа и подтвердите выбор, щелкнув на
кнопке Завершить ввод I ^  1.

□  Сзааи
□  Смиэу

□  Сзапн □  Справа (спереци |» |  □  Слева □  Смай 

0  Сверху
□  Сзади

I (Ж j j Отма»мгь j



2. Для удобства нанесения размеров выпол­
ните местный разрез, проходящий через 
центральное отверстие радиатора. Для это­
го перейдите в режим выполнения эскиза,
щелкнув на кнопке Эскиз , и на виде
спереди в плоскости основания радиатора 
(по его «толщине») нарисуйте замкнутую 
линию комбинированного стиля, охваты­
вающую область расположения отверстия.
Щелкнув на кнопке Создать штриховку

нанесите штриховку в нарисованной оо- 
ласти и по команде Чертеж ► 2d проекция

вернитесь в режим создания проек-□юпт
ций. Далее выберите в автоменю опера­
цию Создать местный разрез [§§ и отметьте
мышью заштрихованную область. После 
этого необходимо на виде сверху модели 
радиатора отметить характерные для раз­
реза объекты (например, ребра двух отвер­
стий) и подтвердить выбор, щелкнув на
кнопке Завершить ввод ГѵП - Для создания
выносного элемента выполните команду
Чертеж ► Чертежный вид и в автоменю
щелкните на кнопке Создать выносной вид 

с обозначением с г . Затем перейдите на
вкладку Свойства и выберите прямоуголь­
ный тип отображаемой формы в списке 
Форма, а также подберите размеры прямо­
угольника и установите масштаб вида 2:1, 
как показано на рисунке.

; Масштаб кол*і

-изображение--------------
;□ Масштаб изображения |Т~
О Угол поворота! | о
; {у? Обозначение ---
Буква (Текст): А

I2f Подбфать следующую букву

[Первая строка: <Буква > (<Мэсштаі |

;□ Подчеркнуть текст
.Вторая строка: j

Область отображения 

'Форма:j
!□ Ширина:
;□ Высота:

Г а̂ямоуго/ъмі

40
5.4

□  Обрезать изображение 

Масштабировать лижи

5 с О М .. .  ЁЙМеню.,. ; ^ С в о и ...

3. Переместите выделенное изображение 
в подходящее место чертежа согласно ри­
сунку.

A L U Ш А 11
—a а ---------

А



Для дальнейшей работы с выносным эле­
ментом щелкните правой кнопкой мыши 
на созданном виде и выберите в контекст­
ном меню команду Активировать чертежный 
вид. Отметьте обозначение вида и увеличь­
те просвет между изображением разреза и 
надписью, при необходимости откорректи­
руйте изображение. Затем проставьте раз­
меры, используя команду Чертеж ► Размер

. Для нанесения линейных размеров[Л]
выберите в автоменю команду Проставить

. Для простанов-размеры по трем узлам П
ки диаметральных размеров на вкладке 
Свойства необходимо установить значения 
размеров, как показано на рисунке.

Знак:

Номинал
Вручную -  О

На чертеже
'Масштаб-

И

Тип: J±L
Смещение строк: [о____jjj
Смещение лини: Г Н
□  Рамке
□  Стрелки снаружи 
-Очистка фона-

LJ

□  Под рАЗиернмчи линиям
□ Под выносным линиями

т т Ш Р І І Р

о т

fj3DM... Изменю... jS'Ceon..

5. Пример оформления выносного элемента 
представлен на рисунке. Чтобы закончить 
работу с видом, щелкните на нем правой 
кнопкой мыши и выберите в контекстном 
меню команду Закрыть чертежный вид.

А (2:1)
016



6. Для включения в чертеж аксонометри­
ческой проекции выполните команду
Чертеж ► 2d проекция щелкните в ав-

□ю
В9томеню на кнопке Произвольный вид

переместите фантом проекции в требуе­
мое место чертежа, щелкните в автоменю 
на кнопке Выбрать все тела в текущей сцене

и подтвердите свой выбор, щелкнув 
на кнопке Завершить ввод - . Затем нане­
сите необходимые размеры на оставшихся 
проекциях, скомпонуйте виды в компакт­
ной форме, выберите основную надпись, 
выбрав команды в меню Оформление так, 
как показано на рисунке. Чтобы завершить 
оформление, заполните основную надпись 
чертежа.

15.10. Создание ассоциативного чертежа 
опоры

В этом разделе мы построим чертеж опоры по модели, которую предварительно 
вам потребуется создать самостоятельно согласно рис. 15.9.

2 выреза выполнить

При самостоятельном создании модели можно воспользоваться представленной 
на рис. 15.10 последовательностью формирования тела детали.



о  „

г  д

Рис. 15.10. Последовательность создания Зй-модели: а  — создание профиля детали и выполнение 
операции выталкивания; 6  — создание профиля на вертикальной стенке детали и выполнение опе­
рации вычитания; в  — создание сквозного отверстия в основании детали с установкой требуемых 
параметров отверстия на вкладке свойств; г  — создание на нижней грани основания эскиза и вы­
полнение операции вычитания; д  — создание резьбовых отверстий в вертикальной стенке детали 

с установкой требуемых параметров отверстий на вкладке свойств

Теперь, предполагая, что модель опоры создана, рассмотрим собственно процедуру 
построения ассоциативного чертежа опоры.

1. Для создания чертежа модели в 2Б-окне 
выберите в меню команду Чертеж ► 2D про­
екция Q|3 . Открыть окно чертежа можно
и другим способом. Поместите указатель 
в нижний левый угол ЗБ-окна, при этом 
указатель изменит свой вид, как показано 
на рисунке слева. Подтвердите свой выбор 
щелчком левой кнопки мыши, в появив­
шемся окне установите переключатель 2D 
Окно и щелкните на кнопке ОК.

@20 Окно ОЭО Ом»

1__01> j 1 оін—ь I



2. В автоменю щелкните на кнопке Создать 

стандартный вид QBШ и в открывшемся диа­
логовом окне укажите вариант Вид сверху.

Вид спереди

ВИВ
Вид tt*oy 
Видслем 
Вид спреде 
Иэоиетрия

3. Переместите прямоугольный фантом вида 
в нужное место чертежа и подтвердите свой 
выбор щелчком на кнопке Завершить ввод

1 ^  I- Затем выберите в меню команду 
Чертеж ► Обозначение вида | — 1> после чего 
в автоменю станет доступной кнопка Соз­

дать простое сечение U  Л  . Установите ли­
нию разреза с учетом простановки размеров 
при последующем завершении чертежа так, 
как показано на рисунке. Для смены на­
правления стрелок воспользуйтесь кнопкой
Изменить направление взгляда

о
*Г -ф-

Изменить параметры обозначения разреза 
можно с помощью контекстного меню. Для 
этого наведите указатель мыши непосред­
ственно на обозначение разреза и щелкни­
те правой кнопкой мыши. Выбор в меню 
команды Свойства вызывает появление на 
экране соответствующего окна настройки.

» 0&ц>«{ Размеры ] Шрифгт j

Параметры /**ий

Длина вьносной п н и is !

Т олшмча/ммй: 1 Из статуса |

Отступ в начале: |17 I

Отстуі в конце: I" !
Дл+*а среанм  штрихов: іг I

Параметры стрелси

Д/wta стре/жи: !15 I

Размер стрелки: j Из статуса |

Т олціма лжии стрелкк (Из статуса I

Ттстре/ки: f -►...И

□  Подолчанио j ОК. j I Отмена j



5. Установите для выносной линии и стрелки

□ю09полните команду Чертеж ► 2D проекция 

В автоменю последовательно щелкните на
и Выбрать обо-кнопках Создать разрез

значение разреза \ Ll A  после чего отметьте
указателем мыши линию разреза на виде 
сверху и переместите фантом проекции на 
место главного вида, зафиксировав его по­
ложение щелчком на кнопке Завершить ввод

Г У 1  Не заканчивая работу с командой, 
создайте проекцию вида слева. Для этого 
отметьте левой кнопкой мыши проекцию 
главного вида и переместите фантом но­
вой проекции в требуемое место чертежа. 
Завершите работу с командой щелчком на
кнопке Выход из команды I Ц  |. Для опреде­
ления истинной формы наклонного среза 
в основании детали создайте наклонное се­
чение описанным ранее способом. Прове­
дение наклонной линии разреза потребует 
дополнительных построений. Пример раз­
реза и дополнительных построений пред­
ставлен на рисунке.

6. Выполните местный разрез на виде слева. 
Для этого нанесите контур будущего раз­
реза тонкими линиями, как показано на
рисунке. По команде Создать штриховку

в режиме ручного ввода контура (при на 
жатой кнопке Режим ручного ввода контура

) последовательно укажите его участ-
ки и щелчком на кнопке Выход из команды 

К  завершите ввод.



7. Выполните команду Чертеж ► 2D проекция 

g § j, щелкните в автоменю на кнопке Соз­

дать местный разрез [§§ , укажите на виде 
слева заштрихованную область и коман­
дой Выход из команды [^Ц [завершите ввод.
Результат выполнения операции показан 
на рисунке. Для удобного нанесения раз­
меров на полученном разрезе целесообраз­
но оформить часть вида слева выносным 
элементом.

I

8. Для создания выносного элемента выпол­
ните команду Чертеж ► Чертежный вид

выберите в автоменю операцию Создать 

выносной вид с обозначением

в еи

а
с г , в окне

Свойства подберите радиус окружности 
и установите масштаб вида 2:1. Двойным 
щелчком указателя мыши зафиксируйте 
положение окружности, а затем положение 
полки. Переместите выделенное изображе­
ние в подходящее место чертежа. Коман­
дой Завершить ввод I V  I завершите ввод
данных и закончите операцию щелчком на
кнопке Выход из команды g  . Отредак­
тируйте выносной элемент, нанеся необхо­
димые размеры. Пример оформления вы­
носного элемента представлен на рисунке.

На рис. 3.13 показан чертеж опоры после нанесения необходимых размеров, разме­
щения видов в соответствии с форматом и заполнения основной надписи чертежа.
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Тестирование 
начальных навыковГЛАВА

—— -  трехмерного 
моделирования

Представленные в книге задания предназначены для формирования начальных 
навыков трехмерного моделирования. Составляющими этих навыков являются, 
в частности, знание требований, касающихся выбора главного изображения моде­
лируемой детали, и особенностей грамотного выполнения эскизов и формообра­
зующих операций, а также умение их быстро создавать и редактировать.

16.1. Многовариантность 
3D-моделирования деталей

При создании твердотельной модели пользователю приходится мыслить в терми­
нах ее конструктивных элементов. В примере на рис. 16.1 на первом этапе создается 
основание в виде цилиндра с двумя отверстиями, на втором этапе — прямоуголь­
ный вырез, на третьем — цилиндрическое углубление.

Рис. 16.1. Этапы создания модели втулки

Рисунок 16.2 иллюстрирует первые два этапа при выборе других способов по­
строения модели втулки и показывает, что отличительной особенностью процедур 
создания трехмерных моделей является их многовариантность.



В то же время многочисленные исследования показывают, что при создании про­
странственных образов и оперировании ими учащиеся, конструкторы, проектиров­
щики имеют стойкие индивидуальные особенности. Таким образом, трехмерный 
графический редактор становится универсальным инструментом для реализации 
различных сценариев построения моделей, и эти сценария выбираются с учетом 
индивидуального восприятия пространственных образов.
Тем не менее многолетний опыт преподавания основ трехмерного моделирования 
говорит о том, что сценарии построения моделей у начинающих пользователей 
очень далеки от оптимальных, о чем легко судить по формируемым деревьям мо­
делей. Можно утверждать, что дерево модели — удобное средство контроля рацио­
нальности подхода к созданию модели. Один из важных аспектов рациональности 
построения модели связан с минимизацией объектов модели, то есть с минимиза­
цией количества формообразующих операций, необходимых для создания модели.

16.2. Разбор карты тестирования 
по деревьям моделей

В приложение А включено 5 вариантов карт тестирования начальных навыков 
трехмерного моделирования. Еще 10 вариантов таких карт можно найти в лите­
ратуре [1]. В табл. 16.1 показан один из вариантов карты тестирования по теме 
«Построение трехмерных моделей деталей».



31.1. Укажите минималь­
ное количество фор­
мообразующих операций, 
необходимых для созда­
ния показанной модели 
детали

31.2. Укажите номера де­
талей, для создания трех­
мерных моделей которых 
достаточно двух формо­
образующих операций

31.3. Какое минимальное 
количество формообра­
зующих операций необхо­
димо для преобразования 
модели 1 в модель 2? 
Операцию выреза четвер­
ти не учитывать

31.4. Укажите номера 
деталей, для создания 
моделей которых необхо­
димо более двух фор­
мообразующих операций. 
Операцию сечения по 
эскизу не учитывать

31.5. Укажите мини­
мальное количество 
формообразующих 
операций, необходимых 
для создания трехмерной 
модели детали 1 и детали 
2. Операцию сечения по 
эскизу не учитывать



В рассматриваемых в книге системах для наглядного представления последова­
тельности построения модели используются «деревья». Таблица 16.2, с опорой на 
деревья, иллюстрирует этапы построения моделей по пяти вопросам теста.

Таблица 16.2, Представление формообразующих операций для создания моделей

К вопросу 31.1

К вопросу 31.3
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По вопросу 31.1 требуется указать минимальное количество формообразующих 
операций, необходимых для создания показанной детали. В зависимости от ва­
рианта, для создания модели достаточно от 4 до 6 формообразующих операций.
Вопросы 31.2 и 31.4 теста требуют анализа формы простых моделей, для создания 
которых достаточно, как правило, не более 3 формообразующих операций.
Вопросы 31.3 и 31.5 иллюстрируются изображениями более сложных моделей. 
Для правильных ответов на поставленные вопросы требуется целесообразно пред­
ставить дерево построения каждой модели.



16.3. Разбор карты тестирования 
для систем AutoCAD и T-FLEX

В системах AutoCAD и T-FLEX 3D модель объекта представляется совокупностью 
тел, образуемых базовыми операциями и связанных между собой по определен­
ным логическим закономерностям. В силу достаточно общих функциональных 
возможностей таких формообразующих команд, как Выталкивание и Вращение, их 
применение в конкретном объектном окружении требует логического уточнения 
(обязательного указания первого операнда логической операции).
В табл. 16.3 приведены примеры реализаций ЗО-моделей объектов, иллюстрирую­
щие возможные последовательности логических операций.

Таблица 16.3. Представление формообразующих операций для создания моделей

К вопросу 31.1

а б в г д е ж
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К вопросу 31.5

В решении данных задач в системе AutoCAD, в отличие от других четырех систем, 
в том, что при создании какого-либо пространственного примитива, дополняющего 
предшествующую модель, необходимо применять булевы операции (как правило — 
объединения или вычитания), что, несомненно, увеличивает общее количество 
шагов моделирования.
Например, в вопросах 31.1, б, г, е требуются операции вычитания построенных 
объектов; в вопросе 31.2, 6 — операции объединения; в 31.2.2 и 31.2.3, г —операции 
вычитания. А в вопросе 31.2.1, б в системе T-FLEX потребуется создание дополни­
тельной рабочей плоскости для устранения конфликтов между профилями эскизов.
В вопросе 31.3 шаги в, д, ж, и — операции объединения, шаги л , н ~  операции вы­
читания.
В вопросе 31.4 шаги в, д — операции вычитания.
В вопросе 31.5 шаги 9, 12, 14, 16 — операции вычитания, шаги 3, 5, 7 — операции 
объединения.



Как видно из разобранных тестовых примеров, количество операций трехмерного 
моделирования в системах AutoCAD и T-FLEX в полтора-два раза больше, чем 
в остальных трех CAD-системах.
В AutoCAD, в отличие от остальных систем, при создании нового пространствен­
ного элемента постоянно приходится менять положение пользовательской систе­
мы координат (UCS), вместо того чтобы указать существующую координатную 
плоскость или плоскую грань и создавать на ней эскиз.



Самостоятельная
ГЛАВА работа в области 

2D- и 3D-технологий

Выполнения представленных в предыдущих главах заданий направлено на фор­
мирование начальных навыков трехмерного моделирования. В данной главе 
представлены задания, ориентированные в основном на формирование навыков 
оформления чертежей.

17.1. Модель и чертеж рупора
Для создания модели рупора, показанной на рис. 17.1, выполните две операции: 
Вращения и Вырезать выдавливанием. Исходные данные для эскизов содержит 
рис. 17.2.

Рис. 17.1. Модель рупора

Оформление чертежа, показанного на рис. 17.3, осуществляется в несколько этапов.
Вначале выполняется компоновка и редактирование видов в поле формата АЗ. 
Последующие этапы рассмотрены на примере применения системы КОМПАС.
1. Простановка размеров. С помощью команд инструментальной панели Размеры 

проставьте в чертеже необходимые размеры (рис. 17.4).
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Размеры
Активизировать инструментальную 
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Рис. 17.4. Компактная панель в режиме чертежа с открытой панелью инструментов Размеры

2. Простановка технологических обозначений. Проставьте в чертеже необходимые 
обозначения, используя на инструментальной панели Обозначения следующие 
команды (рис. 17.5):
□  Шероховатость;

□  База;

□  Допуск формы;

□  Стрелка взгляда;

□  Обозначение центра.

Рис. 17.5. Компактная панель в режиме чертежа с открытой панелью инструментов Обозначения

3. Оформление технических требований. Вызовите команду Вставка ► Технические 
требования ► Ввод и введите технические требования, показанные над основной 
надписью на рис. 17.3. Для выхода из режима щелкните на кнопке Закрыть 
в правом верхнем углу окна. Для возвращения в режим работы с чертежом от­
ветьте Да на запрос системы относительно сохранения изменений в чертеж. При 
необходимости вызовите команду Вставка ► Технические требования ► Размещение, 
задайте размеры страницы технических требований и ее положение на чертеже.

4. Простановка знака неуказанной шероховатости. Вызовите команду Вставка ► Не­
указанная шероховатость ► Ввод и введите значение шероховатости неуказанных 
поверхностей.

5. Заполнение основной надписи. Для активизации процедуры заполнения основной 
надписи можно использовать несколько способов:
□  дважды щелкнуть мышью в любой точке основной надписи;
□  выбрать команду Вставка Основная надпись;

□  щелкнуть правой кнопкой мыши и выбрать в контекстном меню команду 
Заполнить основную надпись.

Признаком активности (доступности для заполнения) является появление 
в основной надписи границ ячеек с учетом заданных отступов текста.

Я ! У  f
Обозначения
Активизировать инструментальную 
панель



Далее при заполнении основной надписи в ручном режиме поставьте курсор 
в нужную ячейку и заполните ее. При заполнении основной надписи доступны 
все возможности текстового редактора. После заполнения отдельных ячеек 
или всей основной надписи щелкните на кнопке Создать объект.

Для заполнения ячеек в полуавтоматическом режиме щелкните дважды внутри 
выделенной ячейки. При этом в зависимости от того, какая ячейка выбрана для 
заполнения, возможен вызов соответствующих дополнительных данных.

17.2. Модель и чертеж крышки
В табл. 16.2 и 16.3 главы 16 при разборе ответа на третий вопрос теста показаны 
этапы построения детали в различных CAD-системах. Назовем эту деталь крыш­
кой. Используя информацию из указанных таблиц и рис. 17.6, требуется построить 
модель и чертеж крышки. Чертеж должен содержать:
О ступенчатый разрез на месте вида спереди;
О вид сверху;
О профильный разрез на месте вида слева;
О дополнительный вид и местный разрез;
О истинный вид наклонного сечения;
О размеры;
О аксонометрическое изображение детали с разрезом.
Чертеж необходимо оформить в соответствии с требованиями ЕСКД и вывести 
на печать.
В случае возникновения затруднений при создании модели и чертежа крышки 
целесообразно обратиться к главе 4 очень обстоятельного пособия [9].
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17.3. Вывод чертежа на печать
Вывод на печать чертежей, созданных в системе КОМПАС, осуществляется через 
режим предварительного просмотра документа. Для включения этого режима на 
панели Стандартная щелкните на кнопке Предварительный просмотр (рис. 17.7).

зі & ѣт\^ш\ ъ&ъ
Предварительный просмотр
Просмотр содержимого перед печатью

Рис. 17.7. Кнопка предварительного просмотра на стандартной панели

Если открыт один документ, то система сразу перейдет в режим предварительного 
просмотра. На экране в левой части появится панель свойств, а в правой части 
будет выведен документ, выбранный для печати (рис. 17.8).



Вы можете напечатать не весь текущий лист документа, а только его часть, ограни­
ченную прямоугольником произвольных размеров. Для этого щелкните на кнопке 
Указать часть на панели свойств. На экране появится текущий лист документа и рам­
ка, ограничивающая печатаемую часть. Чтобы изменить размеры рамки, введите 
нужные значения в поля группы Отступ (рис. 17.9). Можно также переместить 
стороны или углы рамки мышью.

Укажите выводимую часть документа [х]

Отступ, мм 

Слева
1229.81 і \  

Снизу

10-0 С і

Справа

Сверху

I 0.0

Существуют несколько возможностей размещения документа в области вывода: 
О перемещение;
О поворот;
О масштабирование.
Перемещать документ можно разными способами, в том числе произвольно, с при­
вязкой к углу листа, с привязкой к углу другого документа.
Поворот документа осуществляется с помощью команд Повернуть против часовой 
стрелки и Повернуть по часовой стрелке.

Отмена } [ £правка )

Рис. 17.9. Выбор печатаемой части документа



Масштабирование документа позволяет разместить документ на определенном 
количестве листов. Следует иметь в виду, что для вывода на печать чертежа фор­
мата А4 потребуется четыре машинописных листа, так как чертежный формат не 
помещается в полосу печати большинства принтеров. Для рационального разме­
щения документа, например, на одном листе следует воспользоваться командой 
Сервис ► Подогнать масштаб. После вызова команды на экране появится диалоговое 
окно Подгонка масштаба документа (рис. 17.10).

После установки в полях необходимых значений щелкните на кнопке 0К, и система 
перерисует изображение в соответствующем масштабе (рис. 17.11).

В завершение вызовите команду Файл ► Печать. На экране возникнет уведомление 
о процессе. Чтобы вернуться в чертежно-графический редактор, щелкните на кноп­
ке Закрыть просмотр на панели инструментов.



Рис. 17.11. Документ, подготовленный для вывода на лист формата А4



^_____ Обмен графическими 
Щ) глава данными по моделям 

деталей и чертежам

В этой главе рассматриваются ограничения при обмене графическими данными 
между системами КОМПАС-ЗЭ, SolidWorks, Autodesk Inventor и AutoCAD.

18.1. Обмен графическими данными 
по моделям деталей

Для того чтобы экспортировать документ в другие системы, откройте соответ­
ствующий документ, выберите команду Файл ► Сохранить как, в списке Тип файла 
выберите нужный тип файла и в поле Имя файла введите имя файла. В случае не­
обходимости задайте нужные параметры конвертирования.
Для того чтобы открыть импортированный документ, выберите команду Файл ► От­
крыть и укажите нужный файл. В случае необходимости задайте нужные параметры 
чтения.
Все форматы векторных графических файлов условно можно разделить на две 
группы:
О графические документы программ векторной графики;
О форматы для обмена векторными изображениями.
Далее приводятся краткие характеристики наиболее распространенных форматов 
обмена.
В табл. 18.1 показаны наиболее распространенные методы преобразования данных 
для документов четырех CAD-систем.



Таблица 18.1. Методы обмена данными по моделям деталей

Наименование
КОМ ПАС-3D SolidWorks Autodesk Inven­

tor AutoCAD

Импорт Экспорт Импорт Экспорт Импорт Экспорт Импорт Экспорт

ACIS (*.sat) + + + + + + + +

DXF/DWG 
(*.dxf, *dwg) + + + + + + + +

IGES (M gs, 
*.iges) + + + + + - - -

Parasolid 
(*.x_t, *.x_b, 
*.xmt_txt, 
*.xmt_bin)

+ + + + - - - -

STEP AP203/214 
(*.step, *.stp) + + + + + - - -

VRML (*.wrl) - + + + - - - -

Остановимся на терминологии табл. 18.1.
О ACIS — общее наименование для данных, с которыми работает лицензируемое 

(то есть доступное сторонним разработчикам) ядро системы геометрического 
моделирования ACIS. Ядро ACIS для своих программ, в частности, использует 
корпорация Autodesk (Inventor, Mechanical Desktop). Для выводимых данных 
применяются форматы SAT и SAB.

О DWG (Drawing Database) — один из основных форматов системы AutoCAD.
О DXF (Drawing Interchange Format) — формат, много лет назад ставший де-факто 

стандартом для обмена чертежами в различных CAD-системах.
О IGES (Initial Graphics Exchange Specification) — нейтральный формат обмена 

данными для CAD-систем. Поддерживает традиционные инженерные чертежи 
и трехмерные модели.

О Parasolid — ядро системы геометрического моделирования, в настоящее время 
используемое в таких САПР, как Unigraphics, SolidWorks, T-FLEX и других.

О STEP — стандарт ISO для компьютерного представления и обмена индустри­
альными данными. Чаще всего STEP используется для обмена данными между 
CAD-, САМ-, САЕ- и PDM-системами.

О VRML — стандартный формат файлов для демонстрации трехмерной интерак­
тивной векторной графики, чаще всего используется в WWW.

О Х_В — текстовый формат экспорта САПР, основанных на ядре Parasolid.
О Х_Т — бинарный формат экспорта САПР, основанных на ядре Parasolid.
В табл. 18.2 представлены итоги обмена графическими данными. Обмен прово­
дился по моделям 9 деталей, построение которых рассматривалось в предыдущих



главах и которые упоминались во введении к этой книге. Максимальное число 
ошибок возникало при обмене данными по пружинам.

Таблица 18.2. Методы согласованного обмена данными по деталям между системами

Экпорт

Импорт, последующее создание чертежа

КОМ ПАС-3 D SolidWorks Autodesk Inventor Auto­
CAD

AC
IS

IG
ES

ST
EP

AC
IS

IG
ES

ST
EP

AC
IS

IG
ES

ST
EP

AC
IS

Компас-ЗР

ACIS + + X + + + +

IGES + + + + i
1 + +

STEP + + + + I + +

SolidWorks

ACIS X i ++ X + +

IGES
i1 + + + + j + +

STEP + + + + + -2

Autodesk
Inventor

ACIS + -1 + -1 ++1 + +

IGES 1
+ + + +

I
+ + j11

STEP + + 1 + + ;1 + + 1I

1AutoCAD ACIS ! + + + +
1 .

, + +

1 Импортируется поверхность.
2 Некорректный ассоциативный чертеж пружины.

После импорта изображение детали выглядело так, как показано на рис. 18.1.

А

и
А

Рис. 18.1. Результаты импорта модели пружины: 
а —  некорректный импорт; 6 —  корректный импорт



18.2. Обмен данными по чертежам 
деталей

Вначале следует отметить, что обеспечение «идеального» обмена данными по чер­
тежам между различными системами является очень непростой задачей. Заметна 
положительная динамика усовершенствования соответствующих утилит обмена 
систем, рассматриваемых в данной книге. Однако еще предстоит многолетний путь 
к «идеальному» обмену.
Для получения результатов по обмену данными по чертежам деталей был выбран 
чертеж рупора, показанный в главе 17. При тестировании корректности обмена был 
выбран порядок, предусматривающий, в частности, создание чертежа для экспорта 
в определенном формате с последующим импортом этого чертежа в «родную» си­
стему. В табл. 18.3 представлены результаты обмена, числами отмечены примеча­
ния, которые в табл. 18.4 проиллюстрированы фрагментами результатов импорта.

Таблица 18.3. Результаты обмена данными чертежей между системами

Экпорт

Импорт (шрифт, спецсимволы, типы линий)
1

КОМПАС-3 D SolidWorks Autodesk Inventor 1 AutoCAD
1

U.
2 DW

G

IG
ES

j
Li.Xо DW

G

IG
ES Li.Xо DW
G

IG
ES

DX
F

DW
G

КОМ ПАС-3 D

DXF
1
+ - + 1 +++ X i +++

DWG + - + 1 +++ — +7 +++

IGES — +2

Solid Works
DXF +++ +++ +++ +++

DWG + + + 4 +++ + + + 5 +++

Autodesk
Inventor

DXF X
1
X

1
X X

DWG + ++4 +++6 +++ +++6

Auto-CAD
DXF X +++ X +++

DWG X +++ +++ +++

1 Результат взаимного обмена в КОМПАС в форматах DWG, DXF.
2 Результат взаимного обмена в КОМПАС в формате IGES.
3 Результат экспорта из КОМПАС V I1 в форматах DWG, DXF в КОМПАС V I1 LT.
4 Результат экспорта из Inventor и SolidWorks в КОМПАС в формате DWG.
5 Результат экспорта из SolidWorks в Inventor в формате DWG.
6 Результат экспорта из Inventor в SolidWorks и AutoCAD в формате DWG.
7 Результат экспорта из КОМПАС в Inventor в формате DWG.



По этим фрагментам можно сделать вывод о корректности обмена данными. Более 
подробная информация по результатам обмена между четырьмя системами, дан­
ными по чертежам, представлена на прилагаемом к книге DVD-диске.

Таблица 18.4. Фрагменты чертежей для оценки результатов обмена данными



Таблица 18.4 (п р о д о л ж е н и е )

Результат взаимного обмена 
в КОМПАС в формате IGES. 
Отметьте размер фаски, угловой 
размер, обозначение базы

Результат экспорта из КОМПАС 
V II  в форматах DWG, DXF 
в КОМПАС V II  LT. Фрагмент не 
требует комментариев

Е Н -

Результат экспорта из Inventor 
и SolidWorks в КОМПАС 
в формате DWG. Отметьте 
размер фаски, угловой размер, 
обозначение базы. Размеры 
указаны без предельных 
отклонений. Текст и знаки 
размещены в прямоугольных 
раммках

{Ш)0.2



Результат экспорта из SolidWorks 
в Inventor в формате DWG. 
Отметьте высоту шрифта 
при обозначении размеров, 
обозначение базы

Результат экспорта из Inventor 
в SolidWorks и AutoCAD 
в формате DWG. Отметьте 
размер фаски, угловой размер, 
обозначение базы. Размеры 
указаны без предельных 
отклонений. Текст и знаки 
размещены в прямоугольных 
рамках

Результат экспорта из 
КОМПАС в Inventor в формате 
DWG. Фрагмент не требует 
комментариев



Заключение

В следующей таблице перечислены уже знакомые вам ЗЭ-операции, которые ис­
пользовались при создании моделей деталей.

Если следовать методике, предложенной в данной книге, приобретение навыков 
работы в одной системе существенно упрощает и ускоряет освоение следующей. 
Вне поля рассмотрения осталось несколько достаточно распространенных опе­
раций, связанных с созданием тел по сечениям и с перемещением двухмерного 
объекта по траектории.
Наиболее простой путь освоения указанных «неозвученных» операций — обра­
щение к рассмотренному в разделе 3.12 продукту «Азбука КОМПАС». Так как 
это интерактивное пособие реализовано в виде отдельного файла, то его можно 
открывать в отдельном окне не только при работе с системой КОМПАС-ЗБ, но и с 
другими системами. Используя указанное пособие, вы достаточно быстро освоите 
особенности моделирования листовых деталей.
И самое главное. Ждите от авторов книгу по ЗБ-моделированию сборочных еди­
ниц. До скорой встречи!
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Карты тестирования 
начальных навыков

ПРИЛОЖЕНИЕ--------  трехмерного 
моделирования

В данном приложении представлено пять вариантов теста на построение трехмер­
ных моделей деталей.

Вариант 1

4 ?

1. Укажите минимальное коли­
чество формообразующих 
операций, необходимых для 
создания трехмерной модели 
показанной детали.

€
$

2. Укажите номера деталей, для 
создания трехмерных моделей 
которых достаточно двух фор­
мообразующих операций.

(tp ti
1 2

3. Какое минимальное количе­
ство формообразующих опера­
ций необходимо для преобра­
зования модели 1 в модель 2? 
Операцию сечения по эскизу 
не учитывать.



4. Укажите номера деталей, для 
создания которых минималь­
ное количество формообра­
зующих операций равно 3. 
Операцию сечения по эскизу 
не учитывать.

5. Укажите минимальное ко­
личество формообразующих 
операций, необходимых для 
создания трехмерных моделей 
деталей 1 и 2.

Вариант 2

( 1

1. Укажите минимальное ко­
личество формообразующих 
операций, необходимых для 
создания трехмерной модели 
показанной детали

Ф А  

< # > , d

2. Укажите номера деталей, для 
создания трехмерных моделей 
которых достаточно двух фор­
мообразующих операций.

1 2

3. Какое минимальное количе­
ство формообразующих опера­
ций необходимо для преобра­
зования модели 1 в модель 2? 
Операцию сечения по эскизу 
не учитывать.



1 2 3 4

4. Укажите номера деталей, для 
создания которых минималь­
ное количество формообра­
зующих операций равно 3. 
Операцию сечения по эскизу 
не учитывать.

£©\\ /j

1 2

5. Укажите минимальное ко­
личество формообразующих 
операций, необходимых для 
создания трехмерных моделей 
деталей 1 и 2. Операцию сече­
ния по эскизу не учитывать.

Вариант 3

1. Укажите минимальное ко­
личество формообразующих 
операций, необходимых для 
создания трехмерной модели 
показанной детали. Обратите 
внимание, что деталь имеет 
две плоскости симметрии.

2. Укажите номера деталей, для 
создания трехмерных моделей 
которых достаточно двух фор­
мообразующих операций.

1 2

3. Какое минимальное количе­
ство формообразующих опера­
ций необходимо для преобра­
зования модели 1 в модель 2?



4. Укажите номера деталей, для 
создания которых минималь­
ное количество формообра­
зующих операций равно 3. 
Операцию сечения по эскизу 
не учитывать.

л<§“Гчу 5. Укажите минимальное ко­
личество формообразующих 
операций, необходимых для 
создания трехмерных моделей 
деталей 1 и 2. Операцию сече­
ния по эскизу не учитывать.



) ПРИЛОЖЕН ЙІ
Интернет-ресурсы на 
русскоязычных сайтах

О http://www.inventor.ru — сайт, посвященный системе Inventor.
О http://www.autodesk.ru — сайт разработчика программ AutoCAD, Mechanical 

Desktop, Inventor и др.
О http://www.sapr.ru — веб-сервер журнала «САПР и графика».
О http://www.caduser.ru — сайт пользователей продуктов фирмы Autodesk.
О http://www.dwgseries.com — сайт с бесплатными продуктами, предназначенными 

для работы с файлами форматов DWG pi DXF.
О http://www.cadacademy.ru — образовательный сайт в области САПР.
О http://www.solidworks.ru — сайт поддержки пользователей SolidWorks.
О http://www.ascon.ru — сайт разработчика КОМПАС-ЗО.
О http://www.edu.ascon.ru — сайт «КОМПАС в образовании».
О http://www.eltech.ru/misc/graph/index.html — сайт каталога с примерами решения 

учебных задач в системе КОМПАС-ЗО.
О http://www.tflex.ru — сайт разработчика T-FLEX.
О http://www.isi.cad.ru — все о САПР, PLM, ERP.

http://www.inventor.ru
http://www.autodesk.ru
http://www.sapr.ru
http://www.caduser.ru
http://www.dwgseries.com
http://www.cadacademy.ru
http://www.solidworks.ru
http://www.ascon.ru
http://www.edu.ascon.ru
http://www.eltech.ru/misc/graph/index.html
http://www.tflex.ru
http://www.isi.cad.ru


Содержимое компакт-диска

В разделах диска представлены следующие материалы:
О Изображения (jpg) внешнего вида моделей, рассматриваемых в книге.
О Приведены реализации ЗО-моделей в 5 CAD-системах. Для просмотра приме­

ров необходимо установить соответствующее программное обеспечение.
О Примеры конвертированных моделей для обмена данными между системами 

КОМПАС, AutoCAD, Inventor и SolidWorks. Более детальная информация 
о файлах моделей приведена на диске.

О Дистрибутивы систем КОМПАС .3D v.l 1 Spl (ознакомительная 30-дневная про­
фессиональная версия, версия LT, Viewer и набор дополнительных ЗО-моделей 
деталей) и T-FLEX CAD v.l 1 (дистрибутив учебной версии ST, Viewer, Microsoft 
.NET Framework 2.0 и набор дополнительных ЗО-моделей деталей).

О Для систем AutoCAD, Autodesk Inventor и SolidWorks приводятся ссылки, по 
которым можно заказать их ознакомительные версии.

О Приводятся ссылки, по которым можно непосредственно с диска обратиться 
к некоторым русскоязычным сайтам по рассматриваемой тематике.

О Содержание книги и список литературы.
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тел./факс: (495) 234-38-15,974-34-50; e-mail: sales@msk.piter.com

Воронеж Ленинский пр., д. 169; тел./факс: (4732) 39-61 -70 
e-mail: piterctr@comch.ru

Екатеринбург ул. Бебеля, д. 11 а; тел./факс: (343) 378-98-41, 378-98-42 
e-mail: office@ekat.piter.com

Нижний Новгород ул. Совхозная, д. 13; тел.: (8312) 41-27-31 
e-mail: office@nnov.piter.com

Новосибирск ул. Станционная, д. 36; тел.: (383) 363-01-14 
факс: (383) 350-19-79; e-mail: sib@nsk.piter.com

Ростов-на-Дону ул. Ульяновская, д. 26; тел.: (863) 269-91 -22, 269-91 -30 
e-mail: piter-ug@rostov.piter.com

Самара ул. Молодогвардейская, д. 33а; офис 223; тел.: (846) 277-89-79 
e-mail: pitvolga@samtel.ru

УКРАИНА
Харьков ул. Суздальские ряды, д. 12, офис 10; тел.: (1038057) 751-10-02 

758-41-45; факс: (1038057)712-27-05; e-mail: piter@kharkov.piter.com

Киев Московский пр., д. 6, корп. 1, офис 33; тел.: (1038044) 490-35-69 
факс: (1038044) 490-35-68; e-mail: office@kiev.piter.com

БЕЛАРУСЬ
Минск ул. Притыцкого, д. 34, офис 2; тел./факс: (1037517) 201-48-79, 201 -48-81

e-mail: gv@minsk.piter.com

00 Ищем зарубежных партнеров или посредников, имеющих выход на зарубежный рынок. 
Телефон для связи: (812) 703-73-73. E-mail: fuganov@piter.com

Издательский дом «Питер» приглашает к сотрудничеству авторов. Обращайтесь 
по телефонам: Санкт-Петербург -  (812) 703-73-72, Москва -  (495) 974-34-50

Заказ книг для вузов и библиотек по тел.: (812) 703-73-73.
Специальное предложение -  e-mail: kozin@piter.com

Заказ книг по почте: на сайте www.piter.com; по тел.: (812) 703-73-74 
по ICQ 413763617
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И З Д А Т Е Л Ь С К И Й  П О М  УВАЖАЕМЫЕ ГОСПОДА!
I ® КНИГИ ИЗДАТЕЛЬСКОГО ДОМА «ПИТЕР» 

ВЫ МОЖЕТЕ ПРИОБРЕСТИ 
W W W . P I T E R . C O M  ОПТОМ И В РОЗНИЦУ У НАШИХ

РЕГИОНАЛЬНЫХ ПАРТНЕРОВ.

п я и я і  с н о і л л п  u u m

1 > £ П П Т Е Р
W W W  P I Т Р И  Г. П М

ДАЛЬНИЙ ВОСТОК 
Владивосток
«Приморский торговый дом книги» 
тел./факс: (4232) 23-82-12 
e-mail: bookbase@mail.primorye.ru

Хабаровск, «Деловая книга», ул. Путевая, д. 1а 
тел.: (4212) 36-06-65,33-95-31 
e-mail: dkniga@mail.kht.ru

Хабаровск, «Книжный мир»
тел.: (4212) 32-85-51, факс: (4212) 32-82-50
e-mail: postmaster@worldbooks.kht.ru

Хабаровск, «Мире» 
тел.: (4212) 39-49-60 
e-mail: zakaz@booksmirs.ru

ЕВРОПЕЙСКИЕ РЕГИОНЫ РОССИИ
Архангельск, «Дом книги», пл. Ленина, д. 3 
тел.: (8182) 65-41-34,65-38-79 
e-mail: marketing@avfkniga.ru

Воронеж, «Амитапь», пл. Ленина, д. 4 
тел.: (4732) 26-77-77 
http://www.amital.ru

Калининград, «Вестер», 
сеть магазинов «Книги и книжечки» 
тел./факс: (4012) 21-56-28,6 5-65-68 
e-mail: nshibkova@vester.ru 
http://Www.vester.ru

Самара, «Чакона», ТЦ «Фрегат»
Московское шоссе, д. 15 
тел.: (846) 331-22-33 
e-mail: chaconne@chaccone.ru

Саратов, «Читающий Саратов» 
пр. Революции, д. 58 
тел.: (4732) 51-28-93,47-00-81 
e-mail: manager@kmsvrn.ru

СЕВЕРНЫЙ КАВКАЗ
Ессентуки, «Россы», ул. Октябрьская, 424 
тел./факс: (87934) 6-93-09 
e-mail: rossy@kmw.ru

СИБИРЬ
Иркутск, «ПродаЛитЪ» 
тел.: (3952) 20-09-17, 24-17-77 
e-mail: prodalit@irk.ru 
http://www.prodalit.irk.ru

Ир кутск, «Светлана» 
тел./факс: (3952) 25-25-90 
e-mail: kkcbooks@bk.ru 
http://www.kkcbooks.ru

Красноярск, «Книжный мир» 
пр. Мира, д. 86 
тел./факс: (3912) 27-39-71 
e-mail: book-world@public.krasnet.ru

Новосибирск, «Топ-книга» 
тел.: (383) 336-10-26 
факс: (383) 336-10-27 
e-mail: office@top-kniga.ru 
http://Www.top-kniga.ru

ТАТАРСТАН
Казань, «Тайс», 
сеть магазинов «Дом книги» 
тел.: (843) 272-34-55 
e-mail: tais@bancorp.ru

УРАЛ
Екатеринбург, ООО «Дом книги» 
ул. Антона Валека, д. 12 
тел./факс: (343) 358-18-98,358-14-84 
e-mail: domknigi@k66.ru

Екатеринбург, ТЦ «Люмна» 
ул. Студенческая, д. 1в 
тел./факс: (343) 228-10-70 
e-mail: igm@lumna.ru 
http://www.lumna.ru

Челябинск, ООО «ИнтерСервис ЛТД» 
ул. Артиллерийская, д. 124 
тел.: (351) 247-74-03, 247-74-09, 
247-74-16
e-mail: zakup@intser.ru 
http://Www.fkniga.ru, www.intser.ru
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ВАМ НРАВЯТСЯ НАШИ КНИГИ? 
ЗАРАБАТЫВАЙТЕ ВМЕСТЕ С НАМИ!
У Вас есть свой сайт?
Вы ведете блог?
Регулярно общаетесь на форумах? Интересуетесь литературой, 
любите рекомендовать хорошие книги и хотели бы стать нашим 
партнером?
ЭТО ВПОЛНЕ РЕАЛЬНО!

СТАНЬТЕ УЧАСТНИКОМ 
ПАРТНЕРСКОЙ ПРОГРАММЫ ИЗДАТЕЛЬСТВА «ПИТЕР»!

Зарегист рируйт есь на нашем сайте в качест ве парт нера  
по адресу w w w .p ite r.com /eP artners

Получите свой персональный уникальный номер партнера

Выбирайте книги на сайте w w w .p ite r.com , размещайте 
информацию о них на своем сайте, в блоге или на форуме 
и добавляйте в текст ссылки на эти книги 
(на сайт w w w .p ite r.com )

ВНИМАНИЕ! В каждую ссылку необходимо добавить свой персональный 
уникальный номер партнера.

С этого момента получайте 10%  от стоимости каждой покупки, которую  
совершит клиент, придя в интернет-магазин «Питер» по ссылке с Вашим 
партнерским номером. А если покупатель приобрел не только эту книгу, но 
и другие издания, Вы получаете дополнительно по 5% от стоимости каждой 
книги.

Деньги с виртуального счета Вы можете потратить на покупку книг в интернет- 
магазине издательства «Питер», а также, если сумма будет больше 500 рублей, 
перевести их на кошелек в системе Яндекс.Деньги или Web.Money.

Пример партнерской ссылки:
http://w w w .piter.com /book.phtm l7978538800282 -  обычная ссылка 
http ://w w w .p iter.com /book.phtm l?978538800282&refer=0000- партнерская 
ссылка, где 0000 -  это ваш уникальный партнерский номер

Подробно о Партнерской программе 
ИД «Питер» читайте на сайте 
WWW.PITER.COM

П З О А Т Е П Ь С К П П  П О М
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КНИГА-ПОЧТОЙ
ЗАКАЗАТЬ КНИГИ ИЗДАТЕЛЬСКОГО ДОМА «ПИТЕР» МОЖНО ЛЮБЫМ 
УДОБНЫМ ДЛЯ ВАС СПОСОБОМ:

•  на нашем сайте: www.piter.com
•  по электронной почте: postbook@piter.com
•  по телефону: (812) 703-73-74
•  по почте: 197198, Санкт-Петербург, а/я 127, ООО «Питер Мейл»
•  по ICQ: 413763617

ВЫ МОЖЕТЕ ВЫБРАТЬ ЛЮБОЙ УДОБНЫЙ ДЛЯ ВАС СПОСОБ ОПЛАТЫ:

< 0  Наложенным платежом с оплатой при получении в ближайшем почтовом 
отделении.
С помощью банковской карты. Во время заказа Вы будете перенаправлены 
на защищенный сервер нашего оператора, где сможете ввести свои данные 
для оплаты.
Электронными деньгами. Мы принимаем к оплате все виды электрон­
ных денег: от традиционных Яндекс.Деньги и Web-money до USl) 
E-Gold, MoneyMail, INOCard, RBK Money (RuPay), USD Bets, Mobile Wallet 
и др.

<Q> В любом банке, распечатав квитанцию, которая формируется автоматически 
после совершения Вами заказа.
Все посылки отправляются через «Почту России». Отработанная 
система позволяет нам организовывать доставку Ваших покупок макси­
мально быстро. Дату отправления Вашей покупки и предполагаемую дату 
доставки Вам сообщат по e-mail.

ПРИ ОФОРМЛЕНИИ ЗАКАЗА УКАЖИТЕ:

•  фамилию, имя, отчество, телефон, факс, e-mail;
•  почтовый индекс, регион, район, населенный пункт, улицу, дом, 

корпус, квартиру;
•  название книги, автора, количество заказываемых экземпляров.

пзалтЕпьскпй  п о м

http://www.piter.com
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